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KİTABIN TANITIMI
Öğrenme biriminin 

numarasını gösterir.

Öğrenme biriminin 
adını gösterir.Öğrenme biriminin 

bölümlerini gösterir.

Etkileşimli kitap, video, ses, animasyon, 
uygulama, oyun, soru vb. ilave kaynaklara 

ulaşabileceğiniz karekodu gösterir.

Öğrenme biriminin 
kavramlarını gösterir.

Derse başlamadan 
önce yapılacak olan 

hazırlıkları
gösterir.

Konu başlığını 
gösterir.

Alt konu başlıklarını
gösterir.

Sayfa numarasını 
gösterir.
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Konu içindeki
öğrenci

çalışmalarını 
gösterir.

Öğrenme biriminin 
adını gösterir.

Uygulama
faaliyetlerini gösterir.

Ölçme ve 
değerlendirme 

sayfasını
gösterir.

Etkileşimli kitap, 
video, ses, animasyon, 

uygulama, oyun, 
soru vb. kaynaklara 

ulaşabileceğiniz link ve 
karekodu gösterir.

Konu içinde dikkat 
edilmesi gereken 

yerleri
gösterir.



KAVRAMLAR 

Teknik Resim, Norm Yazı

 Üç Boyutlu Görünüş 

İzdüşüm, Perspektif



ÖĞRENME BİRİMİ BÖLÜMLERİ

Temel Geometrik Çizimler

İzdüşüm Görünüşlerini Çizme ve Ölçeklendirme
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1.1. Temel Geometrik Çizimler
1.1.1. Çizgi ve Norm Yazı

Teknik resim çizimleri; teknik resim standartlarina göre oluşturulan çizgiler, geometrik şekiller ve 
yazilardan oluşmaktadir. Bu çizimler yapilirken kullanilan çeşitli çizim araç gereçleri vardir. 

1.1.1.1. Teknik Resimde Kullanılan Araç Gereçler

Çizim Masası: Resim çizilecek kâğidin tutturulduğu masadir. Çizim masasinin köşeleri 90 derece, 
kenarlari ve yüzeyi pürüzsüz olmalidir. Bu masalar genellikle eğimi ayarlanabilir şekilde üretilir. 

Görsel 1.1: Teknik resim masaları

T Cetveli: Teknik resimde en çok kullanilan araçlardan biridir. T cetveli genellikle paralel, eğik ve düz 
çizgilerin çizilmesinde kullanilir. Gönyelerle yapilacak çizimlerde gönyelere kilavuzluk yapar.

Görsel 1.2: T cetveli

Gönyeler: Genellikle T cetveli üzerinde kaydirilarak dikey ve eğik çizgiler çizmek ve açi oluşturmak için 
kullanilir. Standart gönyelerin açilari 45ox45ox900 ve 30ox60ox900dir. 

1. Teknik resim kavramini ve norm yazi standartlarini araştıriniz.

2. İzdüşüm ve perspektif kavramlarini araştıriniz.

1. TEMEL TEKNİK RESİM
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Ölçü Cetvelleri: Uzunluklarin ölçülmesinde kullanilir. 
İletki (Açıölçer): Açilarin ölçülmesi ve gönyelerle çizilmesi imkânsiz açilarin işaretlenmesi için kullanilan 

bir araçtır. İletkinin 00-1800lik ve 00-3600lik olmak üzere iki çeşidi mevcuttur. 

Görsel 1.3: Gönye, ölçü cetveli, açıölçer

Pergel: Daire çizimi, yay çizimi, bir ölçünün bir yerden başka bir yere taşinmasi ve belli bir ölçünün birkaç 
defa tekrarlanarak işaretlenmesi için kullanilir. 

Şablonlar: Çeşitli hazir şekillerin çizilebildiği araçlardir. Daire ve yay şablonu, yazi şablonu, elips şablonu 
ve sembol şablonlari şeklinde çeşitleri vardir. 

Görsel 1.4: Daire şablonu

Kalemler: Kurşun kalemler, takma uçlu kalemler ve teknik çizim kalemleri olmak üzere çeşitleri vardir.

• Kurşun kalemler: Teknik resmin çizilmesinde ve yazilarinin yazilmasinda kullanilan siyah kurşun 
kalemler, sertlik derecelerine göre üçe ayrilir. Kurşun kalemlerin sertlik dereceleri, üzerlerine yazilan 
harf ve rakamlar ile belirtilir. Bu kalemler sert, yumuşak ve orta sertlikte olmak üzere gruplandirilir.

o Sert Kalemler: İngilizce hard (sert) kelimesinin ilk harfi ile ifade edilir. Kurşun kalemlerin sertlik 
derecesini ifade eden rakamlar harfin soluna konur (2H, 3H, 4H).

o Yumuşak Kalemler: İngilizce black (siyah) kelimesinin ilk harfi ile ifade edilir. Harfin soluna konulan 
rakamlar büyüdükçe kalemin yumuşakliği artar (2B, 3B, 4B…).

o Orta Sertlikte Kalemler: HB ve İngilizce firm (dolgun) kelimesinin ilk harfi ile ifade edilir. 
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• Takma Uçlu (Versatil) Kalemler: 0,3 - 0,5 - 0,7 - 0,9 mm kalinliğindaki grafit uçlarin bir boru içinden 
geçirilmesiyle oluşturulan kalemlerdir. Çizimin özelliğine göre uçlari B, HB ve F sertliğinde takma uçlu 
kalemler tercih edilmelidir.

• Teknik Çizim Kalemleri: Genellikle proje çalişmalarinda bu kalemlere özel mürekkep ile kullanilan, 
aydinger kâğida ayni kalinlikta yazip çizebilen kalemlerdir.

Görsel 1.5: Teknik çizim kalem takımı

1.1.1.2. Standart Kâğıt Ölçüleri

Teknik resimde kullanilan kâğitlar, çizilecek resmin cinsine ve kullanilacaği yere göre seçilir. Genel olarak 
teknik resimde kullanilan kâğitlar beş gruba ayrilir. 

• Saydam Olmayan Resim Kâğıdı: Beyaz renkte, sert ve yirtılmaya karşi dayanikli kâğitlardir. Kurşun 
kalemle iyi çizim yapilmasina imkân veren, iz birakmadan silinebilen kâğitlardir. 

• Aydınger: Bu kâğitlara genellikle kopyasi çikarilarak çoğaltılacak resimler çizilir. Bu yüzden aydinger 
kâğitlari, alttaki resmi en ince ayrintısina kadar gösterecek saydamliktadir.

• Ozalit Kâğıdı: Aydingere çizilmiş resimlerin en ucuz çoğaltma metodu, ozalit kâğidina çikarilan 
kopyalardir. Ozalit kâğitlari, bir yüzüne işiğa karşi hassas özel madde sürülmüş kâğitlardir. 

• Fotokopi Kâğıtları: Teknik resimler fotokopileri alinarak da çoğaltılabilir. Fotokopinin ozalit kopyaya 
üstünlüğü, resimlerin aydinger kâğidina çizilme zorunluluğunun olmamasidir. 

• Milimetrik Kâğıt: Üzerlerine herhangi bir renkte milimetrik taksimat basilmiş kâğitlardir. Milimetrik 
kâğitlar genel olarak grafiklerin veya krokilerin çizilmesinde kullanilir.

Teknik resimde kullanilan standart kâğit ölçüsü, A serisi kâğitlardir. Resim kâğitlari, tam ölçüsünde veya 
resim masalarina yapiştırma payi ilaveli olarak kesilir.
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Sıra Sizde 1

Tablo 1.1’de verilen çizgi çeşitlerini teknik resim defterinize sayfa kenar çizgilerinin 
1 cm uzağindan başlayip 1 cm uzağinda bitirerek üçer tane çiziniz.

Görsel 1.6: A serisi kâğıt ölçüleri

1.1.1.3. Çizgi Çeşitleri ve Çizgilerin Kullanıldığı Yerler

Bir noktadan başlayip noktanin yürütülmesi ile oluşan, uzunluğu belli olan biçime çizgi adi verilir. Çizgiler, 
teknik resmin ayrilmaz unsurlaridir. Teknik resmin doğru okunmasi için çizgilerin doğru okunmasi gereklidir.

Makine parçalarinin ve endüstriyel çizimlerin kâğit üzerindeki anlatımi çeşitli çizgilerle oluşturulur. 
Teknik resimde kullanilan çizgilere standart çizgiler denir.

Tablo 1.1: Çizgi Çeşitleri ve Çizgilerin Kullanıldığı Yerler

Görünümü Türü ve Kullanım Yeri

Sürekli Kalin Çizgi (0,5 mm)
•	 Görünen Kenarlar
•	 Görünen Çevreler
•	 Vida Sonu Çizgisi

Sürekli İnce Çizgi (0,25 mm)
•	 Ölçü Çizgileri
•	 İç Sinir Çizgileri
•	 Kesit Taramalari

Sürekli İnce Serbest El Çizgisi (0,25 mm)
•	 Bölgesel Kesit Siniri

İnce Kesik Çizgi (0,25 mm)
•	 Görünmeyen Kenarlar ve Çevreler

Kalin Kesik Çizgi (0,5 mm)
•	 İşlenmiş Yüzey Sinirlarinin Gösterilmesi

Noktali Kesik İnce Çizgi (0,25 mm)
•	 Daire ve Yay Eksenleri

Noktali Kesik Kalin Çizgi (0,5 mm)
•	 Özel İşlemli Yüzeylerin Sinirlarinin Gösterilmesi

İki Noktali Kesik Çizgi (0,25 mm)
•	 Hareketli Parçalarin Sinir Konumlari
•	 Ağirlik Merkezi Çizgileri
•	 Komşu Parçalarin Çevreleri
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1.1.1.4. Standart Yazı Tipleri ve Norm Yazı 

Teknik resimde yazilar, karişikliği önlemek için Türk Standartlari Enstitüsü tarafından yazi tipi A ve yazi 
tipi B olmak üzere iki ayri standarda bağlanmiştır. Bu iki yazi tipi arasindaki fark, yazi kalinliğidir. A tipi yazi, 
B yazi tipine göre incedir. Teknik resimde B yazi tipi tercih edilir. Yazi ayrica teknik resimde biçimlerine göre 
dik norm yazi ve eğik norm yazi olmak üzere ikiye ayrilir. 

Dik norm yazilar, inşaat ve mimari teknik resminde kullanilir. Harfler ve rakamlar, satır çizgisine dik yazilir.
 

Görsel 1.7: Dik norm yazı

Sıra Sizde 2
Görsel 1.7’de verilen alfabe, rakam ve sembolleri teknik resim defterinize dik norm 
yazi kurallarina uygun olarak yaziniz.
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     Eğik norm yazilar; makine, elektrik ve elektronik teknik resminde kullanilir. Harfler ve rakamlar, satır 
çizgisine 75° sağa eğik olacak şekilde yazilir.

Görsel 1.8: Eğik norm yazı

 

1.1.2. Temel Geometrik Çizimler

1.1.2.1. Doğru Çizimi

Cetvel yardimiyla belirlenen uzunlukta bir doğru parçasi çizilir ve doğru parçasinin uç noktalari A ve B 
olarak adlandirilir. Gönye kullanilarak kaydirma yöntemi ile AB doğru parçasina paralel doğrular çizilebilir.

Görsel 1.9: AB doğru parçası

Sıra Sizde 3

İstiklâl Marşi metnini teknik resim defterinize eğik norm yazi kurallarina uygun olarak 
yaziniz.
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Uygulama: Paralel Çizgiler Çizme

Paralel çizgi çizmek için aşağidaki yönergeleri uygulayiniz.
• 30ox60ox900lik ve 45ox45ox900lik gönyelerinizi teknik resim defterinizin çalişma sayfasina Görsel 1.10’daki 

gibi yerleştiriniz.
• Gönyelerinizi sabit tutarak 45ox45ox900lik gönyenizin üst kenari ile bir çizgi çiziniz.

  

Görsel 1.10: İlk doğruyu çizme

• 45ox45ox900lik gönyenizi diğer gönyenizi sabit tutarak aşaği veya yukariya kaydirip tekrar bir çizgi çiziniz.

Görsel 1.11: İlk doğruya paralel doğruyu çizme

• Son işlemi tekrarlayarak istediğiniz kadar paralel çizgi çiziniz. Bu işlemi diğer çizgi çeşitleriyle de 
tekrarlayiniz.

Görsel 1.12: Çeşitli türlerde paralel doğrular çizme

Dikkat

30ox60ox900 gönye kesinlikle hareket ettirilmemelidir.
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Uygulama: Doğrunun Üzerindeki Herhangi Bir Noktadan Dikme Çıkma

Doğrunun üzerindeki herhangi bir noktadan dikme çikmak için aşağidaki yönergeleri uygulayiniz.
• Teknik resim defterinize AB doğrusunu çiziniz.
• O noktasindan doğruya A ve B yönünde iki yay çiziniz, bu noktalari C ve D olarak adlandiriniz.

Görsel 1.13: Doğru üzerinde C ve D noktalarını bulma

• C ve D noktalari merkez olmak üzere doğru üzerinde kesişecek şekilde iki yay çiziniz ve kesişen noktayi 
E olarak adlandiriniz.

Görsel 1.14: E noktasını bulma

• E noktasi ile O noktasini bir doğru ile birleştiriniz. Böylece AB doğru parçasina dikme çikmiş olacaksiniz.

Görsel 1.15: E ve O noktasını birleştirme
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Uygulama: Dik Açı Oluşturma

Dik açi oluşturmak için aşağidaki yönergeleri uygulayiniz.
• Teknik resim defterine BA doğrusunu çiziniz.
• A noktasi merkez olacak şekilde pergeli istenilen değerde açarak AB doğrusunu kesen bir yay çiziniz ve 

doğruyu kesen noktayi C olarak adlandiriniz.

Görsel 1.16: Doğru üzerinde C noktasını bulma

•  C merkezli önceki yayi kesecek bir yay çiziniz ve yayi kesen noktayi D olarak adlandiriniz.

Görsel 1.17: Yay üzerinde D noktasını bulma

• C ve D noktasindan geçecek şekilde bir doğru çiziniz. 
• D noktasini merkez alarak çizilen doğruyu kesecek şekilde bir yay çiziniz ve kesişen noktayi E olarak 

adlandiriniz.

Görsel 1.18: D ve E noktalarını bulma

Dikkat

Pergelin ölçüsünü kesinlikle bozmayiniz.
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• A ve E noktalarini birleştiriniz. 

Görsel 1.19: A ve E noktalarının birleştirilmesi

Uygulama: Doğru Parçasını Dört Eşit Parçaya Bölme

Doğru parçasini dört eşit parçaya bölmek için aşağidaki yönergeleri uygulayiniz.
• Teknik resim defterine AB doğrusu çiziniz. 
• AB doğru parçasinin altında veya üstünde olacak şekilde, istenilen açida yardimci bir x doğrusu çiziniz. 

Görsel 1.20: Yardımcı x doğrusunu çizme

• x doğrusu üzerine pergel yardimiyla dört yay kadar işaret koyunuz. 

Görsel 1.21: x doğrusu üzerine eşit aralıklı yay çizimi

• İşaretlenen C ile B noktasini birleştiriniz. 

Görsel 1.22: C ve B noktalarının birleştirilmesi
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• Gönye yardimiyla CB doğru parçasina paralel doğrular çizerek AB doğrusunu dört eşit parçaya bölünüz. 

Görsel 1.23: CB doğru parçasına paralel çizgilerin çizimi

  1.1.2.2. Çokgenlerin Çizimi

Uygulama: Daire İçine Eşkenar Üçgen Çizme

Daire içine eşkenar üçgen çizmek için aşağidaki yönergeleri uygulayiniz.
• Teknik resim defterinize ilk önce O merkezli, birbirine dik iki eksen çiziniz. Pergel yardimiyla da O merkezli 

bir daire çiziniz. 
• Dairenin eksen çizgilerini kestiği noktalari A, B, C ve D olarak adlandiriniz.

Görsel 1.24: Koordinat düzlemi üzerine daire çizimi

• D noktasini merkez alarak O noktasindan geçecek ve daireyi kesecek şekilde bir yay çiziniz. 
• Yayin daireyi kestiği noktalari E ve F olarak adlandiriniz. E ve F noktalarini cetvel yardimiyla birleştiriniz.

Görsel 1.25: E ve F noktalarını bulma ve birleştirme

Sıra Sizde 4

Teknik resim defterinize bir doğru parçasi çizerek doğruyu yedi eşit parçaya bölünüz.
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• Cetvel yardimiyla B ve E ile B ve F noktalarini birleştiriniz. Böylece eşkenar üçgen oluşturacaksiniz.

Görsel 1.26: B ve E ile B ve F noktalarını birleştirme

Uygulama: Daire İçine Eşkenar Dörtgen Çizme

Daire içine eşkenar dörtgen çizmek için aşağidaki yönergeleri uygulayiniz.
• Teknik resim defterinize ilk önce O merkezli birbirine dik iki eksen çiziniz. Pergel yardimiyla da O merkezli 

bir daire çiziniz. 
• Dairenin eksen çizgilerini kestiği noktalari A, B, C ve D olarak adlandiriniz.
• Pergeli B-C araliği kadar açiniz. 
• B ve C noktalarindan dairenin dişina birer yay çiziniz. 
• Yaylarin birbirini kestiği noktayi E olarak adlandiriniz. 
• A ve B noktalarindan dairenin dişina birer yay çiziniz. 
• Yaylarin birbirini kestiği noktayi F olarak adlandiriniz.

Görsel 1.27: E ve F noktalarını bulma

• E ve O noktalarindan geçecek,  daire kenarlarini kesecek bir doğru çiziniz. 
• F ve O noktalarindan geçecek, daire kenarlarini kesecek bir doğru daha çiziniz. 
• Doğrularin daireleyi kestiği noktalari k, l, m, n olarak adlandiriniz. 

Görsel 1.28: k, l, m ve n noktalarını bulma
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• k-l, l-m, m-n ve n-k noktalarini birleştirdiğinizde eşkenar dörtgen ortaya çikacaktır.

Görsel 1.29: Eşkenar dörtgeni oluşturma

Uygulama: Daire İçine Eşkenar Beşgen Çizme

Daire içine eşkenar beşgen çizmek için aşağidaki yönergeleri uygulayiniz.
• Teknik resim defterinize birbirine dik çizilen iki eksen üzerine istenilen yariçapta pergel açarak O merkezli 

bir daire çiziniz. 
• Dairenin eksen üzerinde kesiştiği noktalari A, B, C, D olarak adlandiriniz.
• C noktasini merkez alarak O noktasindan geçecek ve daireyi kesecek bir yay çiziniz. 
• Yayin daireyi kestiği noktalari E ve F olarak adlandiriniz. 
• E ve F noktalarini birleştiren bir doğru çiziniz. 
• Doğrunun ekseni kestiği noktayi S olarak adlandiriniz.

Görsel 1.30: E ve F noktalarını bulma ve birleştirme

• Pergeli S-B araliği kadar açarak S merkezli bir yay çiziniz. 
• Yayin ekseni kestiği noktayi T olarak adlandiriniz. 
• Pergeli T-B araliği kadar açarak B merkezli bir yay çiziniz. 
• Yayin daireyi kestiği noktalari I ve K olarak adlandiriniz.

Görsel 1.31: T ve K noktalarını bulma
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• I ve K merkezli, daireyi kesen birer yay çiziniz. 
• Yaylarin daireyi kestiği noktalari M ve N olarak adlandiriniz. 
• B, I, M, N ve K noktalarini birleştirdiğinizde eşkenar bir beşgen ortaya çikacaktır.

Görsel 1.32: M ile N noktalarını bulma ve eşkenar beşgeni oluşturma

Uygulama: Daire İçine Eşkenar Altıgen Çizme

Daire içine eşkenar altıgen çizmek için aşağidaki yönergeleri uygulayiniz.
• Teknik resim defterinize birbirine dik çizilen iki eksen üzerine pergel açarak istenilen yariçapta O merkezli 

bir daire çiziniz. 
• Dairenin eksen üzerinde kesiştiği noktalari A, B, C, D olarak adlandiriniz.
• C noktasi merkezli, O noktasindan geçecek ve daireyi kesecek bir yay çiziniz. 
• Yayin daireyi kestiği noktalari E ve F olarak adlandiriniz. 
• A noktasi merkezli, O noktasindan geçecek ve daireyi kesecek bir yay çiziniz. 
• Yayin daireyi kestiği noktalari G ve H olarak adlandiriniz.

Görsel 1.33: E, F, G ve H noktalarını bulma

• G, A, H, E, C ve F noktalarini cetvel yardimiyla birleştirdiğinizde daire içinde düzgün bir altıgen elde 
edeceksiniz.

Görsel 1.34: Düzgün altıgeni çizme
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1.2. İzdüşüm Görünüşlerini Çizme ve Ölçeklendirme
1.2.1. İzdüşüm Tanımı ve Sınıflandırılması

İzdüşüm, cismin bir düzlem üzerine çizilmiş şekli veya izdüşüm düzlemine düşen görüntüsüdür. Örneğin, 
bir işik kaynağindan (odak noktasi) çikan işinlarla (izdüşüm işinlari) bir cismin duvara düşen görüntüsü bir 
izdüşümdür.  

İki çeşit izdüşüm vardir.
• Merkezî (Konik) İzdüşüm: Işik kaynağinin yakin mesafede olmasi, cismin boyutlarinin küçülerek 

veya büyüyerek izdüşüm düzlemine düşmesiyle oluşan izdüşümdür. Bu izdüşüm; mimari, reklam ve 
dekorasyon teknik resimlerinin çizimlerinde kullanilir.

Görsel 1.35: Konik izdüşüm

• Paralel İzdüşüm: Işik kaynağinin sonsuzda olmasi, cismin boyutlarinin izdüşüm düzlemine büyüme veya 
küçülme göstermeden düşmesiyle elde edilen izdüşümdür. Paralel izdüşüm, eğik ve dik izdüşüm olmak 
üzere ikiye ayrilir. 

Görsel 1.36: Paralel izdüşüm

1.2.2. İzdüşüm Düzlemleri

Üretimi yapilacak bir parçanin sadece bir yüzeyinin görüntüsü o parçayi tanimlamaya yetmez. Cismin 
tek yönden görünüşü o cisim hakkinda yeterli bilgiyi vermez. Bu nedenle cisimlerin görüntüleri birden fazla 
izdüşüm düzlemine düşürülür. Üzerine izdüşüm çizilecek olan düzlemler birbirine bitişik ve dik kabul edilir. 
Diedri, temel izdüşüm düzlemlerini bir arada bulunduran kapali şekildir.
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Uygulama: Noktanın İzdüşümü

Uzaydaki bir noktanin düzlem yüzeylerine dik gelen işinlarinin değme noktalari, o noktanin izdüşümünü 
verir. Bir a noktasinin uzaydaki yerini belirlemek için aralik, kot ve uzaklik değerleri olmak üzere üç elemana 
ihtiyaç vardir. Teknik resimde bir a noktasinin izdüşümü çikarilirken Aralık (noktanin profil izdüşümüne 
olan mesafesi), Kot (noktanin yatay izdüşümüne olan mesafesi), Uzaklık (noktanin alin izdüşümüne olan 
mesafesi) değerleri bilinmelidir.

 Diedri üzerinde bulunan izdüşüm düzlemleri şunlardir:
1. Alın izdüşüm düzlemi: Önden görünüm için kullanilir. 
2. Yatay izdüşüm düzlemi: Yandan görünüm için kullanilir.
3. Profil izdüşüm düzlemi: Üstten görünüm için kullanilir. 

Görsel 1.37: Diedri çizimi

a noktasinin (Aralik: 3, Kot: 5, Uzaklik: 5) izdüşümlerini bulmak için aşağidaki yönergeleri uygulayiniz.
• Teknik resim defterinize boş bir koordinat düzlemi çiziniz.
• Kot: 5 ve Aralik: 3 değerlerine bakarak alin bölgesine y ekseni kot, x ekseni aralik olacak şekilde noktayi 

yerleştiriniz.

Görsel 1.38: Noktanın alın izdüşüm düzlemindeki görüntüsü

Dikkat

Mavi ince kesik çizgiler taşima çizgileridir. Kalemi bastirmadan çiziniz.
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• Kot: 5 ve Uzaklik: 5 değerlerine bakarak profil bölgesine y ekseni kot, x ekseni uzaklik olacak şekilde 
noktayi yerleştiriniz.

Görsel 1.39: Noktanın profil izdüşüm düzlemindeki görüntüsü

• Alin bölgesindeki a noktasinin x eksenini kestiği çizgiyi yatay bölgesine kadar uzatıniz. 
• Pergeli profil bölgesindeki a noktasinin uzaklik değeri kadar açarak y eksenine dek O merkezli bir yay 

çiziniz. 
• Yayin kestiği noktadan kesik çizgi ile yatay bölgesine bir doğru çiziniz.  İki doğrunun yatay bölgesinde 

kesiştiği nokta, çizdiğiniz noktanin son izdüşümüdür. 

Görsel 1.40: Noktanın yatay izdüşüm düzlemindeki görüntüsü

 

Uygulama: Doğru Parçasının İzdüşümü

Uzayda iki nokta birleştirildiğinde bir doğru parçasi meydana gelir. Doğru parçasinin uç noktalarina ait 
izdüşümleri ayri ayri çizilip birleştirilirse doğrunun izdüşümleri elde edilir. 

İki uç noktasi a (Aralik: 3, Kot: 5, Uzaklik: 5) ve b (Aralik: 5, Kot: 2, Uzaklik: 6) olan doğru parçasinin 
izdüşümlerini bulmak için aşağidaki yönergeleri uygulayiniz.
• Teknik resim defterinize boş bir koordinat düzlemi çiziniz.
• a ve b noktasinin kot ve aralik değerlerine bakarak alin bölgesine iki noktayi yerleştirip birleştiriniz.

Dikkat

İzdüşümleri bitirdikten sonra taşima çizgilerini yumuşak silgi ile siliniz.
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Görsel 1.41: Doğru parçasının alın izdüşüm düzlemindeki görüntüsü

• a ve b noktasinin kot ve uzaklik değerlerine bakarak profil bölgesine iki noktayi yerleştirip birleştiriniz.

Görsel 1.42:  Doğru parçasının profil izdüşüm düzlemindeki görüntüsü

• Alin bölgesindeki a ve b noktasinin x eksenini kestiği çizgileri yatay bölgesine kadar uzatıniz. 
• Pergeli profil bölgesindeki a ve b noktalarinin uzaklik değeri kadar açarak y eksenine kadar O merkezli 

yaylar çiziniz.
• Yaylarin kestiği noktalardan kesik çizgi ile yatay bölgesine iki doğru çiziniz. İki doğrunun yatay bölgesinde 

kesiştiği noktalar, a ve b noktasinin son izdüşümüdür. 
• Yatayda oluşan a ve b noktalarini birleştirdiğinizde ab doğru parçasinin son izdüşümünü oluşturacaksiniz.

Görsel 1.43: Doğru parçasının yatay izdüşüm düzlemindeki görüntüsü
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Uygulama: Düzlemin İzdüşümü

Uzayda bulunan bir doğru parçasinin yön değiştirmeden ve kendi doğrultusunda olmayan hareketiyle 

meydana getirdiği yüzeylere düzlem denir. Düzlemler uzayda temel izdüşüm düzlemlerine göre çeşitli 
konumlarda bulunur. 

Üç köşe noktasi a (Aralik: 3, Kot: 5, Uzaklik: 5), b (Aralik: 5, Kot: 2, Uzaklik: 6) ve c (Aralik: 1, Kot: 2, Uzaklik: 
4) olan düzlemin izdüşümlerini bulmak için aşağidaki yönergeleri uygulayiniz.
• Teknik resim defterinize boş bir koordinat düzlemi çiziniz.
• a, b ve c noktalarinin kot ve aralik değerlerine bakarak alin bölgesine bu üç noktayi yerleştirip abc 

düzlemini oluşturunuz.

Görsel 1.44: Düzlemin alın izdüşüm düzlemindeki görüntüsü

• a, b ve c noktasinin kot ve uzaklik değerlerine bakarak profil bölgesine bu üç noktayi yerleştirip abc 
düzleminin profil izdüşümünü oluşturunuz.

Görsel 1.45: Düzlemin profil izdüşüm düzlemindeki görüntüsü

• Alin bölgesindeki a, b ve c noktasinin x eksenini kestiği çizgileri yatay bölgesine kadar uzatıniz. 
• Pergeli profil bölgesindeki a, b ve c noktalarinin uzaklik değeri kadar açiniz. Y eksenine kadar O merkezli 

yaylar çiziniz. 
• Yaylarin kestiği noktalardan kesik çizgi ile yatay bölgesine birer doğru çiziniz. Üç doğrunun yatay 

bölgesinde kesiştiği noktalar, a, b ve c noktalarinin son izdüşümleridir. 
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Görsel 1.46: Düzlemin profil izdüşüm düzlemindeki görüntüsü

 
1.2.3. Görünüş Çıkarma

Temel izdüşüm düzlemlerine (alin, profil ve yatay), dik izdüşüm yöntemiyle çizilen izdüşümlere görünüş 
adi verilir. Temel izdüşüm düzlemlerine parçalarin görünüşlerinin çizilmesine de görünüş çıkarma adi verilir. 

 Her parçanin yükseklik, genişlik ve derinlik olmak üzere üç boyutu vardir. Bir parçanin görünüşleri 
çizilmeden önce görünüşlerin isimleri ve konumlari belirlenir. Parçaya bakarak parça boyutlari ve 
görünüşlerin birbirleriyle ilişkileri bulunur. Görünüşlerde delikler veya kesik çizgiler (görünmeyen kisimlar) 
varsa ifade ettikleri yerler belirlenerek inceleme tamamlanir. 

Görsel 1.47: Parçanın önden, üstten ve yandan görünüşü

Sıra Sizde 5

Uç noktalarinin değerleri a (Aralik: 4, Kot: 4, Uzaklik: 3), b (Aralik: 4, Kot: 1, Uzaklik: 3), 
c (Aralik: 1, Kot: 1, Uzaklik: 1)  ve d (Aralik: 1, Kot: 4, Uzaklik: 1) olan abcd düzleminin 
izdüşümlerini koordinat düzlemi üzerine çiziniz.

Dikkat

Görünüşler düzleme yerleştirilirken her bir görünüşün düzlem eksenlerine uzakliklari eşit 
olmalidir.
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Görsel 1.48: Görünüşlerin diedri üzerine yerleştirilmesi

Uygulama: Perspektifi Verilen Parçanın Üç Görünüşünü Koordinat Düzlemine Çıkarma 

Perspektifi verilen parçanin üç görünüşünü koordinat düzlemine çikarmak için  aşağidaki yönergeleri 
uygulayiniz.

Görsel 1.49: Üç görünüşü çizilecek parça

• Koordinat düzlemini çiziniz ve cismi inceleyiniz. 
• Parçanin ön, yan ve üst görünüşünün nasil olabileceğini düşünüp boş bir yere kabaca çizerek oranli bir 

şekilde ölçülerini planlayiniz.
• Kenarlar için ince çizgi, görünmeyen kenarlar için ince kesik çizgi ve eksenler için noktali ince kesik çizgi 

kullaniniz. 
• Parçanin görünüşünün düzgün yerleştirilmesi için y ve x ekseninde bulunan eşit araliklari kullanarak 

orantili bir şekilde taşima çizgileri çiziniz. 
• Koordinat düzlemi üzerine parçanin ön görünüşünü çiziniz.
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Görsel 1.50: Parçanın ön görünüşünün diedri üzerine yerleştirilmesi

• Parçanin yan görünüşünü koordinat düzlemine yerleştirmek için her doğrunun uç noktalarinin 
izdüşümlerini profil bölgesinde bulunuz. 

• Taşima çizgilerinizi profil bölgesine uzatarak parçanin yan görünüşünü çiziniz. 

Görsel 1.51: Parçanın yan görünüşünün diedri üzerine yerleştirilmesi

Dikkat

Görünüşler ile eksenler arasinda 1 birim boşluk birakmayi unutmayiniz. Eksenlerden 
çizdiğiniz taşima çizgilerini kolayca silinebilecek şekilde hafif çiziniz.
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• Parçanin üst görünüşünü koordinat düzleminde yerleştiriniz. 

 

Görsel 1.52: Parçanın üst görünüşünün diedri üzerine yerleştirilmesi

• Taşima çizgilerinizi dikkatli bir şekilde siliniz. 

 

Görsel 1.53: Görünüşlerin son görünümü
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Görsel 1.54: Görünüş çıkarılacak parçanın perspektifi

1.2.4. Ölçeklendirme ve Ölçekler

İstenilen parçalarin yapimi için gerekli ölçülerin belirli kurallara göre parça veya görünüşlerin üzerine 
yazilmasi işlemine ölçeklendirme adi verilir. 

Teknik resim kurallarina göre çizilmiş parçanin görünüşleri sadece parçanin şekli hakkinda bilgi verebilir. 
Bu nedenle parçanin boyutlarinin ölçülerine ihtiyaç vardir. Ayri ayri yapilan parçalar birleştirildiğinde 
sorunsuz çalişmalidir. Bu parçalarin üretimi ancak eksiksiz ve kurallara uygun ölçülendirilmiş çizimlerle 
mümkündür. 

Teknik resmi çizilen parçanin resim üzerindeki çizim ölçüsünün o parçanin gerçek ölçüsüne oranina 
ölçek adi verilir.

Gerçek ölçek, küçültme ölçeği ve büyültme ölçeği olmak üzere üç tür ölçek vardir.

• Gerçek Ölçek: Parçanin gerçek ölçüleri ile yapilan ölçeklendirme çeşididir. Ölçek 1:1 olarak belirtilir.
• Küçültme Ölçeği: Parçanin ölçülerinin küçültülerek çizildiği ölçeklendirme çeşididir. 1:10, 1:20, 1:30 … 

olarak belirtilir.
• Büyültme Ölçeği: Parçanin ölçülerinin büyültülerek çizildiği ölçeklendirme çeşididir. 2:1, 5:1, 10:1 … 

olarak belirtilir.

Ölçeklendirme çizim elemanlari ve çizim kurallari şunlardir:

• Ölçü Sınır Çizgisi: Çizgi kalinliği 0,25 mm olan, sürekli ve düz çizgidir.  Bu çizgiler mutlaka birbirine 
paralel olmalidir. Ölçeklendirme yapilacak yüzeylerin kenar noktalarindan uzatılarak kullanilmalidir.

Sıra Sizde 6

Aşağida perspektifi verilen parçanin görünüşlerini teknik resim kurallarina göre 
koordinat düzlemi üzerine çiziniz.
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• Ölçü Çizgisi: Çizgi kalinliği 0,25 mm olan, sürekli ve her iki ucunda ok şekli bulunan düz çizgidir. Oklarin 
uç açisi 15 derece ve ikizkenar üçgen şeklinde olmalidir. Ölçeklendirilen yüzeyin kenarindan yaklaşik 
7-10 mm uzaklikta, ölçülendirilecek kenara paralel ve birbirini kesmeyecek şekilde çizilmelidir.

• Ölçü Rakamları: Ölçü çizgisinin tam ortasina ve 0,5 mm üstüne yazilan rakamdir.

Görsel 1.55: Ölçeklendirme çizim elemanları

Uygulama: Görünüş Ölçülendirme

Görünüş ölçeklendirme için aşağidaki yönergeleri uygulayiniz.
• Aşağida verilen görünüşü teknik resim kurallarina göre cetvelle ölçerek teknik resim defterinize çiziniz.

Görsel 1.56: Ölçeklendirilecek görünüş

• Ölçü sinir çizgilerini çiziniz. 

Görsel 1.57: Görünüşün ölçü sınır çizgilerinin çizilmesi
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• Ölçü çizgilerini çiziniz. 

Görsel 1.58: Görünüşün ölçü çizgilerinin çizilmesi

• Norm yazi kurallarina göre ölçü rakamlarini yaziniz. 

Görsel 1.59: Görünüşün ölçü rakamlarının yazılması

Dikkat

Resimler hangi ölçekle çizilirse çizilsin, üzerine parçanin gerçek büyüklüğünü gösteren 
ölçüler yazilmalidir.
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Görsel 1.60: Parça perspektifi

Sıra Sizde 7

Aşağida perspektifi verilen parçanin üç görünüşünü çikarip ölçülendiriniz.
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1. Teknik resimde görünmeyen kenarlar ve çevreler aşağıdakilerden hangisi ile çizilir?

A) Sürekli ince çizgi B) Sürekli kalin çizgi C) Kesik orta çizgi

                   D) İnce kesik çizgi                E) Noktali kesik ince çizgi

2. Teknik resimde kullanılan kurşun kalemlerden orta sertlikteki kalemlerin kodu aşağıdakilerden 
hangisidir?

A) 2H B) 2B C) HB D) 3H E) 3B

3. Aşağıdaki yazı tiplerinden hangisinin yazı kalınlığı daha incedir?

A) Yazi tipi A B) Yazi tipi B C) Yazi tipi C

                 D) Eğik yazi E) Dik yazi

4. 45-30-60 derecelik gönyeler ile aşağıdaki açılardan hangisi çizilemez?

A) 45 B) 75 C) 105 D) 90 E) 20

5. Teknik resimde aşağıdaki kâğıtlardan hangisi kullanılmaz?

A) Aydinger B) Kraft kâğidi C) Ozalit kâğidi

                D) Milimetrik kâğit            E) Saydam olmayan resim kâğidi

6.  I. Pergel
 II. 450lik gönye
 III. 300-600lik gönye
 IV. İletki

 Birbirine paralel çizgiler çizmek için yukarıdaki araçların hangisi ya da hangilerinin kullanılması  
 yeterlidir?

A) I ve II B) III ve IV C) II ve III

D) II ve IV E) I, II ve III

Ölçme ve Değerlendirme
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7. Bir cismin izdüşüm düzlemine düşen görüntüsüne verilen ad aşağıdakilerden hangisidir?

A) İzdüşüm B) İzdüşüm işini C) İzdüşüm noktasi

               D) Odak noktasi E) Bakiş açisi

8. Teknik resimde en çok kullanılan izdüşüm şekli aşağıdakilerden hangisidir?

A) Konik izdüşüm B) Eğik izdüşüm C) Dik izdüşüm

                              D) Paralel izdüşüm E) Çapraz izdüşüm

9. İzdüşüm ışınlarının çıktığı varsayılan noktaya verilen ad aşağıdakilerden hangisidir?

A) İzdüşüm noktasi B) İzdüşüm işini noktasi C) İzdüşüm noktasi

           D) Odak noktasi E) Paralel izdüşüm noktasi

10. 

1.Bölge 2.Bölge

3.Bölge

 Yukarıdaki koordinat düzleminde 1.Bölge, 2.Bölge ve 3.Bölge olarak tanımlanan bölgelerin   
 sıralanışı aşağıdakilerden hangisinde doğru verilmiştir?

A) Alin-Profil-Yatay     B) Yatay-Alin-Profil C) Profil-Alin-Yatay

        D) Alin- Yatay-Profil           E) Profil-Yatay-Alin
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11. Alın bölgesine yerleştirilen görünüş aşağıdakilerden hangisidir?

A) Arka B) Yan C) Alt

D) Üst E) Ön

12. Noktanın izdüşümü çıkarılırken noktanın alın izdüşümüne olan mesafesine verilen ad aşağıdakilerden 
hangisidir?

A) Uzaklik B) Aralik C) Kot

D) Değer E) İzdüşüm

13. Cisimlerin görünüşlerinin temel izdüşüm düzlemlerine çizilmesine verilen ad aşağıdakilerden 
hangisidir?

A) Görünüş B) Görünüş çikarma C) Ön görünüş

D) Üst görünüş                             E) İzdüşüm

14. Parça ölçülerinin kendisi veya görünüşlerinin üzerine yazılmasına verilen ad aşağıdakilerden 
hangisidir?

A) Ölçü çizgisi B) Ölçeklendirme C) Ölçü

D) İzdüşüm E) Ölçü alma

15. Ölçü çizgisinin çizgi kalınlığı aşağıdakilerden hangisidir?

A) 0,5 mm B) 0,75 mm C) 0,25 mm

D) 0,1 mm                                E) 0,4 mm
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KAVRAMLAR 

Üç Boyutlu Tasarım 

Üç Boyutlu Modelleme 

Üç Boyutlu Yazıcı
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ÖĞRENME BİRİMİ BÖLÜMLERİ

Çizim Programı Arayüzü

Üç Boyutlu Modelleme
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2.1. Çizim Programı Arayüzü
2.1.1. Hesap Oluşturma

Web arayüzlü çizim programının en önemli özelliği, tek kullanıcı hesabıyla tüm ortamlardan kullanıcının 
oluşturduğu tasarımlara ulaşılabiliyor olmasıdır. Çizim programının Türkçe desteği bulunmaktadır. Tasarım 
yapılabilmesi için kayıt işlemi gerekmektedir. Çizim programına herkes kayıt yaptırabilir. 12 yaşından küçük 
bir kullanıcı kayıt yaptıysa ebeveyninin mail adresine bir aktivasyon bilgisi gitmektedir.  Kullanıcı, ebeveyni 
onayladıktan sonra sisteme giriş yapabilmektedir.

Uygulama: Hesap Oluşturma

Hesap oluşturma işlemi için aşağıdaki yönergeleri uygulayınız.

• Çizim programı web sitesine giriniz.
• Sağ üst köşede yer alan Hemen Katıl linkine tıklayınız.

Görsel 2.1: Çizim programına giriş

• Kişisel Hesap Oluştur linkine tıklayınız.
• Hesap oluşturma yöntemleri için birden fazla seçenek sunulmaktadır. Diğer oturum açma seçeneklerinde 

OAuth yöntemi ile oturum açabilirsiniz. E-posta yöntemi ile devam etmek için E-postayla Kaydol 
linkine tıklayınız.

• Ülke ve doğum tarihi seçeneklerini uygun şekilde işaretleyiniz. 
• Sonraki linkine tıklayınız.

• E-posta adresinizi giriniz.
• Şifrenizi giriniz.

Dikkat

OAuth, kullanıcıların kendi hesaplarına ait şifreleri paylaşmadan üçüncü taraf web 
sitelerine erişmek için kullanılan açık standartlı bir yetkilendirme protokolüdür.

Dikkat

Şifre belirlerken güçlü şifre ölçütlerine uygun bir şifre oluşturulmalıdır. Şifre ölçütleri; en 
az 1 harf, en az 1 sayı, en az 8 karakter, en az 3 benzersiz karakter girilmesidir.

1.  Üç boyutlu çizim programlarını araştırınız.

2. Üç boyutlu yazıcıları araştırınız.

2.BİLGİSAYARLI ÇİZİM
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• Hizmet şartlarını ve gizlilik beyanını kabul ediniz.
• Hesap oluştur linkine tıklayınız.

Görsel 2.2: Hesap oluşturma

2.1.2. Çizim Programı Ortamı

Çizim programı, kolay anlaşılabilir bir arayüze sahiptir. Çizim programına giriş yapıldıktan sonra 
aşağıdaki arayüz ekrana gelecektir. 

Görsel 2.3: Çizim programı arayüzü

Sol menüden;

• Üç boyutlu tasarım yapılmak isteniyorsa 3D Tasarımlar menüsü,
• Arduino ile sanal devreler kurulmak isteniyorsa Circuits menüsü,
• Kod blokları ile üç boyutlu tasarım yapılmak isteniyorsa Kod 

Blokları menüsü,
• Daha önceden tamamlanmış eğitimler görüntülenmek 

isteniyorsa Dersler menüsü seçilmelidir.

Üst menüden;

• Çizim programına kayıtlı kullanıcıların paylaşımlarını incelemek 
ve kullanmak için Galeri menüsü,

• Çizim programı ile ilgili çalışmalar incelenmek istenirse Blog 
menüsü,

Görsel 2.4: Çizim programı sol menüsü
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Görsel 2.5: Çizim programı üst menüsü

• Çizim programına yeni başlayanların kendi kendilerine öğrenme sağlayabilmeleri için Öğren menüsü,
• Öğretmenlerin öğrenci grupları oluşturup takip edebilmesi için Öğret menüsü,
• Kullanıcı profili ile ilgili işlem yapılmak isteniyorsa profil resmi seçilmelidir. 
• Son olarak arayüzün orta alanı ise kullanıcı tarafından daha önceden oluşturulmuş tasarımların yer 

aldığı bölümdür.

2.1.3. Yeni Tasarım Oluşturma

Çizim programı yeni oluşturulan her tasarıma otomatik olarak isim vermektedir.  Kullanıcı, bu ismi 
değiştirerek tasarımlara istediği adı verebilmektedir. Yeni bir tasarım oluşturmak için Yeni Tasarım Oluştur 
düğmesine tıklanması yeterli olacaktır. 

2.1.4. Çalışma Düzlemi Kontrolleri

Çizim programı tasarım ortamı, kullanıcılara kolaylık sağlayacak şekilde tasarlanmıştır.

Uygulama: Temel Kontroller

Çalışma düzleminde yer alan kontrolleri kullanmak için aşağıdaki yönergeleri uygulayınız.

• Yeni bir tasarım oluşturunuz.
• Çizim programının tasarıma verdiği ismi değiştirmek için tasarım ismini tıklayınız.
• Tasarımın adını İlk Tasarım olarak değiştiriniz.

Görsel 2.6: İlk Tasarım

Dikkat

Çizim programında daha önceden tasarlanmış bir tasarım üzerinde değişiklik yapıldığında 
çevrimiçi olarak değişiklik yapıldığı için tüm ortamlarda değişiklik uygulanacaktır.

Dikkat

 Kayıtlı tasarımlar üzerinde çalışmak için tasarım seçilerek Bunu düzenle düğmesine 
tıklanmalıdır.

Sıra Sizde 1

İkinci Tasarım adında yeni bir tasarım oluşturunuz.
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Uygulama: Temel İşlem Kontrolleri

Çalışma düzleminde yer alan kontrolleri kullanmak için aşağıdaki yönergeleri uygulayınız.

• Yeni bir tasarım oluşturunuz.
• Tasarımın adını Temel İşlem Kontrolleri olarak değiştiriniz.
• Çalışma düzleminin sağ tarafında yer alan kutu şeklini çalışma düzlemine sürükleyerek ekleyiniz.

Görsel 2.7: Şekillerin çalışma düzlemine eklenmesi

• Çalışma düzleminde seçili şekli kopyalamak için Kopyala (Ctrl+C) düğmesine tıklayınız.
• Kopyalanan şekli yapıştırmak için Yapıştır (Ctrl+V) düğmesine tıklayınız.
• Çalışma düzleminde seçili şekli çoğaltmak için Duplicate and repeat (Ctrl+D) düğmesine tıklayınız.
• Çalışma düzleminde seçili şekli silmek için Sil (Delete) düğmesine tıklayınız.
• Son yapılan işlemleri geri almak için Geri Al (Ctrl+Z) düğmesine tıklayınız.
• Son yapılan işlemleri yinelemek için Yinele (Ctrl+Y) düğmesine tıklayınız.

Görsel 2.8: Temel işlem kontrolleri 

Tasarıma farklı açılardan bakmak, tasarımı kolaylaştıracaktır. Tasarımlara farklı açıdan bakmak için 
görünüm kontrolleri kullanılır.
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Uygulama: Görünüm Kontrolleri 1

Çalışma düzleminde yer alan kontrolleri kullanarak görünümü değiştirmek için aşağıdaki yönergeleri 
uygulayınız.

• Yeni bir tasarım oluşturunuz.
• Tasarımın adını Görünüm Kontrolleri 1 olarak değiştiriniz.
• Çalışma düzlemine kutu ekleyiniz.
• Çalışma düzleminin sol tarafında yer alan görünüm küpünü fare (mouse) ile yönlendirerek tasarım 

ortamının bakış açısını değiştiriniz.

Görsel 2.9: Görünüm değiştirme

• Çalışma düzleminin tamamını görmek için Ana Ekran görünümü düğmesine tıklayınız.
• Çizilen şekli ekrana sığdırmak için Tümünü görünüme sığdır (F) düğmesine tıklayınız.
• Çalışma düzleminin görünümünü yakınlaştırmak için Yakınlaştır (+) düğmesine tıklayınız.
• Çalışma düzleminin görünümünü uzaklaştırmak için Uzaklaştır (-) düğmesine tıklayınız.

• Çizilen şeklin iki boyutlu görünümüne geçmek için Düz görünüme geç düğmesine tıklayınız.

Görsel 2.10: Düz görünüme geç düğmesi

Dikkat

Çalışma düzlemini yakınlaştırmak veya uzaklaştırmak için farenin tekerleği de kullanılabilir.
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Uygulama: Görünüm Kontrolleri 2

Çalışma düzleminin boyutunu değiştirmek için aşağıdaki yönergeleri uygulayınız.

• Yeni bir tasarım oluşturunuz.
• Tasarımın adını Görünüm Kontrolleri 2 olarak değiştiriniz.
• Çalışma düzleminin boyutunu değiştirmek için Çalışma düzlemi ölçümleri düğmesine tıklayınız.

Görsel 2.11: Çalışma alanı ölçümleri düğmesi

• Birimler bölümünü seçerek ölçü birimini değiştiriniz.
• Genişlik ve uzunluk değerlerini değiştiriniz.

• Izgarayı Güncelle linkine tıklayarak çalışma düzlemi ölçülerini değiştiriniz.
• Şekillerin taşınması sırasında kılavuz çizgilerine tutunma aralıklarını değiştirmek için Izgarayı Tuttur 

seçeneğini işaretleyiniz.

Görsel 2.12: Izgarayı tuttur düğmesi

Dikkat

 Çizim programı, çalışma düzleminde genişlik ve uzunluk için maksimum 1000 mm 
ölçüsünü desteklemektedir.

Sıra Sizde 2

Ana sayfaya dönerek önceden oluşturduğunuz başka bir tasarımı açınız.
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2.2. Üç Boyutlu Modelleme
Nesneler gerçek dünyada üç boyutlu olarak algılanır. Üç boyut; bir nesneye ait yükseklik, genişlik 

ve derinlik algısıdır. Çeşitli programlar aracılığıyla bir nesnenin çiziminde genişlik, yükseklik ve derinlik 
özelliklerinin kullanılması üç boyutlu modelleme olarak tanımlanır. İstenilen şeklin modelini hazırlamak 
için hangi tekniğin kullanıldığından çok gerçeğe ne kadar yaklaşıldığı önemlidir (Güler, 2014).

Üç boyutlu modelleme yapılırken nesnenin önden, yandan ve üstten görünüşleri çıkartılır. Bu görünüşler 
üzerinde nesnenin modeli oluşturulur. Modelleme işlemi çeşitli yöntemlerle yapılabilir: Bir nesneye ait üç 
boyutlu model tek bir görüntüde hazırlanabilir veya nesnenin her bir parçası ayrı ayrı modellenerek bu 
parçaların birleştirilmesiyle de oluşturulabilir.

2.2.1. Temel Şekiller

Şekiller, çizim programının temel yapı nesneleridir. Çizim programı, üç boyutlu nesnelerin hemen 
hemen hepsini kullanıcıların hizmetine sunmaktadır. Çalışma düzlemine eklenerek bu şekiller üzerinde 
işlem yapılabilir, birden fazla şekille yeni şekiller tasarlanabilir.

Temel şekiller menüsü altında geometrik şekillerin üç boyutlu modelleri yer almaktadır. Metin ve 
sayılar menüsü altında üç boyutlu metin yazılmak istendiğinde kullanılabilecek modeller vardır. Karakterler 
menüsü altında tasarımlarda kullanılabilecek basit karakter tasarımları bulunmaktadır. Şekil oluşturucular 
altında ise tasarlanmış şekiller yer almaktadır.

Uygulama: Şekil Yerleştirme

Çalışma düzlemine bir şekil yerleştirmek ve şeklin görünümünü değiştirmek için aşağıdaki yönergeleri 
uygulayınız.

• Yeni bir tasarım oluşturunuz.
• Tasarımın adını Şekil Yerleştirme olarak değiştiriniz.
• Çalışma düzlemine bir kutu ekleyiniz.
• Şekil özelliklerinden kutunun rengini mavi olarak değiştiriniz.

Görsel 2.13: Şekil renk özelliği

• Çalışma düzlemine bir piramit ekleyiniz.

Dikkat

Üç boyutlu kavramı yerine 3B ifadesi de kullanılabilir.
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• Şekil özelliklerinden piramidin rengini kırmızı olarak değiştiriniz.
• Piramidin köşe sayısını şekil taraflar özelliğinden 10 olarak değiştiriniz.

Görsel 2.14: Şekil taraflar özelliği

• Çalışma düzlemine bir B harfi ekleyiniz.
• B harfinin rengini yeşil olarak değiştiriniz.

Görsel 2.15: Harf ekleme

• Karakter menüsünü seçiniz.
• Çalışma düzlemine Scuba Maskesi (dalış maskesi) karakterini ekleyiniz.

Görsel 2.16: Karakter ekleme
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Uygulama: Şekil Taşıma

Çalışma düzlemine eklenen şeklin yerini değiştirmek için aşağıdaki yönergeleri uygulayınız.

• Yeni bir tasarım oluşturunuz.
• Tasarımın adını Şekil Taşıma olarak değiştiriniz.
• Çalışma düzlemine yan yana dört tane kutu ekleyiniz.

Görsel 2.17: Taşınacak şekillerin eklenmesi

• Farenin sol tuşunu tıklayarak her kutuyu çalışma düzleminin köşelerine taşıyınız.

Görsel 2.18: Taşıma işlemi

Uygulama: Şekil Döndürme

Çalışma düzlemine eklenen şekli döndürmek için aşağıdaki yönergeleri uygulayınız.

• Yeni bir tasarım oluşturunuz.
• Tasarımın adını Şekil Döndürme olarak değiştiriniz.
• Çalışma düzlemine yan yana üç tane kutu ekleyiniz.

Görsel 2.19: Döndürülecek şekillerin eklenmesi
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• Döndürmek istediğiniz şekli seçiniz. Şekli döndürmek için tutamaçları kullanabilirsiniz.
• Döndürme işleminde en iyi görünümü elde etmek için çalışma düzlemini döndürünüz.
• Her şekli görselde görüldüğü gibi 45 derece döndürmek için eğri okları kullanınız.

Görsel 2.20: Şekil döndürme

Uygulama: Şekil Boyutlandırma

Çalışma düzlemine eklenen şekli boyutlandırmak için aşağıdaki yönergeleri uygulayınız.

• Yeni bir tasarım oluşturunuz.
• Tasarımın adını Şekil Boyutlandırma olarak değiştiriniz.
• Çalışma düzlemine üç tane kutu ekleyiniz.

Görsel 2.21: Boyutlandırılacak şekillerin eklenmesi

• Boyutlandırma işleminde en iyi görünümü elde etmek için çalışma düzlemini döndürünüz.
• Her şekli görselde görüldüğü gibi bir kenarı 50 mm olacak şekilde boyutlandırınız.

Görsel 2.22: Şekillerin boyutlandırılması
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2.2.2. Gruplama ve Grup Çözme

Temel şekillerle tasarım yapmak bazen yetersiz kalmaktadır. Temel şekiller birleştirilerek yeni şekiller 
oluşturulabilir.

Uygulama: Şekil Gruplama

Çalışma düzlemine eklenen şekilleri gruplandırmak için aşağıdaki yönergeleri uygulayınız.

• Yeni bir tasarım oluşturunuz.
• Tasarımın adını Şekil Gruplama olarak değiştiriniz.
• Çalışma düzlemine iki tane kutu ekleyiniz.

Görsel 2.23: Gruplama işlemi için birinci nesnelerin eklenmesi

• Çalışma düzlemine kutuların ortasına gelecek şekilde iki tane silindir ekleyiniz.
• Silindirleri 10x10x30 mm olacak şekilde boyutlandırınız.

Görsel 2.24: Gruplama işlemi için ikinci nesnelerin eklenmesi

• Shift tuşuna basılı tutarak birinci kutuyu ve birinci silindiri seçiniz.
• Üst menüden Gruplandır (Ctrl+G) düğmesine tıklayınız. Grup rengi, grubu oluştururken seçilen ilk şekil 

ile eşleşecektir.
• Shift tuşuna basılı tutarak ikinci silindiri ve ikinci kutuyu seçiniz.

Dikkat

Taşıma değeri, döndürme açısı ve boyut değerleri fare yardımıyla veya klavyeden değerler 
girilerek yapılabilir.

Sıra Sizde 3

Temel şekillerle ilgili taşıma, döndürme ve boyutlandırma işlemini silindir üzerinde 
uygulayınız.
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• Üst menüden Gruplandır (Ctrl+G) düğmesine tıklayınız. Grup rengi, grubu oluştururken seçilen ilk şekil 
ile eşleşecektir.

Görsel 2.25: Gruplanan şekiller

• Grubu çözmek için üst menüden Grubu Çöz (Ctrl+Shift+G) düğmesine tıklayınız.

2.2.3. Eksiltme Özelliği

Şekil birleştirme işleminde bir şekil, başka bir şekilden eksiltme yoluyla çıkartılarak yeni şekiller 
oluşturulabilir.

Uygulama: Şekil Eksiltme

Çalışma düzlemine eklenen şekillerde eksiltme işlemi yapmak için aşağıdaki yönergeleri uygulayınız.

• Yeni bir tasarım oluşturunuz.
• Tasarımın adını Şekil Eksiltme olarak değiştiriniz.
• Çalışma düzlemine bir kutu ekleyiniz.
• Çalışma düzlemine kutuların ortasına gelecek şekilde bir silindir ekleyiniz.
• Silindiri 10x10x30 mm olacak şekilde boyutlandırınız.
• Silindir şeklini seçiniz ve silindirin özelliklerinden Delik özelliğini seçiniz.

Görsel 2.26: Eksiltme uygulanacak şekillerin eklenmesi

• Shift tuşuna basılı tutarak kutuyu ve silindiri seçiniz.
• Üst menüden Gruplandır (Ctrl+G) düğmesine tıklayınız. Böylece kutu şeklinden silindir şekli eksiltilmiş 

olacaktır.

Görsel 2.27: Eksiltme uygulanan şekiller
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2.2.4. Hizalama Özelliği

Hizalama seçeneği, bir şekil oluştururken şekilleri sıralamak için kullanıcılara yardımcı olmaktadır. 
Hizalama işlemi, yatay ve dikey olmak üzere iki şekilde yapılabilir.

Uygulama: Şekil Hizalama

Çalışma düzlemine eklenen şekilleri hizalamak için aşağıdaki yönergeleri uygulayınız.

• Yeni bir tasarım oluşturunuz.
• Tasarımın adını Şekil Hizalama olarak değiştiriniz.
• Çalışma düzleminde farklı yerlere üç kutu ekleyiniz.
• Birinci şekle dokunmadan ikinci şekli 5 mm, üçüncü şekli ise 10 mm yükseltiniz.

Görsel 2.28: Hizalanacak şekillerin eklenmesi

• Shift tuşuna basılı tutarak üç şekli de seçiniz.
• Tüm şekiller seçiliyken üst menüde yer alan Hizala (L) düğmesine tıklayınız. Hizala düğmesine tıkladıktan 

sonra hizala tutamaçları şekillerin çevresinde görünür.
• Hizalamanın ön izlemesini görmek için farenizi siyah hizalama tutamaçlarının her birinin üzerine 

getiriniz.
• Hizalama tutamaçlarından herhangi birine tıklayarak şekilleri taşıyınız.
• Araç çubuğundaki Geri Al düğmesini kullanarak gerekirse son işleminizi geri alabilirsiniz.
• Çalışma düzlemindeki kutuları yatay hizalama tutamaçlarını kullanarak birinci kutuya yatayda 

hizalayınız.

Görsel 2.29: Yatay hizalama uygulanan şekiller

• Çalışma düzlemindeki kutuları dikey hizalama tutamaçlarını kullanarak ikinci kutuya dikeyde hizalayınız.
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Görsel 2.30: Dikey hizalama yapılan şekiller

2.2.5. Örnek Uygulamalar

Uygulama: Yüzük Yapımı

• Yeni bir tasarım oluşturunuz.
• Tasarımın adını Yüzük Yapımı olarak değiştiriniz.
• Çalışma düzlemine bir silindir ekleyiniz ve çapı 21 mm olacak şekilde silindiri boyutlandırınız.
• Çalışma düzlemine yeni bir silindir daha ekleyiniz ve çapı 17 mm olacak şekilde silindiri boyutlandırınız.
• Her iki şekli de seçiniz ve 4 mm yüksekliğe ölçeklendiriniz.
• İkinci silindiri seçerek silindirin özelliğini Delik olarak değiştiriniz.
• Hizalama özelliğini kullanarak şekilleri merkezde hizalayınız.
• Her iki ögeyi de seçili tutunuz ve menü çubuğundaki Gruplandır (Ctrl+G) düğmesini kullanarak bunları 

gruplandırınız.
• Çalışma düzleminde dik duracak şekilde yüzüğü döndürünüz.

Görsel 2.31: Çizim programı ile yüzük yapımı

Uygulama: Çikolata Yapımı

• Yeni bir tasarım oluşturunuz.
• Tasarımın adını Çikolata Yapımı olarak değiştiriniz.
• Çalışma düzlemine bir kutu ekleyiniz.
• Kutunun yüksekliğini 10 mm olarak ölçeklendiriniz.
• Kutunun enini ve boyunu 100x100 mm olarak ölçeklendiriniz.

http://kitap.eba.gov.tr/KodSor.
php?KOD=21370

http://kitap.eba.gov.tr/KodSor.
php?KOD=21371
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Görsel 2.32: Çikolata zemininin oluşturulması

• Çalışma düzlemine bir çatı şekli ekleyiniz.
• Çatının enini ve boyunu 20x100 mm olarak ölçeklendiriniz.
• Çatı şeklini Duplicate and repeat (Ctrl+D) düğmesi ile 6 adet yan yana çoğaltınız.
• Çatı şekillerini Gruplandır (Ctrl+G) düğmesi ile gruplandırınız.

Görsel 2.33: Gruplandırılmış çatı şekilleri

• Çatı şekillerini ters dönecek şekilde 180 derece döndürünüz.
• Kutu ve çatı grubunu Hizala (L) düğmesi ile merkezden hizalayınız.
• Çatı grubunu 5 mm yukarı kaldırınız.
• Çatı grubunun özelliğini Delik olarak değiştiriniz.
• Çatı grubunu Duplicate and repeat (Ctrl+D) düğmesi ile çoğaltınız.
• Yeni çatı grubunu yatayda 90 derece döndürünüz.

Görsel 2.34: Çikolata kalıbının oluşturulması

• Tüm şekilleri seçiniz ve Gruplandır (Ctrl+G) düğmesi ile gruplandırınız.
• Oluşturduğunuz şeklin rengini kahverengi olarak değiştiriniz.
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Görsel 2.35: Tamamlanmış çikolata tasarımı

Uygulama: Bayrak Yapımı

• Yeni bir tasarım oluşturunuz. 
• Tasarımın adını Bayrak Yapımı olarak değiştiriniz.
• Çalışma düzlemine bir kutu ekleyiniz.
• Kutunun yüksekliğini 3 mm olarak ölçeklendiriniz.
• Kutunun enini ve boyunu 100x150 mm olarak ölçeklendiriniz.

Görsel 2.36: Bayrak zemininin oluşturulması

• Çalışma düzlemine bir silindir ekleyiniz.
• Silindirin yüksekliğini 3,1 mm olarak ölçeklendiriniz.
• Silindir çapını 50 mm olarak ölçeklendiriniz.
• Çalışma düzlemine yeni bir silindir ekleyiniz.
• Silindirin yüksekliğini 3,5 mm olarak ölçeklendiriniz.
• Silindirin çapını 40 mm olarak ölçeklendiriniz.
• İki silindiri seçip Hizala (L) düğmesi ile merkezden hizalayınız.

Sıra Sizde 4

Çikolata yapımı uygulamasını farklı şekillerle yapınız.

http://kitap.eba.gov.tr/KodSor.
php?KOD=21372
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Görsel 2.37: Hilalin oluşturulması için silindirlerin kullanımı

• Küçük silindiri merkezden sağa doğru 6,25 mm kaydırınız.
• Küçük silindirin özelliğini Delik olarak değiştiriniz.
• İki silindiri seçerek Gruplandır (Ctrl+G) düğmesi ile gruplandırınız.
• Silindir grubunun rengini beyaz olarak değiştiriniz.

Görsel 2.38: Hilalin oluşturulması

• Kutu ve silindir grubunu orta-solda Hizala (L) düğmesi ile hizalayınız.
• Silindir grubunu 27 mm sağa kaydırınız.

Görsel 2.39: Hilalin yerleştirilmesi

• Çalışma düzlemine bir yıldız ekleyiniz.
• Yıldızın yüksekliğini 3,10 mm olarak ölçeklendiriniz.
• Yıldızı 110 derece döndürünüz.
• Yıldızın enini ve boyunu 23x23 mm olarak ölçeklendiriniz.
• Yıldızın rengini beyaz olarak değiştiriniz.
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Görsel 2.40: Yıldızın oluşturulması

• Kutu, yıldız ve silindir grubunu orta-sağda Hizala (L) düğmesi ile hizalayınız.
• Yıldızı 73 mm sağa kaydırınız.

Görsel 2.41: Tamamlanmış Türk Bayrağı

Uygulama: Bardak Yapımı

• Yeni bir tasarım oluşturunuz. 
• Tasarımın adını Bardak Yapımı olarak değiştiriniz.
• Çalışma düzlemine silindir ekleyiniz.
• Silindirin yüksekliğini 50 mm olarak ölçeklendiriniz.
• Silindirin çapını 50 mm olarak ölçeklendiriniz.
• Köşeli görüntüyü ortadan kaldırmak için silindir özelliğinde Taraflar değerini 64 olarak değiştiriniz.
• Silindiri çoğaltınız ve yeni silindirin çapını 47 mm olarak güncelleyiniz.
• İkinci silindirin yüksekliğini 60 mm olarak güncelleyiniz.
• İkinci silindirin özelliğini Delik olarak değiştiriniz.

Dikkat

Türk Bayrağının standart bir ölçüsü vardır ve şekli Türk Bayrağı Kanunu ile belirlenmiştir. 
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• İkinci silindiri 3 mm yükseltiniz.
• İki silindiri merkezde hizalayınız. 

Görsel 2.42: Bardak gövdesinin oluşturulması

• Çalışma düzlemine metin ekleyiniz ve şekil özelliklerinden metni BİLİŞİM olarak değiştiriniz.
• Metnin enini ve boyunu 40x20 mm olarak ölçeklendiriniz.
• Bardak gövdesi ile aynı görünümde olacak şekilde metni 90 derece döndürünüz.
• Bardak yüzeyinde ortada görünecek şekilde metni taşıyınız.

Görsel 2.43: Bardak metninin oluşturulması

• Birinci silindiri çoğaltınız ve çapını 55 mm olarak güncelleyiniz.
• Birinci silindir ile üçüncü silindiri merkezden hizalayınız.
• Üçüncü silindirin yüksekliğini 60 mm olarak güncelleyiniz.
• Üçüncü silindirin özelliğini Delik olarak değiştiriniz.

Görsel 2.44: Bardak metninin ovalleştirilmesi

• Çalışma düzlemine bir kutu ekleyiniz ve tüm şekli kapatacak şekilde kutuyu boyutlandırınız.
• Kutu ve üçüncü silindiri gruplandırınız.
• Kutunun özelliğini Delik olarak değiştiriniz.
• Tüm şekilleri seçerek gruplandırınız.
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Görsel 2.45: Bardak gövdesi

• Çalışma düzlemine bir halka ekleyiniz.
• Halkanın çapını 30 mm olarak ölçeklendiriniz.
• Halkayı dik duracak şekilde 90 derece döndürünüz.
• Halkayı bir kutu yardımı ile yarım halkaya dönüştürüp kulpu oluşturunuz.

Görsel 2.46: Bardak kulpunun oluşturulması

• Bardak gövdesine kulpu yerleştiriniz.
• Tüm şekilleri seçerek gruplandırınız.

Görsel 2.47: Bardak tasarımı

Uygulama: Kalemlik Yapımı

• Yeni bir tasarım oluşturunuz. 
• Tasarımın adını Kalemlik Yapımı olarak değiştiriniz.
• Çalışma düzlemine silindir ekleyiniz.
• Silindirin yüksekliğini 50 mm olarak ölçeklendiriniz.
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• Silindirin çapını 50 mm olarak ölçeklendiriniz.
• Köşeli görüntüyü ortadan kaldırmak için silindir özelliğinde Taraflar değerini 64 olarak değiştiriniz.
• Silindiri çoğaltınız ve yeni silindirin çapını 47 mm olarak güncelleyiniz.
• İkinci silindirin yüksekliğini 60 mm olarak güncelleyiniz.
• İkinci silindirin özelliğini Delik olarak değiştiriniz.
• İkinci silindiri 3 mm yükseltiniz.
• İki silindiri merkezden hizalayınız.
• İki silindiri gruplandırınız.

Görsel 2.48: Kalemlik gövdesinin oluşturulması

• Çalışma düzlemine metin ekleyiniz ve şekil özelliklerinden metni BİLİŞİM olarak değiştiriniz.
• Metnin enini ve boyunu 20x10 mm olarak ölçeklendiriniz.
• Kalemlik gövdesi ile aynı görünümde olacak şekilde metni 90 derece döndürünüz.
• Metnin özelliğini Delik olarak değiştiriniz.
• Kalemlik gövdesinde ortada görünecek şekilde metni taşıyınız.

Görsel 2.49: Kalemlik üzerine metin ekleme

• Çalışma düzlemine yıldız ekleyiniz.
• Yıldızın enini ve boyunu 10x10 mm olarak ölçeklendiriniz.
• Kalemlik gövdesi ile aynı görünümde olacak şekilde yıldızı 90 derece döndürünüz.
• Yıldızın uzunluğunu 60 mm olarak değiştiriniz.
• Kalemlik gövdesinin her iki yüzeyinde görünecek şekilde yıldızı taşıyınız.
• Yıldızı çoğaltınız ve yeni yıldızı 45 derece döndürünüz.
• İkinci yıldızı çoğaltınız ve üçüncü yıldızı 45 derece döndürünüz.
• Üçüncü yıldızı çoğaltınız ve dördüncü yıldızı 45 derece döndürünüz.
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Görsel 2.50: Kalemlik desenlerinin eklenmesi

• Yıldızları seçiniz ve özelliğini Delik olarak değiştiriniz.
• Tüm şekilleri seçiniz ve gruplandırınız.

Görsel 2.51: Tamamlanmış kalemlik tasarımı

 

Uygulama: Piyon Yapımı

• Yeni bir tasarım oluşturunuz.
• Tasarımın adını Piyon Yapımı olarak değiştiriniz.
• Çalışma düzlemine bir silindir ekleyiniz.
• Silindirin yüksekliğini 3 mm olarak değiştiriniz.
• Silindirin üstüne bir Çalışma Düzlemi (W) sürükleyiniz.

Görsel 2.52: Piyon tabanının yapılması

Sıra Sizde 5

Kalemlik üzerindeki yıldız sayısını artırarak daha fazla yıldız deseni oluşturunuz.

http://kitap.eba.gov.tr/KodSor.
php?KOD=21373
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• Bir koni şeklini silindirin üstüne ekleyiniz. 
• Koninin yüksekliğini 11 mm olarak değiştiriniz.
• Çalışma düzlemine bir küre ekleyiniz.
• Küreyi 18 mm çapında ölçeklendiriniz.

• Kürenin yüksekliğini 5 mm olarak ölçeklendiriniz.

Görsel 2.53: Piyon yapımı tabanının tamamlanması

• Çalışma düzlemine bir koni şekli ekleyiniz.
• Koninin yüksekliğini 28 mm olarak ölçeklendiriniz.
• Koninin çapını 14 mm olarak ölçeklendiriniz.
• Koniyi diğer şekillerin üstüne taşıyınız.
• Koniyi çalışma düzleminden 3 mm yükseltiniz.

Görsel 2.54: Piyon gövdesinin oluşturulması

• Başka bir koniyi çalışma düzlemine ekleyiniz.
• Koninin çapını 12 mm olarak ölçeklendiriniz. 
• Koninin yüksekliğini 19 mm olarak ölçeklendiriniz.
• Koniyi 180 derece döndürünüz.
• Koniyi 5 mm yükseltiniz.
• Koniyi diğer şekillerin üzerine taşıyınız.
• Bir çalışma düzlemini koninin üstüne sürükleyiniz.

 

Dikkat

Bir şekil üzerine çalışma düzlemi eklendiğinde yeni eklenen şekiller için çalışma 
düzlemi olarak yeni eklenen düzlem kabul edilecektir.

Dikkat

Bu aşamadan sonra gövde kullanılarak farklı satranç taşları tasarlanabilir.
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• Bir koni şeklini silindirin üstüne ekleyiniz. 
• Koninin yüksekliğini 11 mm olarak değiştiriniz.
• Çalışma düzlemine bir küre ekleyiniz.
• Küreyi 18 mm çapında ölçeklendiriniz.

• Kürenin yüksekliğini 5 mm olarak ölçeklendiriniz.

Görsel 2.53: Piyon yapımı tabanının tamamlanması

• Çalışma düzlemine bir koni şekli ekleyiniz.
• Koninin yüksekliğini 28 mm olarak ölçeklendiriniz.
• Koninin çapını 14 mm olarak ölçeklendiriniz.
• Koniyi diğer şekillerin üstüne taşıyınız.
• Koniyi çalışma düzleminden 3 mm yükseltiniz.

Görsel 2.54: Piyon gövdesinin oluşturulması

• Başka bir koniyi çalışma düzlemine ekleyiniz.
• Koninin çapını 12 mm olarak ölçeklendiriniz. 
• Koninin yüksekliğini 19 mm olarak ölçeklendiriniz.
• Koniyi 180 derece döndürünüz.
• Koniyi 5 mm yükseltiniz.
• Koniyi diğer şekillerin üzerine taşıyınız.
• Bir çalışma düzlemini koninin üstüne sürükleyiniz.

 

Dikkat

Bir şekil üzerine çalışma düzlemi eklendiğinde yeni eklenen şekiller için çalışma 
düzlemi olarak yeni eklenen düzlem kabul edilecektir.

Dikkat

Bu aşamadan sonra gövde kullanılarak farklı satranç taşları tasarlanabilir.

Görsel 2.55: Piyon gövdesinin tamamlanması

• Çalışma düzlemine bir küre ekleyiniz.
• Kürenin çapını 8 mm olarak ölçeklendiriniz.
• Bir Çalışma Düzlemini şeklin dışında bir alana sürükleyerek çalışma düzleminin orijinal konumuna 

getiriniz.
• Tüm şekilleri merkezden hizalayınız.
• Tüm şekilleri gruplandırınız.

Görsel 2.56: Tamamlanmış piyon taşı

2.2.6. İki Boyutlu Görseli Üç Boyutlu Görsele Dönüştürme

Çizim programı dışındaki bir resim üç boyutlu hâle getirilebilir. Resmin üç boyutlu hâle getirilebilmesi 
için çalışma düzlemine aktarılması gerekmektedir.

Sıra Sizde 6

Piyon gövdesini kullanarak kale taşını tasarlayınız.
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Uygulama: Üç Boyutlu Hâle Dönüştürme

• Yeni bir tasarım oluşturunuz.
• Tasarımın adını Üç Boyutlu Hâle Dönüştürme olarak değiştiriniz.
• Üst menüden İçe Aktar düğmesini tıklayınız.
• İki boyutlu resmi seçiniz.
• Çevrimiçi format dönüştürücü ile dosyanızı .svg formatına dönüştürünüz.
• Bir dosya seç düğmesine tıklayınız.
• Resmi seçiniz ve onaylayınız.

• İsterseniz Ölçeklendir değerini değiştirerek resmin boyutunu değiştiriniz.
• İçe Aktar düğmesine tıklayınız.
• Shift tuşuna basılı tutup fare ile şeklin genişliğini 100 mm olarak değiştiriniz.
• Ana Ekran görünümü düğmesine tıklayarak ekran görüntüsünü ortalayınız.

Görsel 2.57: Üç boyuta dönüştürülmüş şekil

2.2.7. Hareket Edebilen Bir Nesne Oluşturma

Çizim programı yardımıyla birbirinden bağımsız şekiller bir arada tasarlanabilir. Böylece hareketli 
nesneler oluşturulabilir.

Uygulama: Dişli Çark

• Yeni bir tasarım oluşturunuz.
• Tasarımın adını Dişli Çark olarak değiştiriniz.
• Çalışma düzlemine bir çatı ekleyiniz.
• Çatıyı 90 derece döndürünüz.
• Çatının yüksekliğini 10 mm olarak ölçeklendiriniz.
• Çatının enini ve boyunu 9x9 mm olarak ölçeklendiriniz.
• Çalışma düzlemine bir kutu ekleyiniz.
• Kutunun yüksekliğini 4 mm olarak ölçeklendiriniz.

http://kitap.eba.gov.tr/KodSor.
php?KOD=21374

http://kitap.eba.gov.tr/KodSor.
php?KOD=21375

Dikkat

Çizim programı, içe aktarma işleminde .stl, .obj ve .svg dosya uzantılarını desteklemektedir.
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• Kutunun enini ve boyunu 1x1 mm olarak ölçeklendiriniz.
• Kutunun özelliğini Delik olarak değiştiriniz.
• Kutu ile çatıyı merkezden hizalayınız.
• Kutuyu çatının bir köşesine doğru 6 mm taşıyınız.

Görsel 2.58: Çarkın dişinin oluşturulması

• Çatı ve kutuyu gruplandırınız.
• Çalışma düzlemine bir küre ekleyiniz.
• Kürenin çapını 3 mm olarak ölçeklendiriniz.
• Küreyi çatının tabanından 40 mm uzağa yerleştiriniz.
• Çatı ve küreyi gruplandırınız.
• Yeni şekli çoğaltınız ve 36 derece döndürünüz.

Görsel 2.59: Çarkın dişlerinin çoğaltılması

• Çarkın dişleri tamamlanıncaya kadar bir önceki adımı tekrarlayınız.

 

Görsel 2.60: Çarkın dişlerinin tamamlanması
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• Dişleri gruplandırınız.
• Çalışma düzlemine bir silindir ekleyiniz.
• Silindirin yüksekliğini 10 mm olarak ölçeklendiriniz.
• Silindirin çapını 34 mm olarak değiştiriniz.
• Dişli grubunu ve silindiri merkezde hizalayınız.

Görsel 2.61: Dişli gövdesinin oluşturulması

• Çalışma düzlemine bir silindir ekleyiniz.
• Silindirin yüksekliğini 12 mm olarak ölçeklendiriniz.
• Silindirin çapını 15 mm olarak ölçeklendiriniz.
• Silindirin özelliğini Delik olarak değiştiriniz.
• Silindiri ve çark gövdesini merkezden hizalayınız.

Görsel 2.62: Tamamlanmış dişli çark

• Dişli çarkı çoğaltınız.
• Oluşturulan dişli çarkları, dişler birbirine uygun olacak şekilde yerleştiriniz.

Görsel 2.63: Tamamlanmış dişli çark grubu
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 2.2.8. Tasarımların İçe veya Dışa Aktarımı

Çizim programında üç boyutlu ya da iki boyutlu tasarımlar İçe Aktar seçeneği ile çalışma düzlemine 
aktarılabilir ve yeni tasarımlarda kullanılabilir. Çizim programı, içe aktarma işleminde .stl, .obj ve .svg dosya 
uzantılarını desteklemektedir. 

Uygulama: İçe Aktarma

• Yeni bir tasarım oluşturunuz.
• Tasarımın adını İçe Aktarma olarak değiştiriniz.
• Üst menüden İçe Aktar düğmesini tıklayınız.
• Bir dosya seç düğmesine tıklayınız. 
• Dosyanın yerini bulunuz ve dosyayı seçiniz.
• İki boyutlu ya da üç boyutlu resmi seçiniz.
• İçe Aktar düğmesini tıklayınız.
• İçe aktarılan şekli tasarımınıza göre ölçeklendiriniz.

Uygulama: URL ile İçe Aktarma

• Yeni bir tasarım oluşturunuz.
• Tasarımın adını URL ile İçe Aktarma olarak değiştiriniz.
• İçe Aktar düğmesini tıklayınız.
• Import From URL düğmesine tıklayınız. 
• URL adresini yapıştırınız ve İçe Aktar düğmesini tıklayınız.

Çizim programında hazırlanan tasarımlar, Dışa Aktar seçeneği ile çizim programı dışında bir ortama 
aktarılabilir.

Uygulama: Dışa Aktarma

• Yeni bir tasarım oluşturunuz.
• Tasarımın adını Dışa Aktarma olarak değiştiriniz.
• Çalışma düzlemine bir kutu ekleyiniz.
• Dışa Aktar düğmesini tıklayınız.
• Üç boyutlu yazıcıdan çıktı almak için .STL düğmesini tıklayınız.

2.2.9. Oluşturulan Ürünleri Üç Boyutlu Yazıcıda Yazdırma

Üç boyutlu tasarım yapıldıktan sonra örnekleri oluşturulmak istendiğinde geleneksel yöntemlerde 

Dikkat

Çizim programı, içe aktarılacak dosya boyutunu 25 MB ile sınırlandırmıştır.
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parçalar hâlinde üretilip tekrar birleştirilmesi gerekir. Ancak üç boyutlu yazıcı sayesinde tüm detaylarla tek 
parça hâlinde örnek oluşturulabilmektedir.

Üç boyutlu yazıcılarla ile ilgili en önemli sorulardan biri, modelleri oluştururken hangi ham maddenin 
kullanıldığıdır. Filament adı verilen bu ham maddenin PLA ve ABS olmak üzere iki farklı türü vardır.   PLA 
filament, şeker kamışı ve mısır nişastası gibi maddelerden üretilen doğa dostu bir plastik türüdür. ABS 
filament ise petrol türevlerinden üretilmektedir.

Üç boyutlu yazıcılardan çizim programı ile tasarlanan bir model, üretiminin yapılabilmesi için doğrudan 
yazıcıya gönderilebileceği gibi .stl formatında dışa aktar özelliği kullanılarak yazıcıya gönderilebilir. .stl 
formatındaki bir tasarım dilimleme programları yardımıyla üç boyutlu yazıcının programlama dili olan 
G-code diline dönüştürülür. G-code dosyası,  hafıza kartı ile üç boyutlu yazıcıya tanıtılır ve tasarımın üç 
boyutlu modeli yazdırılır.

Uygulama: Üç Boyutlu Yazıcıda Tasarımları Yazdırma

Tasarladığınız modeli üç boyutlu yazıcıdan yazdırmak için aşağıdaki yönergeleri uygulayınız.

• Daha önce tasarımını yaptığınız Piyon Yapımı uygulamasını seçiniz. 
• Bunu düzenle butonuna tıklayarak tasarımı açınız.

Görsel 2.64: Daha önceden hazırlanan tasarımın açılması

• Dışa Aktar düğmesine tıklayınız.
• Tasarımı doğrudan üç boyutlu yazıcıya göndermek için 3D Baskı sekmesini seçiniz.
• Dosyayı dışa aktarmak için İndir sekmesini seçiniz.
• .STL düğmesini tıklayınız.

Dikkat

Tasarımı doğrudan üç boyutlu yazıcıya gönderebilmek için yazıcınızın bilgisayarınıza bağlı 
bulunması ve çizim programının desteklediği yazıcılardan biri olması gerekir.
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Görsel 2.65: Dışa aktarma dosya formatının seçilmesi

• Dışa aktarılan .stl dosyasını dilimleme programı yardımıyla G-code diline dönüştürünüz.

• .G-code dosyasını hafıza kartı ile yazıcıya aktarınız.
• Yazıcıda baskı işlemini başlatınız.

Dikkat

Dilimleme programı ile ilgili ayrıntılı bilgi üçüncü ünitede verilecektir.
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Aşağıdaki soruları dikkatlice okuyarak doğru seçeneği işaretleyiniz.
1. Çizim programında çoğaltma için kullanılan kısayol kombinasyonu aşağıdakilerden hangisidir?

A) CTRL+C B) CTRL+D C) CTRL+V

D) CTRL+Y E) CTRL+Z

2. Çizim programında çalışma düzleminin ya da seçilen şeklin ekrana sığdırılması için kullanılan düğme 
aşağıdakilerden hangisidir?

A) B) C) 

D) E) 

3. Çizim programı çalışma düzlemi sınırı aşağıdakilerden hangisidir?

A) 100 x 100 mm B) 500 x 500 mm C) 1000 x 1000 mm

           D) 1500 x 1500 mm                  E) 2000 x 2000 mm

4. Çizim programında iki veya daha fazla şeklin birleştirilmesi ile yeni şekil oluşturulmasını sağlayan 
özellik aşağıdakilerden hangisidir?

A) Hizalama B) Çoğaltma C) Kopyalama

                                  D) Gruplama                         E) Eksiltme

5. Hizalama işlemi için kullanılan kısayol tuşu aşağıdaki hangisidir?

A) D B) G C) L

D) Y E) Z

6. Çizim programı içe aktarma dosya boyutunun üst sınırı aşağıdakilerden hangisidir?

A) 10 MB B) 15 MB C) 20 MB

D) 25 MB E) 30 MB

Ölçme ve Değerlendirme
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I. .obj
 II. .psd
 III. .stl
 IV. .svg

Çizim programı, içe aktarma işlemi sırasında yukarıdaki dosya formatlarından hangilerini 
desteklemektedir?

A) I – II B) I – II – III C) I – II – IV

D) I – III – IV E) II – III - IV

8. Hazırlanan tasarımın üç boyutlu yazıcıda baskısını almak için aşağıdaki dosya formatlarından 
hangisi kullanılır?

A) .stl B) .dxf C) .gib

       D) .obj                               E) .svg

9. Üç boyutlu yazıcıların ham madde olarak kullandığı malzeme aşağıdakilerden hangisidir?

A) Arduino B) Filament C) Nozzle

       D) Step motor                               E) Tabla

10. I.  Geleneksel yöntemlere göre daha kullanışlıdır.
 II.  Kalıpçılık gibi yüksek maliyetler gerektirmez.
 III.  Model ayrıntıları ayrı ayrı oluşturulur.
 IV. Kullanımı için teknik bilgi gereklidir.

Yukarıdakilerden hangisi ya da hangileri üç boyutlu yazıcıların kullanım avantajı olarak gösterilebilir?

A) Yalnız I B) I – II C) I – II – III

 D) I – II – IV                                E) I – III – IV

7.



KAVRAMLAR 

Katı Modelleme, CAD, CAM, CAE 

Üç Boyutlu Modelleme, 3D Yazıcı 

Üç Boyutlu Montaj, Dijital Üretim 

Sketch, Eskiz, Montaj, Joint, Design

Tasarım, Assemble



ÖĞRENME BİRİMİ BÖLÜMLERİ

Dijital Üretim Programları

Basit Parametrik Model

Taslak Çizim Komutları

Komut Yardımıyla Objeler Oluşturma

Komut Yardımıyla Nesneleri Düzenleme

Assembly (Nesnelerin Montajı)

Tasarlanan Modelin Üç Boyutlu Baskısını Alma
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3.1. Dijital Üretim Programları
Dijital üretim programları; ürün geliştirmeye yönelik, bulut tabanlı, üç boyutlu CAD: Computer Aided 

Design (Bilgisayar Destekli Tasarım), CAM: Computer Aided Manufacturing (Bilgisayar Destekli Üretim) ve 
CAE: Computer Aided Engineering (Bilgisayar Destekli Mühendislik)  platformudur. Programdaki araçlar, 
entegre konsept üretim araç seti ile tasarım fikirlerinin hızlı ve kolay keşfine imkân tanır.

3.1.1. Eğitim Hesabı Açma ve Bireysel Kurulum Adımları

Programı kullanmaya başlamak için hesap oluşturmak gerekmektedir. 

Uygulama: Hesap Oluşturma
Hesap oluşturmak için aşağıdaki yönergeleri takip ediniz.

• Ekranın sağından Hesap Oluş-
tur düğmesini tıklayınız.

• “Ülke” alanında Türkiye seçiniz.
• “Eğitimdeki rolü” alanında uy-

gun profil seçiniz. 
• Kurumunuzun türünü seçiniz.   Görsel 3.1: Hesap oluşturma

• Ad soyad bilginizi, doğum tarihinizi ve e-posta adresinizi giriniz.
• Bir şifre belirleyiniz.

• Onay kutucuğunu seçiniz ve Hesap Oluştur düğmesine tıklayınız.
• Kayıtta kullanılan e-posta adresine doğrulama mesajı gönderilecektir. Bu mesajın içinde yer alan linke 

tıklayarak e-posta adresinizi doğrulayınız. Bu işlemin ardından ekranda Hesap Doğrulandı mesajı 
görülecektir.

• Hesap doğrulandığında okulunuzun adını giriniz. 
• Öğrenciyseniz branş seçiniz. Bu okula ne zaman başladığınızı ve tahminen okulunuzdan ne zaman 

mezun olacağınızı giriniz. Eğitimciyseniz Eğitimci veya Okul BT Yöneticisi rolünü seçiniz, erişmek 
istediğiniz lisans türünü de belirtiniz.

Dikkat

Kullanıcıya ait bir e-posta adresi ile kaydolunur ancak program içinde Generative Design 
erişimi de istenirse bu yeni teknolojiyi kullanabilmek için üniversite e-posta adresi ile 
kaydolmak gerekir.

3. DİJİTAL ÜRETİM 

1. Bölgenizdeki sanayi kuruluşlarında kullanılan bilgisayar destekli çizim 
programlarını araştırınız. 

2. Üç boyutlu modelleme yazılımlarından faydalanarak modellemenin nasıl 
yapıldığını araştırınız.
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• Bu adımları tamamlandığınızda ekranda Hesap Ayarlandı mesajını göreceksiniz.

Uygulama: Program Kurulum Adımları

Dijital üretim programını bilgisayarınıza kurmak için aşağıdaki yönergeleri uygulayınız.
• Yeni hesap ile program lisansına erişmek için bu aşamada tek adımlık erişim işlemi gerçekleştirilmelidir. 

Bunun için Erişim Elde Edin düğmesine tıklayınız.
• Programı bilgisayarınıza indiriniz. Daha önceden program kurulu ise kullanıcı hesabı ile giriş yapabilirsiniz.
• Kurulum adımlarını tamamlayınız.
• Kurulumun ardından program ilk defa çalıştırıldığında Hesabınızı Koruyun başlıklı, iki adımlı kimlik 

doğrulama ayarları gelecektir. Daha Sonra Hatırlat seçeneğine tıklayarak bu işlemi daha sonra da 
tamamlayabilirsiniz.

• Bulut üzerinde projelerin yer alacağı bir takım alanı oluşturmak gerekmektedir. Bu aşamada Create a 
Team seçeneğini işaretleyiniz ve takım adını giriniz.

• Anonim veri toplama seçenekleriyle ilgili bir bilgilendirme ekrana gelecektir. Bu seçenekler daha sonra 
Preferences (Tercihler) menüsünden değiştirilebilir. Continue düğmesine tıklayınız.

Uygulama: Hesabı Ücretsiz Kullanım İçin Aktive Etme

Yazılım ilk açılışta 30 günlük Trial (Deneme) modunda açılacaktır. Ücretsiz kullanımı başlatmak için 
aşağıdaki yönergeleri uygulayınız.
• Sağ tarafta yer alan Subscribe Now düğmesine tıklayınız.
• Buy Now (Satın Al) ekranına geçiniz.
• Altta yer alan Are you a Startup, Non-commercial user or Student? (Tecrübesiz, Ticari Olmayan 

Kullanıcı veya Öğrenci / Eğitimci misiniz?) linkine tıklayınız.
• Educational use (Eğitim Kullanımı) seçeneğine tıklayınız. Bu aşamadan sonra program, eğitim kullanımı 

için kaydolunması gerektiğini size tekrar hatırlatacaktır. Yukarıdaki tüm adımları tamamladığınızda 
Continue düğmesine tıklayınız.

Dikkat

Lisans seçiminde iki lisans türü ile karşılaşılacaktır. Bunlar;  
• Personal use only: Sadece bireysel eğitim lisanslarına erişim, 
• Personal Use and Educational Institution Deployment: Hem bireysel lisanslara hem 

de kurumunuz için çoklu kurulum lisanslarına erişim seçeneğidir.

Dikkat

Ortak bir e-posta alanına sahip olan kurumsal kullanıcılar, birbirlerinin takım alanlarını 
araştırıp onlara katılma isteği gönderebilirler. Herkese açık bir e-posta platformu 
kullanılıyorsa bu aşamada başka takımlar görülmeyecektir.
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3.1.2. Dijital Üretim Programı Arayüzü

Program kısayoluna tıklanarak program açılır. Program arayüzünden File > New Design seçimi yapılır. 
Önceden hazırlanıp kaydedilen bir dosyadan başlanmak istenirse File > New Design From File seçimine 
basılır. Ekrana Untitled (Adsız) çizim sayfası gelir.

Uygulama: Çizim Ekranını Tanıma

Dijital üretim programı çizim ekranı ile ilgili aşağıdaki yönergeleri uygulayınız.

• Üyesi olduğunuz grupları 
listelemek, yeni grup kurmak 
veya bir gruba katılmak için 
Team Accounts [Takım Hesabı 
(1)] bölümünü seçiniz.

• Data Panel [Veri Paneli (2)] 
içinde yenileme işlemi için Ref-
resh düğmesini, arama işlemi 
için Find düğmesini ve çıkış için 
Exit düğmesini kullanınız.  

• Bulutta kayıtlı bütün projeleri 
listelemek için All Project (3) 
bölümünü kullanınız.

• Yeni proje dosyası oluşturmak 
için New Project (4) düğmesini 
kullanınız.

• Bulutta bulunan kütüphane dos-
yalarına ulaşmak için Libraries 
(5) bölümünü kullanınız.

Görsel 3.2: Çizim ekranı 

• Program içindeki proje örneklerine ve eğitim dokümanlarına ulaşmak için Samples (6) bölümünü kul-
lanınız.

• Veri panelini gösterip gizlemek için Show / Hide Data Panel (7) seçeneğini kullanınız.
• Yeni dizayn, yeni elektronik dizayn, kütüphane ve yeni çizimler oluşturmak için File [Dosya (8)] 

menüsünü kullanınız. Ayrıca mevcut projeler açma, projelere yüklemeler yapma, projeleri kaydetme 
gibi işlemler için bu menüyü kullanabilirsiniz. 

Dikkat

Size verilen lisans ilk etapta 1 yıllıktır ancak her yıl ücretsiz olarak yenilenebilir.
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• Kaydetme işlemi için Save [Kaydet (9)] düğmesini, geri alma işlemi için Undo düğmesini ve ileri alma 
işlemi için Redo düğmesini kullanınız.
Dijital üretim programı temel olarak 6 farklı modda çalışabilmektedir. Her mod, yapılacak tasarımın 

üzerinde uygulanacak işlemlerle ilgilidir. 
Ana çalışma, Design modudur. Bu modda tasarım, tek bir parça hâlinde ya da montaj olarak hazırlanabilir. 

Uygulama: Komutlar

• Komutlarla ilgili aşağıdaki yönergeleri uygulayınız.
• Ekranın üst kısmında yer alan komut ikon çubuğu aracılığıyla komutlara erişiniz.
• Çalışma modunu değiştirerek komutlardaki değişimi izleyiniz. Her moda özgü komutlar ekranınıza 

gelecektir. 
• Komutları yukarı dönük ok işaretine tıklayarak komut ikon çubuğuna taşıyınız.

Görsel 3.3: Komutlar

• Fare çalışma alanındayken klavyeden S kısayol tuşuna basılarak sık kullanılan komutlara ve arama 
ekranına erişilebilmektedir.  S tuşuna basarak sık kullanılan komutları görüntüleyiniz.

• Kullanılacak komut ismi, arama bölümüne baş harfleri yazılarak aratılabilir. Komutları baş harfleri ile 
arayınız.

• Arama yaptığınız komutları, komutların yanındaki ok işareti ile sık kullanılan komutlara ekleyiniz.
• Sık kullanılan listesindeki komutları,komutların yanındaki X işaretine tıklayarak listeden çıkartınız.
• Çalışma sırasında her bir çizim nesnesi oluşturulduğunda ekranın sağ kısmında Sketch Palette başlıklı 

bir menü ekrana gelir. Buradan çizim nesnelerine sınırlamalar eklenebilir. Kullanılan komutlar ve alt 
komutları bu menünün üst kısmında görüntülenir. Buradan da seçim yapılarak çizime devam edilebilir. 
Sketch Palette menüsüne göz atınız.
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Uygulama: Çizim Ekranı Bölümleri
Çizim ekranı bölümlerine erişmek için aşağıdaki yönergeleri uygulayınız.

Görsel 3.4: Çizim ekranı bölümleri

• Hızlı Erişim Menüsü (1): Burada dosya ve projelerin organize edildiği, dokuz küçük kare ile sembolleş-
tirilmiş Data Panel, siyah bir sayfa ile sembolize edilmiş File açılır menüsü ve çalışmaları hızla kaydet-
meye yarayan Save ikonu bulunur. Hızlı erişim menüsündeki ögeleri deneyiniz.

• Dosya Sekme Çubuğu (2): Birden çok çalışmanın aynı anda açık olması durumunda dosya adları kar-
teks biçiminde görülür. Bunların üzerine tıklanarak dosyalar arasında geçiş yapılabilir. Birden fazla ça-
lışma dosyası açarak dosya sekme çubuğunu deneyiniz.

• Kullanıcı Hesabı İşlemleri ve Tercihler (3): Kullanıcı hesabı ayarları ve program tercihlerinin değiştirile-
bileceği kısımdır. Kullanıcı hesabı ayarlarını ve tercihler menüsünü görüntüleyiniz. 

• Komut İkon Çubuğu (4): Burada yer alan komutlara doğrudan tıklanarak en sık kullanılan komut çalıştı-
rılabilir. Komut ikonlarının altındaki aşağı yönlü okun üstüne tıklandığında o komut grubunda bulunan 
alt komutlara ulaşılır. Buradaki komutlardan herhangi birinin sağında bulunan yukarı ok tuşuyla alt 
komut, komut şeridine taşınabilir. Komut ikon çubuğundaki komutları görüntüleyiniz.

• Görünüş Küpü (5): Küpün üzerindeki dilimlere ve yüzlere tıklayarak görsel konumuna göre ekranı dön-
dürünüz.

• Browser [(Unsur Ağacı) (6)]: Çalışma alanının sol yanında yer alır. Modelleme esnasında yapılan 
işlemler, eksen takımları, çalışma yüzeyleri burada bulunur. Çalışma alanının solundaki Eye (Göz) sim-
gesini tıklayarak çalışma unsurlarını açınız ve kapatınız. 

• Görünüm komutları (7): Ekran kaydırma, zoom ve orbit gibi görsel ayarlamaları yapınız.
• Çalışma Alanı Ayarları (8): Ekranın bölünmesi, ızgara ve görsellik ayarlarını yapınız.
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• Timeline [(Zaman Çizelgesi) (9)]: Yeni bir dosya açılmasının ardından yapılan tüm işlem aşamalarının 
görsel olarak sıralandığı bölümdür. İşlemlerin herhangi birinin üzerinde sağ tuş menüleriyle düzenleme 
yapılabilir. Solda yer alan oynatma tuşu ile tüm işlem aşamalarının ekranda tekrarlanması sağlanabilir. 
Timeline görüntüleyiniz.

• 10. Zaman Çizelgesi Ayarları (10): Süreç şeridinin görsel özelliklerini ayarlayınız.

Uygulama: Ekran Rengi ve Görünüm Ayarları

Ekran rengi ile ilgili aşağıdaki yönergeleri uygulayınız.
• Ekran rengini ayarlamak için çalışma alanı ayarları kısmından yararlanabilirsiniz.
• Environment başlığı altında beş sahne olarak hazırlanmış seçeneklerden tercih yapabilirsiniz.

 
Görsel 3.5: Ekran rengi ve görünüm

Uygulama: Grid (Izgara Ayarları)

Izgara ayarları ile ilgili 
aşağıdaki yönergeleri uygu-
layınız.
• Izgara ayarlarında geçerli 

olan Adaptive seçimidir. 
• Fixed seçimi ile değer gi-

rerek ızgara aralıklarını 
ayarlayınız. Bu seçimde, 
Adaptive seçiminden 
farklı olarak ekrana yak-
laşılıp uzaklaşıldığında 
ızgara aralıklarının değiş-
mediğini gözlemleyiniz. 

Görsel 3.6: Izgara ayarları

Dikkat

Ekran renginin ayarlanmasında rengin gözü almamasına ve yorucu olmamasına dikkat edilmelidir.
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Uygulama: Snap (Kenetlenme Ayarları)
Kenetlenme ayarları ile ilgili aşağıdaki yönergeleri uygulayınız.

• Bu ızgara ayarları için Grid and Snaps > Snap to Grid kısmından yararlanabilirsiniz.
• Çizim esnasında farenin belirli aralıklarla sekme yaparak hareket etmesi için  Snap to Grid seçimini 

yapınız.
• Çizim esnasında imlecin ızgaraların köşelerine kenetlenmesi için Snap to Grid kutusunu işaretleyiniz.

3.2. Basit Parametrik Model
Dijital üretim programı yazılımı, 6 hazır şekli hızlı biçimde oluşturmayı sağlayan hızlı şekil oluşturma 

aracını içerir. Bu araçlar kullanılarak üç boyutlu nesneler oluşturulabilir.
Dijital üretim programı ile üç boyutlu basit modelleme yapabilmek 

için Solid (Katı) komut ikonu penceresinde Create (Oluştur) menüsünün 
altında hâlihazırda kullanılabilecek basit modeller listelenmektedir.  

Görsel 3.7: Solid modelleme

Box (Kutu), Cylinder (Silindir), Sphere (Küre), Torus (Simit Halkası), Coil (Yay) ve Pipe (Boru) listede 
hazır olarak kullanılabilecek basit modellerdir.

Çizilecek basit model seçilip komut ça-
lıştırıldıktan sonra ekrana gelen düzlem-
lerden çizim yapılacak düzlemin seçilmesi 
yeterlidir. Koordinat merkezi, içi çapraz 
olarak çeyrekleri dolu bir daire ile göste-
rilir. X ekseni kırmızı, Y ekseni yeşil ve Z 
ekseni de mavi renklidir. 

Düzlemler, çizim alanından veya unsur 
ağacından seçilebilir. Unsur ağacından XZ 
[Front (Ön)], XY [Top (Üst)] veya YZ [Right 
(Sağ)] düzlemlerinden biri seçilmelidir. 

Görsel 3.8: Düzlem seçimi

Eklenen nesnenin daha sonra düzenlenmesi istenirse Browser > Bodies (Gövdeler) içindeki ilgili nesne 
seçildiğinde nesneye odaklanılır. Odaklanılan nesne mavi renklidir. Eklenen nesne seçili iken ya da Timeline  
akışında ilgili işlem üzerine sağ tuş tıklandığında gelen menüden Edit Feature (Özelliği Düzenle) komutu 
çalıştırılır. 

Fare kaydırma tekerleğinin üzerine basılı tutularak Pan moduna geçiş yapılır. Bu sayede tasarım ekra-
nında sağa, sola, ileri ve geri hareket edilebilir.

Fare kaydırma tekerleğinin üzerine ve klavyeden Shift tuşuna basılı tutularak Constrained Orbit (Ser-
best Kamera) moduna geçiş yapılır. 

Fare kaydırma tekerleği ileri hareket ettirilirse Zoom Out (Görüntüyü Uzaklaştır), geri hareket ettirilir-
se Zoom In (Görüntüyü Yakınlaştır) eylemleri gerçekleşir.
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3.2.1. Box (Kutu)

Uygulama: Box (Kutu) Ekleme

Çizim alanına Box eklemek için aşağıdaki yönergeleri uygulayınız.
• Create > Box komutunu seçiniz.
• XY düzlemini seçerek çizmek istediğiniz Box nesnesinin taban yüzeyinin Width  (Genişlik) ve Length 

(Uzunluk) değerlerini giriniz. Genişlik ve uzunluk değerlerini belirledikten sonra klavyeden Enter tuşuna 
basarak Box nesnesini oluşturunuz. Oluşan kutunun genişlik, uzunluk ve yükseklik değerleri, aşağıdaki 
resimde görülen ok tuşları seçilerek okun gösterdiği doğrultuda ileri veya geri hareketle artırılıp azaltı-
labilir. Aynı işlem Box Palette (Kutu Paleti) penceresinden değer girilerek de yapılabilir.

Görsel 3.9: Kutu ve kutu paleti

3.2.2. Cylinder (Silindir)

Uygulama: Cylinder (Silindir) Ekleme

Çizim alanına Cylinder eklemek için aşağıdaki yönergeleri uygulayınız.
• Create > Cylinder komutunu seçiniz.
• XY düzlemini seçerek çizmek istediğiniz Cylinder için Diameter (Taban Çapı) değerini giriniz. 
• Fare kullanarak ya da Cylinder Palette menüsünden çap ve yükseklik değerlerini değiştiriniz.

Görsel 3.10: Silindir ve silindir paleti

Dikkat

Yükseklik, eksi (-) değer alabilir. Eksi değer, bulunduğu doğrultuda nesnenin oluşturulma 
yönünü değiştirir. 
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3.2.3. Sphere (Küre)

Uygulama: Sphere (Küre) Ekleme

Çizim alanına Sphere eklemek için aşağıdaki yönergeleri uygulayınız.
• Create > Sphere komutunu seçiniz.
• XZ düzlemini seçerek çizmek istediğiniz Sphere için Diameter değerini giriniz. 
• Fare kullanarak ya da Sphere Palette menüsünden çap değerini değiştiriniz. 

Görsel 3.11: Küre ve küre paleti

3.2.4. Coil (Yay)

Uygulama: Coil (Yay) Ekleme

Çizim alanına Coil eklemek için aşağıdaki yönergeleri uygulayınız.
• Create > Coil komutunu seçiniz.
• XY düzlemini seçerek çizmek 

istediğiniz Coil için Diameter 
ve Height değerlerini tasarım 
alanına yerleştirirken giriniz. 

• Fare kullanarak ya da Coil Palette 
menüsünden çap ve yükseklik 
değerlerini değiştiriniz. Coil 
Palette menüsünden ayarları 
değiştirerek gözlemleyiniz.

Görsel 3.12: Yay ve yay paleti
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3.2.5. Torus (Simit Halkası)

Uygulama: Torus (Simit Halkası)

Çizim alanına Torus eklemek için aşağıdaki yönergeleri uygulayınız.
• Create > Torus komutunu seçiniz.
• XY düzlemini seçerek çizmek istediğiniz Torus için Diameter değerini tasarım alanına yerleştirirken 

giriniz. 
• Torus Palette menüsünden ayarları değiştirerek gözlemleyiniz.

Görsel 3.13: Simit halkası ve simit halkası paleti

3.2.6. Pipe (Boru)

Uygulama: Pipe (Boru) Ekleme
Pipe nesnesi çizebilmek için bir Path (Yol) belirlenmelidir. Path, iki boyutlu bir tasarım nesnesi olduğu 

için önce Sketch (Taslak) hazırlamak gereklidir.  
Çizim alanına Pipe eklemek için aşağıdaki yönergeleri uygulayınız.

• Browser altında Skectch çizilecek XZ düzlemini seçiniz ve sağ tuş yaparak Create Sketch (Taslak 
Oluştur) komutuna tıklayınız. 

• Spline (Eğri) komutunu seçiniz.
• Düzleme noktalar yerleştirdikten sonra yeşil daire içinde beliren tik işaretine tıklayınız. 
• Üst menüde en sağdaki Finish Sketch (Taslağı Sonlandır) komutuna tıklayınız.
• Create > Pipe komutunu seçiniz. 
• Taslak olarak çizilen yolu Select (Seç) komutuyla seçiniz. 
• Yol boyunca borunun ne kadarının çizileceğini belirlemek için Distance (Mesafe) değerini kullanınız. 

Distance değeri 0-1 arasındadır.
• Pipe Palette menüsünden ayarları değiştirerek gözlemleyiniz. 
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Görsel 3.14: Boru ve boru paleti

3.3. Taslak Çizim Komutları
3.3.1. Sketch (Taslak) Oluşturma 

CAD programlarıyla üç boyutlu nesne modelleme yapabilmek için öncelikle iki boyutlu model taslağının 
bir düzlem üzerine çizilmesi gerekir. Bunun için de taslak çizim komutları ile çizime başlamadan önce bir 
Sketch açılmalıdır. 

Uygulama: Sketch (Taslak) Oluşturma

Taslak oluşturmak için aşağıdaki yönergeleri uygulayınız.
• Komut ikon çubuğu üzerindeki Create > Create Sketch komutunu çalıştırınız ya da bir çizim komutu 

seçiniz. 
• Düzlemleri çizim alanından ya da Browser menüsünden seçebilirsiniz. 
• Seçimin ardından ekran dönerek çizim yapmaya hazır hâle gelecektir.
• Finish Sketch düğmesine tıklayarak taslağı tamamlayınız.  
• İkinci bir Sketch açınız.  
• Önceden Sketch ile çizilmiş nesneler, Browser altında Sketches dalında bulunur. Nesne üzerine sağ 

tıklayarak ekran paletinden Edit Sketch (Taslak Düzenle) seçimi yapınız. 

3.3.2. Nesne İlişkilendirme Modları (Kısıtlamalar)
Kısıtlamalar, çizimin bozulmamasına yardımcı olur ve ögelerin parçalanmamasını ya da öngörülemeyen 

alanlara taşmamasını sağlar. Temelde çizimin şeklini korumak için nesne ilişkilendirme modları kullanılarak 
çizimler yüzde yüz öngörülebilir hâle getirilir. Kısıtlamalar, çizimlerde değişiklik yapıldığında belirli 
davranışların korunmasına izin verir.

Uygulama: Nesne İlişkilendirme Modları

Nesne ilişkilendirme iki biçimde gerçekleştirilebilir. Nesne ilişkilendirme işlemi için aşağıdaki yönergeleri 
uygulayınız.
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Birinci yol için;
• Sketch ortamına girildiğinde çizim yapma esnasında çalışmaya başlar. Her çizim işleminde önceki 

çizim nesnelerinin referans olabilecek noktalarına kenetlenme sağlanır. Çizim esnasında kenetlenme 
doğrultuları da kullanılabilir. Çizim bu doğrultulardan başlanarak sınırlandırılabilir. Kenetlenme 
doğrultuları sürekli kesik çizgi biçiminde görüntülenir. Kesik çizginin gösterdiği doğrultuları tıklayarak 
ilişkilendiriniz ve bir çizim nesnesi oluşturunuz. 

• Çizim komutları çalıştırıldığında otomatik nesne kenetlenmesi istenmiyorsa komut çalışıyorken Ctrl 
tuşuna basılı tutmak yeterlidir. Böylece herhangi bir kenetlenme gerçekleşmez. Ctrl tuşunu kullanarak 
uygulayınız.
İkinci yol için;

• Çizim nesneleri oluşturulduktan sonra da birbirleriyle ilişkilendirilebilir. Sketch başlatıldığında ekranın 
sağ tarafında otomatik olarak görüntülenen Sketch Palette bölümünden bu modları seçiniz ve çizim 
nesnelerine tıklayarak ilişkilendiriniz.

• Nesne ilişkilendirme modlarının ne işe yaradığının bilinmesi önemlidir. Bu modlar, çizim sırasında çizimi 
kolaylaştırır ve nesneler arasında bağlantı kurarak birbiri ile ilişkilenmelerini sağlar. Aşağıdaki modları 
sırasıyla uygulayınız.

o Endpoint: Başlangıç veya son noktadır. Ayrıca bir nokta yakalanacaksa Node (Düğüm), Endpoint 
gibi işlem görür.

o Midpoint: Orta nokta seçer.
o Center: Merkez nokta seçer.
o Intersection: Kesişim noktası seçer.
o Extension: Bir çizginin hayali uzantısıyla hizalı bir noktayı seçer.
o Perpendicular: Bir nesne üzerinde son seçilen noktaya dik bir konum seçer.
o Tangent: Teğet nokta seçer.
o Apparent Intersection: Kesişmeyen iki nesnenin varsayılan kesişme noktalarını seçer.
o Parallel: Bir çizgiye paralel başka bir çizgi çizmek için kullanılır.

Kenetlenme komutlarının tümü otomatik olarak çalışır ve çizim esnasında her nesnede uygulanabilir. 
Çizim esnasında kenetlenme işleminin gerçekleşmesi istenmiyorsa fare hareketleri yapılırken Ctrl tuşuna 
basılı tutmak yeterlidir.

3.3.3. Line (Çizgi) 

Line komutuna Sketch araç çubuğundan L kısayol tuşu ya da Sketch Toolbox menüsünden ulaşılabilir. 
Line komutu doğrudan veya bir Sketch açma işlemi sonrasında çalıştırılabilir. Komut doğrudan çalıştırılırsa 
taslağın oluşacağı çizim düzleminin gösterilmesi istenir.

Uygulama: Line (Çizgi) Çizme

Çizgi çizmek için aşağıdaki yönergeleri uygulayınız.
• Line komutunu işaretledikten sonra bir başlangıç noktasına tıklayınız.
• Farenin hareketlendirilmesiyle birlikte ikinci bir nokta girilmesi (Specify next point) istenir. İkinci 

noktayı tıklayınız ve çizgi oluşturunuz.
• Teğet bir yay oluşturmak için son noktayı tıkladıktan sonra farenin sol tuşuna basılı tutarak bir yay 
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hareketi yapınız. 
• İkinci çizgi için Line komutunu işaretledikten sonra bir 

başlangıç noktasına tıklayınız.
• İlk noktayı tıkladıktan sonra ekranda farenin hareketini 

takip ederken iki adet ölçü kutucuğu belirir. Bu 
kutucuklara çizgi boyu ve açı değerini girerek bir çizgi 
oluşturunuz.

Uygulama: Çizginin Uzunluğunu Değiştirme

Çizginin boyunu değiştirmek için aşağıdaki yönergeleri uygulayınız. 
• Bir değer girerek çizgi oluşturunuz. Çizgi üzerinde bir ölçü görülecektir.
• Ölçüyü çift tıklayınız. Değer kutucuğu görünür hâle gelecektir.
• Ölçü değerini değiştiriniz. Böylece çizgi boyu değişecektir.
• İki noktayı tıklayarak yeni bir çizgi oluşturunuz.
• (D) Sketch Dimension kısayoluna basarak ölçü veriniz. Bu ölçü çift tıklanarak değiştirilebilir.

Uygulama: Line Komutuyla Yay Çizmek

Line komutuyla yay çizmek için aşağıdaki yönergeleri uygulayınız. 
• Çizimin son noktasını belirleyiniz.
• Son noktayı yerleştirirken farenin sol tuşuna basılı tutarak bir yay hareketi oluşturunuz.
• Farenin sol tuşunu yayın bitiş noktasında bırakınız.
• Çizilen çizgi ile yayın teğet olduğuna dikkat ediniz.

Uygulama: Çizgiyi Construction Line Hâline Getirmek

Line komutu ile çizilen çizgiyi yardımcı geometriye dönüştürmek için aşağıdaki yönergeleri uygulayınız. 
• Line komutunu çalıştırınız.
• Komut yardımıyla bir çizgi oluşturunuz.
• Farenin sağ tuşu ardından OK ya da ESC tuşuna basarak Line komutundan çıkınız.
• Çizilen çizgiyi seçiniz.
• Sketch Palette menüsünden Construction seçeneğini işaretleyiniz ya da X kısayol tuşuna basınız.

3.3.4. Circle (Daire)

Daire komutu, komut ikon çubuğundan Sketch başlığının altından çalıştırılabilir. Klavyede C kısayolu 
tuşuna basıldıktan sonra daire çizimi için komutlar Sketch Palette menüsünden görüntülenir. 

Görsel 3.15: Çizgi oluşturma

Dikkat

Taslak çizimde herhangi bir geometri, yardımcı geometri hâline dönüştürülmek istenirse aynı 
adımlar uygulanır.
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Uygulama: Merkez ve Yarıçap Göstererek Daire Çizme

Merkez ve yarıçap göstererek daire çizmek için aşağıdaki yönergeleri uygulayınız.
• Circle > Center Diameter 

Circle komutunu çalıştırınız.
• Dairenin çapını ölçülendirerek 

oluşturunuz.

Görsel 3.16: Merkez yarıçap göstererek daire çizme

Uygulama: İki Nokta Göstererek Yeni Daire Çizme

İki nokta göstererek yeni 
daire çizmek için aşağıdaki 
yönergeleri uygulayınız.
• Circle > 2-Point Circle ko-

mutunu çalıştırınız. 
• Ekranda iki nokta (çap ge-

nişliği kadar) gösteriniz.

Görsel 3.17: İki nokta göstererek daire çizme
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Uygulama: Üç Nokta Göstererek Bir Daire Çizme

Üç nokta göste-
rerek bir daire çizmek 
için aşağıdaki yönerge-
leri uygulayınız.
• Circle > 3-Point 

Circle komutunu 
çalıştırınız. 

• Ekranda üç nokta 
gösteriniz.

Görsel 3.18: Üç nokta göstererek daire çizme

3.3.5. Arc (Yay)

Yay komutu, komut ikon çubuğundan Sketch başlığının altından çalıştırılabilir. Komut ikon çubuğundaki 
Sketch menüsünde Arc komutu altında üç ayrı komut olduğu görülebilir. Komutun üç seçim yöntemi vardır.

Uygulama: İki Uç ve Bir Orta Nokta Gösterilerek Yay Çizme

İki uç ve bir orta nokta gösterilerek yay çizmek 
için aşağıdaki yönergeleri uygulayınız.
• Arc > 3-Point Arc komutunu çalıştırınız.
• Başlangıç ve bitiş noktalarını işaretleyiniz. 

İsterseniz başlangıç ve bitiş noktaları 
arasındaki kiriş mesafesini giriniz. 

• Yayın orta (kubbe) noktasını oluşturacak 
noktayı işaretleyiniz. 

Görsel 3.19: İki uç ve bir orta nokta gösterilerek yay çizme
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Uygulama: Merkez, Yarıçap ve Bitiş Noktalarını Göstererek Yay Çizme

Merkez, yarıçap ve bitiş noktalarını göstererek yay çizmek için aşağıdaki yönergeleri uygulayınız.
• Arc > Center Point Arc komutunu 

çalıştırınız.
• Yay merkezini gösteriniz.
• Yayın yarıçapını ve bitiş noktasını 

gösteriniz. İstediğiniz takdirde bitiş 
noktasına açı değeri vererek de 
çizimi gerçekleştirebilirsiniz.

Görsel 3.20: Merkez, yarıçap ve bitiş noktası (açı) göstererek yay çizme

Uygulama: Çizgiye Teğet Yay Çizme

Çizgiye teğet yay çizmek için 
aşağıdaki yönergeleri uygulayınız.
• Bir çizgi çiziniz.
• Arc > Tangent Arc komutunu 

çalıştırınız. 
• Çizginin ucunu teğet noktası 

olarak seçiniz. 
• Arc bitiş noktasını işaretleyiniz.

Görsel 3.21: Çizim elemanın (teğet) ucu, bitiş noktası ile yay çizme
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Sıra Sizde 1

Aşağıda ölçüleri verilen şekli çiziniz.
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3.3.6. Rectangle (Dikdörtgen)
Dikdörtgen çizmek için Rectangle komutu kullanılır. R, kısayol tuşudur. Dikdörtgen çizimi üç yöntemle 

yapılabilir.

Uygulama: İki Nokta Göstererek Dikdörtgen Çizme

İki nokta göstererek dikdörtgen 
çizmek için aşağıdaki yönergeleri uy-
gulayınız.
• Rectangle > 2-Point Rectangle 

komutunu çalıştırınız.
• Çapraz iki köşe noktasını 

işaretleyerek dikdörtgeni çiziniz.
• Kenar ölçülerini çizimden son-

ra düzenleyiniz. Çizim sırasında 
TAB tuşu yardımıyla kenar ölçü-
leri arasında geçiş yapabilirsiniz. 
Klavyeden değer vererek dik-
dörtgeni çizilebilirsiniz.

Görsel 3.22: İki nokta ile dikdörtgen çizme

Uygulama: Üç Nokta Göstererek Yeni Bir Dikdörtgen Çizme

Üç nokta göstererek yeni 
bir dikdörtgen çizmek için aşa-
ğıdaki yönergeleri uygulayınız.
• Rectangle > 3-Point Rec-

tangle alt komutunu çalış-
tırınız.

• Dikdörtgenin üç köşe 
noktasını sırasıyla ekran 
üzerinde işaretleyiniz. 

Görsel 3.23: Üç nokta ile dikdörtgen çizme
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Uygulama: Merkez Noktasıyla Yeni Bir Dikdörtgen Çizme

Merkez noktasıyla yeni bir 
dikdörtgen çizmek için aşağıdaki 
yönergeleri uygulayınız.
• Rectangle > Center Rectangle 

komutunu çalıştırınız. 
• Ekran üzerinde dikdörtgenin 

merkez noktasını seçerek köşe 
noktasını işaretleyiniz. 

• Çizim ölçülerini düzenleyiniz.

Görsel 3.24: Merkez noktasıyla dikdörtgen çizme

Sıra Sizde 2

Aşağıda ölçüleri verilen şekli çiziniz.
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3.3.7. Slot (Kanal)

Kanal oluşturmak için birden fazla yöntem vardır.

Uygulama: İki Eksen Arası Ölçüyle Yarıçap Ölçüsünü İşaretleyerek Kanal Çizme

İki eksen arası ölçüyle yarı-
çap ölçüsünü işaretleyerek kanal 
çizmek için aşağıdaki yönergeleri 
uygulayınız.
• Slot > Center To Center Slot ko-

mutunu çalıştırınız.
• Eksenler arası mesafeyi belirle-

mek için noktaları işaretleyiniz.
• Kanalın yarıçap ölçüsü olan nok-

tayı (Değer penceresine ölçü de 
yazılabilirsiniz.) işaretleyiniz.

Görsel 3.25:  İki eksen arası ölçüyle yarıçap ölçüsünü işaretleyerek kanal çizme 

Uygulama: Merkez, Eksen Noktası ve Yarıçapla Kanal Çizme
Merkez, eksen nok-

tası ve yarıçapla kanal 
çizmek için aşağıdaki 
yönergeleri uygulayı-
nız.
• Slot > Center Point 

Slot komutunu ça-
lıştırınız.

• Merkez noktayı işa-
retleyiniz.

• Eksenlerin ölçüsü-
nün yarısı olan me-
safeyi belirlemek 
için diğer noktayı 
işaretleyiniz.

• Kanalın yarıçap öl-
çüsü olan noktayı 
işaretleyiniz.

Görsel 3.26: Merkez, eksen noktası ve yarıçapla kanal çizme
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Uygulama: İki Uç Noktası ve Yarıçapla Kanal Çizme

İki uç noktası ve yarıçapla kanal 
çizmek için aşağıdaki yönergeleri uy-
gulayınız.
• Slot > Overall Slot komutunu ça-

lıştırınız.
• İki nokta ile Slot uç noktalarını 

işaretledikten sonra yarıçap ölçü-
sü olan noktayı belirleyiniz.

Görsel 3.27: İki uç noktası ve yarıçapla kanal çizme

3.3.8. Polygon (Çokgen)

Polygon, eşkenar çokgenler çizmek için kullanılan komuttur. Eşkenar çokgenlerin üç çizim yöntemi vardır.

Uygulama: Daire Dışına Çokgen Çizme
Daire dışına çokgen çizmek için aşağıdaki yönergeleri uygulayınız.

• Öncelikle bir daire çiziniz.
• Polygon > Circumscribed Polygon komutu-

nu çalıştırınız. 
• Dairenin merkez noktasını işaretleyiniz.
• Açılan değer penceresine çokgenin kenar 

sayısını yazınız.
• İki nokta ile dairenin merkezini ve yarıçapı-

nı işaretleyiniz.

Görsel 3.28: Daire dışına çokgen çizme



DİJİTAL ÜRETİM

1033. ÖĞRENME BİRİMİ

Uygulama: Daire İçine Çokgen Çizme

Daire içine çokgen çizmek için aşağıdaki 
yönergeleri uygulayınız.
• Polygon > Inscribed Polygon komutunu 

çalıştırınız. 
• Dairenin merkez noktasını işaretleyiniz.
• Açılan değer penceresine çokgenin ke-

nar sayısını yazınız.
• İki nokta ile dairenin merkezini ve yarıça-

pını işaretleyiniz.

Görsel 3.29: Daire içine çokgen çizme

Uygulama: Kenar Boyutunu Vererek Çokgen Çizme

Kenar boyutunu vererek çokgen çizmek için aşağıdaki yönergeleri uygulayınız.
• Polygon > Edge Polygon alt komutunu 

çalıştırınız. 
• Dairenin merkez noktasını işaretleyi-

niz.
• Açılan değer penceresine çokgenin ke-

nar sayısını yazınız.
• İki nokta ile dairenin merkezini ve yarı-

çapını işaretleyiniz.

Görsel 3.30: Kenar boyutunu vererek çokgen çizme

3.3.9. Ellipse (Elips)

Bir merkez, dar ve geniş uç ölçüleri verilerek elips çizilebilir.
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Uygulama: Ellipse (Elips) Çizme

• Ellipse komutunu çalıştırı-
nız.

• İlk nokta ile elipsin 
merkezini işaretleyiniz.

• Diğer iki nokta ile elipsin 
dar ve geniş uçlarını işaret-
leyiniz.

Görsel 3.31: Elips çizme

3.3.10. Conic Curve (Konik Eğri)

Conic Curve, bir koninin kesit ayrıtı demektir. Dişli çark yuvarlanma yüzeylerinin, diş profillerinin 
çiziminde kullanılır. Başlangıç, bitiş noktalarının ve odak uzaklığının işaretlenmesiyle oluşturulur.

Uygulama: Conic Curve (Konik Eğri) Çizme

• Conic Curve komutunu çalıştırınız. 
• İki nokta ile eğrinin uç noktalarını 

işaretleyiniz.
• Eğrinin uç noktasının yükseleceği 

yöndeki noktayı işaretleyiniz.

Görsel 3.32: Konik eğri çizme
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3.3.11. Spline (Eğri)

Spline, farklı noktalar ya da doğrulardan geçen birleşik eğriler çizmek için kullanılır. İşaretlenen 
noktalardan geçen eğriler ekranda çizilebilir. Oluşan işaretleme noktaları ve eğri teğet çizgileri 
ölçülendirilerek parametrik sınırlar verilebilir. 

Uygulama: Spline (Eğri) Çizme

Eğri çizmek için aşağıdaki yö-
nergeleri uygulayınız.
• Spline komutunu çalıştırınız.
• Önceden belirlenmiş nokta-

lara ya da ekrandaki belirli 
yerlere istenilen sıklıkta işa-
retleme yapınız.

• Yeşil daire içinde yer alan tik 
sembolüne tıklayarak Spline 
nesnesini tamamlayınız.

• Eğri üzerindeki noktaların 
konumu değiştirilebilir. 
Noktanın üstünde görünen 
Anchor (Çapa) doğrularının 
uçlarını çekerek eğrinin 
noktalarda yaptığı kavis hare-
ketini yeniden düzenleyiniz.

Görsel 3.34: Eğri düzenleme

Uygulama: Kontrol Noktalı Eğri Çizme

Seçilen kontrol noktaları tarafından yönlendirilen bir Spline oluşturur. Kontrol noktalı eğri çizmek için 
aşağıdaki yönergeleri uygulayınız.
• Spline komutunu çalıştırınız.
• Eğriyi başlatmak için ilk noktayı seçiniz.
• Kontrol noktaları olarak ek noktalar seçiniz ve çizime 

devam ediniz.
• Tik sembolüne tıklayarak çizimi tamamlayınız.

Görsel 3.35: Kontrol noktalı eğri

Görsel 3.33: Eğri çizme



106 3. ÖĞRENME BİRİMİ

3.3.12. Text (Metin)

Bir başlangıç noktası gösterilerek istenilen özellikte yazı oluşturulabilir.

Uygulama: Text (Metin) Oluşturma

Metin oluşturmak için aşağıdaki yönergeleri uygulayınız.
• Text komutunu çalıştırınız.
• İşaretlenen nokta ile ekranda beliren yazı alanına bir metin yazınız.
• Text Palette menüsünden ayarları değiştirerek metni gözlemleyiniz.

Görsel 3.36: Metin oluşturma

3.3.13. Point (Nokta)

Point; çizim ortamına noktalar yerleştirmek, çizim ortamında oluşturulan noktaların delik merkezlerini 
belirlemek, eğri çiziminde kılavuzluk etmek gibi işlemlerde kullanılabilir. Çizim elemanları üzerine noktalar 
yerleştirilebilir, ölçülendirilebilir veya parametrik sınırlamalar yapılabilir.

3.3.14. 3D Sketch (Üç Boyutlu Taslak)

3D Sketch oluşturmadan önce Preferences (Tercihler) > Design (Tasarım) > Allow 3D Sketching of 
Lines and Splines (Doğru ve Eğrilerle 3D Taslak Oluşturmasına İzin Ver) seçeneği işaretlenmelidir. 3D 
Sketch; üç boyutlu çizgi, eğri, daire, yay ve dikdörtgen çizmek için kullanılır. 

Uygulama: 3D Sketch (Üç Boyutlu Taslak) Oluşturma

Üç boyutlu taslak oluşturmak için aşağıdaki yö-
nergeleri uygulayınız.
• Bir Sketch oluşturarak dikdörtgen çiziniz.
• Boyu 50 mm, eni 70 mm olacak şekilde dikdörtge-

ni ölçülendiriniz.
• Finish Sketch komutu ile Sketch oluşturunuz. 

Görsel 3.37: Dikdörtgen oluşturma



DİJİTAL ÜRETİM

1073. ÖĞRENME BİRİMİ

• Bu dikdörtgene belli bir 
uzaklıkta aşağı ya da yukarı 
yönde Offset Plane (Düzle-
mi Ötele) komutu ile Plane 
oluşturunuz.

• Plane üzerinde bir Sketch 
oluşturarak Project (P) ko-
mutu ile dikdörtgenin ke-
narlarını izdüşürünüz.

• Taslağı kapatınız.
• Görünümü izometrik hâle 

getiriniz.
• Spline komutunu çalıştı-

rınız. Noktaları görseldeki 
gibi ilk dikdörtgenin köşe-
sinden başlayarak işaretle-
yiniz. 

• Son noktayı işaretlediğiniz-
de Enter tuşu ile işlemi son-
landırınız.

Görsel 3.38: Düzlem ötele

Görsel 3.39: İzdüşüm

Görsel 3.40: Üç boyutlu taslak

3.3.15. Fillet (Yuvarlatma / Kavis)

Fillet daha çok keskin köşeleri yuvarlatmak için kullanılmaktadır. Yuvarlatılacak nesnelerin kesişmesi 
şart değildir. Yuvarlatılacak kenar çizgilerinin seçimi yeterlidir. İki çizgi seçildikten sonra değer penceresine 
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yarıçap ölçüsü yazılarak ya da mavi ok tuşu hareket ettirilerek yuvarlatma işlemi yapılır. OK (Tamam) 
butonuna tıklanarak işlem tamamlanır.

Görsel 3.41: Yuvarlatma

3.3.16. Trim (Budama)

Trim; birbirini kesen nesnelerden birini, diğerine göre kırparak silme işlemidir. Kısayolu T tuşudur. Üç 
biçimde budama yapılabilir.
• Uç Göstererek Budama: Çakışan çizgilerin uçları gösterilir. Gösterilen bölüm kırmızı renk alır.
• Fareyi Sürükleyerek Budama: Farenin sol tuşuna basılı tutulur ve uzantı uçlarının üzerinden geçilir. 

Uçlar çakışma noktasına kadar budanır.
• Tek Bir Nesneyi Göstererek Budama: Silme işlemine benzer. Herhangi bir çakışma yapmayan nesneye 

tıklanarak nesnenin silinmesi sağlanır.

Görsel 3.42: Budama

3.3.17. Extend (Uzatma)

Extend, bir nesneyi başka bir nesnenin sınırına kadar uzatmak için kullanılır. Modify komut nesnesinin 
altında yer alır. Nesneler çizgi, yay veya eğri olabilir. Nesnelerin uzantısının kesişmesi gerekir. Uzatılacak 
nesnenin üzerine fare ile gelindiğinde otomatik olarak uzayacağı sınıra kadar kırmızı çizgi belirir, tıklanınca 
çizgi uzar. Çizginin uzantısında kesişeceği başka nesneler varsa aynı işlem devam eder.

Görsel 3.43: Uzatma
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3.3.18. Offset (Öteleyerek Çoğaltma)

Offset; çizgileri, kenarları, eğrileri ve profilleri belirli bir mesafede öteleyerek çoğaltma işlemidir.

Uygulama: Offset (Öteleyerek Çoğaltma)

Öteleyerek çoğaltma işlemi için aşağıdaki yönergeleri uygulayınız.
• Modify>Offset komutunu çalıştırınız. Ekrana Offset diyalog kutusu gelir.
• Nesne ya da nesneleri seçiniz. Offset Position kısmına öteleme mesafesini yazınız.
• Öteleme yönünü ekran üzerinde işaretleyiniz. İmleci fare ile basılı tutup kaydırarak Offset miktarı ve 

yönünü elle değiştirebilirsiniz.

Görsel 3.44: Öteleyerek çoğaltma

Sıra Sizde 3

Aşağıda ölçüleri verilen şekli dijital üretim programında çiziniz.
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3.3.19. Mirror (Aynalama)

Mirror; çizgileri, kenarları, eğrileri ve profilleri belirli bir referans nesnesine göre aynalayarak çoğaltma 
işlemidir. Endüstriyel ürünler genellikle simetrik olarak tasarlandığı için çok sık kullanılan bir komuttur. 

Uygulama: Aynalama (Mirror) Yapma

Aynalama işlemi için aşağıdaki yönergeleri uygulayınız.
• Bir taslak oluşturunuz.
• Referans alacağınız bir nesne çiziniz. Referans nesnesi olarak bir doğru çizebilirsiniz. 
• Çizgi seçili iken Sketch Panel menüsünden Construction ifadesine tıklayınız ve çizdiğiniz doğruyu kesik 

çizgili hâle dönüştürünüz (Kesik çizgi yardımcı geometridir, tasarımın bir parçası değildir.).
• Komut ikon çubuğu altında Create > Mirror komutunu seçiniz. 

Görsel 3.45: Aynalama

• Aynalanacak nesneyi ve Mirror Line (Aynalama Doğrusu) seçiniz.
• OK tuşuna basınız.

Sıra Sizde 4

Aşağıda ölçüleri verilen şekli dijital üretim programında çiziniz.
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3.3.20. Circular Pattern (Dairesel Çoğaltma)

Circular Pattern, seçilen nesneleri bir eksen etrafında dairesel olarak çoğaltmak için kullanılır. 

Uygulama: Dairesel Çoğaltma

Dairesel çoğaltma yapmak için aşağıdaki yönergeleri uygulayınız.
• Circular Pattern komutunu çalıştırınız.
• Objects ile döndürülecek nesneyi seçiniz.
• Döndürme merkezi olarak ekranda oluşturulmuş bir nokta veya koordinat merkezi seçiniz.
• Type ile açısal, tam dairesel ya da simetrik seçim yapınız.
• Suppress seçimi yapılırsa çoğaltılan nesnelerin yanında onay kutucukları çıkar. Bu kutucukların işaretini 

kaldırarak çoğaltılan nesneyi silebilirsiniz.
• Quantity kısmına çoğaltma adedini giriniz.
• OK tuşuna basarak işlemi tamamlayınız.

Görsel 3.46: Dairesel çoğaltma

Sıra Sizde 5

Aşağıda ölçüleri verilen şekli dijital üretim programında çiziniz.
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3.3.21. Rectangular Pattern (Dikdörtgensel Çoğaltma)

Rectangular Pattern, bir nesnenin verilen satır ve sütun sayısında dikdörtgensel olarak çoğaltılması 
için kullanılır. Sadece bir yön verilerek çoğaltma yapılırsa doğrusal çoğaltma, iki yön verilerek çoğaltma 
yapılırsa dikdörtgensel çoğaltma adını alır. 

Uygulama: Dikdörtgensel Çoğaltma

• Rectangular Pattern komutunu çalıştırınız.
• Çoğaltılacak nesneyi seçiniz ya da komutu çalıştırdıktan sonra Objects kısmını tıklayarak nesne seçimini 

yapınız.
• Direction/s seçimi ile ekrandaki oklar yatay ve dikey olarak sürüklenebilir. Tek yönde çoğaltma için 

sadece o yöndeki ok işaretini sürükleyiniz.
• Distance Type alanında adım ya da çoğaltılacak boy seçimini yapınız.
• Quantity kısımına çoğaltılan nesnelerin adedini yazınız.
• Distance bölümüne çoğaltma yapılacak boyu yazabilirsiniz.
• Direction Type alanında simetrik ya da tek yönlü seçim yapabilirsiniz.

Görsel 3.47: Dikdörtgensel çoğaltma

3.3.22. Move / Copy (Taşı / Kopyala)

 Move / Copy; çizim alanı üzerindeki nesne ya da nesneleri ve nesnelerin detaylandırmalarını bir 
noktadan başka bir noktaya taşımak, kopyalamak ve döndürmek için kullanılır. 

Uygulama: Taşı / Kopyala

Taşı / Kopyala işlemi için aşağıdaki yönergeleri uygulayınız.
• Komutu çalıştırınız. Ekrana Move / Copy diyalog kutusu gelir.
• Selection kısmından taşınacak nesneleri seçiniz.
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• Move Type (Taşıma Türü) kısmında Free Move (Serbest Taşıma), Translate (XYZ Eksenlerine 
Dönüştür), Rotate (Döndür), Point to Point (Noktadan Noktaya Taşı), Point to Position (Noktadan 
Konuma Taşıma) seçeneklerini seçebilirsiniz.

• Set Pivot ile yeni bir tutma noktası belirleyiniz.
• XYZ Distance kısmında nesnenin XYZ eksenlerine olan mesafesini belirleyiniz.
• XYZ Angle kısmında nesnenin XYZ eksenleri ile arasındaki açı değerini giriniz.
• Create Copy kutucuğunu işaretlerseniz nesnenin sürüklendiği yerde bir kopyasını oluşturabilirsiniz.
• Ok yönleriyle veya küçük bir kare biçimindeki düğmeden tıklayarak sürükleme yapabilirsiniz.
• Nesnenin taşınacak noktasını farenin sol tuşuna basılı tutarak seçiniz. Bu noktadan basılı tutup nesneyi 

sürükleyerek istenilen yere bırakınız.

Görsel 3.48: Taşı

3.3.23. Scale (Ölçeklendirme)

Scale, çizim alanı üzerindeki nesne ya da nesneleri bir nokta merkez alınarak belirlenen ölçekte 
büyültmek ya da küçültmek amacı ile kullanılır.

Uygulama: Ölçeklendirme

Ölçeklendirme yapmak için aşağıdaki yönergeleri uygulayınız.
• Komutu çalıştırınız. Ekrana Sketch Scale diyalog kutusu gelir.
• Entities kısmından ölçeklendirilecek nesneyi seçiniz.
• Point kısmından ölçeklendirme işlemi için referans noktası seçiniz.
• Scale Factor kısmına ölçeklendirme faktörünü (büyültme ya da küçültme miktarını) yazınız.
• OK tuşuna basınız.
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Görsel 3.49: Ölçeklendirme

3.3.24. Sketch Dimension (Ölçülendirme)

Sketch Dimension, bir ya da daha çok nesneyi ölçülendirmek için kullanılır. Çizilen nesnelerin ölçülerini 
daha sonra değiştirmek mümkündür. Ölçülerde yapılan değişiklikler otomatik olarak geometrinin konumuna 
ve büyüklüğüne yansır. Bütün ölçülendirme çeşitlerini tek ölçülendirme komutu ile yapma imkânı sunar. 

Uygulama: Ölçülendirme

Ölçülendirme yapmak için aşağıdaki yönergeleri uygulayınız.
• Sketch Dimension komutunu çalıştırınız.
• Ölçülendirilecek nesneyi seçiniz. Ölçü çizgisini yerleştirince ekrana değer diyalog kutusu gelir.
• İstenilen ölçüyü yazıp Enter tuşuna basınız. Ölçülendirilecek başka bir çizim elemanı varsa ona tıklayarak 

ölçülendirmeye devam ediniz.
• İki doğru arasındaki açıyı da ölçülendirebilirsiniz. 
• D kısayol tuşuna basınız. Sketch Dimension aktif iken birinci doğruya, ardından ikinci doğruya tıklayınız.
• Doğrular arasındaki açı ölçüsünü girerek değiştiriniz.

Görsel 3.50: Ölçülendirme

3.3.25. Split Body / Split Face (Kesişim Eğrisi)
Split Body / Split Face; seçilen gövdeleri bir profil, yüz veya düzlem kullanarak böler ve yeni gövdeler oluşturur. 
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Uygulama: Split Body (Kesişim Eğrisi)
Kesişim eğrisinin kullanımı için 

aşağıdaki yönergeleri uygulayınız.
• XY düzleminde bir Box oluştu-

runuz.
• Construct > Midplane komutu-

nu çalıştırınız.
• Kutunun alt ve üst tabanlarını 

seçiniz. Seçilen bu iki düzlem 
arasında bir orta düzlem oluş-
turulur.

Görsel 3.51: Orta düzlem oluşturma

• Modify > Split Body komutunu 
çalıştırınız.

• Body to Split olarak bölünmesi 
istenen gövdeyi seçiniz.

• Splitting Tool(s) olarak Cons-
truct > Midplane komutu ile 
oluşturulan, modeli kesen orta 
düzlemi seçiniz.

• OK tuşuna basarak işlemi 
tamamlayınız. 

Görsel 3.52: Split body

Uygulama: Split Face (Kesişim Eğrisi)

Kesişim eğrisinin kullanımı için aşağıdaki yönergeleri uygulayınız.
• XY düzleminde bir küre oluşturunuz.
• XZ düzleminde bir Sketch oluşturunuz.
• Spline komutu ile eğri çiziniz.
• Çizgi ya da eğri nesnelerini yüzey nesnesine çevirmek için Surface (Yüzey) komut ikon penceresini 
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seçerek altındaki Create > Extrude komutunu çalıştırınız. 
• OK tuşuna basarak işlemi tamamlayınız.

Görsel 3.53: Eğri ile yüzey oluşturma

• Nesneyi seçiniz. 
• Eğri ile oluşturulan yüzeyi seçiniz.
• OK tuşuna basarak işlemi tamamlayınız.

Görsel 3.54: Eğri ile gövde bölme

3.4. Komut Yardımıyla Objeler Oluşturma
Dijital üretim programında çeşitli komutlar yardımıyla yeni nesneler oluşturulabilir.
3.4.1. Profil Nesnelerini Döndürerek Yeni Nesne Oluşturma

Dijital üretim programında iki boyutlu çizimler belirli yöntemlerle bir eksen etrafında döndürülerek 
yeni nesneler oluşturulabilir.

3.4.1.1. Revolve (Döndürerek Nesne Oluşturma) 

Revolve, iki boyutlu nesneleri belirlenen bir eksen etrafında döndürerek yeni bir nesne oluşturma 
komutudur. Döndürme ekseni sürekli çizgi veya eksen çizgisi olabilir. 

Dikkat

Eksen seçimi önemlidir. Seçilen eksene göre oluşan nesne farklılık gösterir. 
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Uygulama: Yuvarlak Masa Tablası Oluşturma

Revolve komutunu kullanarak 80 cm çapında yuvarlak masa tablası oluşturmak için
aşağıdaki yönergeleri uygulayınız.

• XY düzlemini seçerek aşağıda ölçüleri verilen iki boyutlu şekli çiziniz. 
• Şekli çizdikten sonra Finish Skecth tıklayınız.

Görsel 3.55: İki boyutlu çizim

• Create > Revolve komutunu seçiniz.
• Döndürülecek Profile (Profil) ve Axis (Eksen)’i seçiniz.
• OK tuşuna basarak işlemi tamamlayınız. Çalışmanızı kaydediniz.

Görsel 3.56: Yuvarlak masa tablası

3.4.1.2. Sweep (Yol Kullanarak Nesne Oluşturma) 

Sweep, seçilen kapalı bir geometrinin kapalı ya da açık bir yolu süpürerek nesne oluşturması için 
kullanılan komuttur. 

Uygulama: Köşegen Dolap Kulpu Oluşturma
Sweep komutunu kullanarak 7,5 cm uzunluğunda, 

1 cm genişliğinde dolap kulpu
oluşturmak için aşağıdaki yönergeleri uygulayınız.

• XY düzlemini seçerek 25 mm yüksekliği, 75 mm 
uzunluğu olan ters U biçimindeki şekli çiziniz.

Görsel 3.57: İki boyutlu çizim

http://kitap.eba.gov.tr/KodSor.
php?KOD=21376

Dikkat

Çizilecek profil ve yolun farklı düzlemlerde olması gerekmektedir.

http://kitap.eba.gov.tr/KodSor.
php?KOD=21377
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• XY düzleminde şekli çizdikten sonra Fillet komutu ile R10 olacak şekilde yuvarlayınız. Şekli çizdikten 
sonra Finish Skecth tıklayınız.

• XZ düzlemini seçerek 5 mm yarıçapında bir altıgen çiziniz.
• Şekli çizdikten sonra Finish Skecth tuşuna tıklayınız.
• Create > Sweep komutunu seçerek Profile (Profil) olarak XY düzleminde çizdiğiniz şekli ve Path (Yol) 

olarak XZ düzleminde çizdiğiniz şekli seçiniz.
• OK tuşuna basarak işlemi tamamlayınız. Çalışmanızı kaydediniz.

Görsel 3.58: Sweep komutu

3.4.1.3. Loft (Profiller ve Yüzeyler Arasında Nesne Oluşturma) 

Loft, farklı düzlemlerde ve taslaklarda çizilmiş profiller arasına malzeme atayarak nesne oluşturur. 
Komutun kullanılabilmesi için profillerin kapalı olması ve farklı düzlemlerde çizilmesi gerekir.

Sıra Sizde 6

Yandaki resimde gördüğünüz çay fincanı ve tabağını 
tasarlayınız. Çay fincanı 60 mm yüksekliğinde (taban 
yarıçapı 20 mm, ağız yarıçapı 60 mm), tabağı 5 mm 
yüksekliğinde olmalıdır. 
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Uygulama: Dolap Ayağı Oluşturma

Loft komutunu kullanarak taban yarıçapı 3,5 cm altıgen, ortası 60 mm çapında ve 90 mm uzunluğunda 
dolap ayağı oluşturmak için aşağıdaki yönergeleri uygulayınız.
• XY düzlemini seçerek 35 mm yarıçapında bir altıgen çiziniz. 
• Şekli çizdikten sonra Finish Skecth tıklayınız.
• Construct > Offset Plane seçiniz ve XY düzlemine 40 mm uzaklıkta yeni bir düzlem oluşturunuz. Bu 

düzlemde 40 mm çapında bir daire çiziniz.
• Construct > Offset Plane seçiniz ve XY düzlemine 25 mm uzaklıkta yeni bir düzlem oluşturunuz. Bu 

düzlemde 60 mm çapında bir daire çiziniz.

Görsel 3.59: Offset Plane oluşturma

• Construct > Offset Plane seçiniz ve XY düzlemine 25 mm 
uzaklıkta yeni bir düzlem oluşturunuz. Bu düzlemde 50 
mm genişliğinde bir altıgen çiziniz.

• Create > Loft komutunu seçip ilk çizdiğiniz profilden 
başlayarak sırasıyla profil çizimlerini seçiniz.

Görsel 3.60: Çizimlerin görünümü

http://kitap.eba.gov.tr/KodSor.
php?KOD=21378
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Görsel 3.61:  Loft komutu ile nesne oluşturma

Görsel 3.62: Loft komutu ile nesne oluşturma seçim sırası değişirse farklı bir nesne oluşumu

Dikkat

Profillerin seçim sırasına dikkat edilmelidir. Seçim sırası farklı olursa istenilen nesne elde 
edilemeyecektir.
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3.4.2. Profil Nesnelerinde Destek Elemanı (Payanda) Oluşturma

Dijital üretim programında gerekirse belirli yöntemlerle nesnelerin üzerine destek elemanları 
oluşturulabilir.

3.4.2.1. Rib (Nesneler Arasında Düşey Taşıyıcı Oluşturma)

Rib, nesneler üzerinde gerekli olan yerlerde payanda (destek elemanı) oluşturmak için kullanılır. 
Payanda Sketch ortamında çizilen bir çizgi, yay, eğri ya da daire olabilir.

Uygulama: Masa Ayağı Payanda Oluşturma

Masa ayağını güçlendirmek amaçlı bir payanda oluşturmak için aşağıdaki yönergeleri uygulayınız.
• XY düzlemini seçerek kenar uzunluğu 300 mm olan bir kare çiziniz. Şekli çizdikten sonra Finish Skecth 

tıklayınız.
• E kısayol tuşuyla Extrude komutunu çalıştırınız ve çizdiğiniz şekle 40 mm kalınlık veriniz.
• Create > Cylinder seçiniz ve tablanın orta noktasına 150 mm çapında, 60 cm uzunluğunda silindir 

oluşturunuz.
• Construct > Midplane (Orta Düzlem) komutunu kullanarak iki yüzey ortasına yeni bir düzlem 

oluşturunuz.

Görsel 3.63: Midplane (orta düzlem) oluşturma

• Oluşturduğunuz orta düzleme L kısayol tuşunu kullanarak tablanın dış yüzeyinden 20 mm uzaklıkta 
120° açıyla silindiri kesen bir yardımcı doğru parçası çiziniz.

Görsel 3.64: Payanda için yardımcı doğru parçası çizimi

http://kitap.eba.gov.tr/KodSor.
php?KOD=21379
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• Tablanın diğer yüzüne gelerek dış 
yüzeyinden 20 mm uzaklıkta 60° 
açıyla silindiri kesen bir yardımcı 
doğru parçası çiziniz.

Görsel 3.65: Payanda için nesnenin diğer yanına yardımcı doğru parçası çizimi

• Create > Rib komutunu seçiniz. 
Curve olarak çizdiğiniz yardımcı 
doğruyu seçiniz.

• Thickness değerini 30 mm olarak 
veriniz.

Görsel 3.66: Rib komutu ile payanda oluşturma

• Aynı işlemi diğer yardımcı çizgi için de gerçekleştiriniz. 
• OK tuşuna basarak işlemi tamamlayınız. Çalışmanızı kaydediniz.

3.4.2.2. Web (Nesneler Arasında Destek Elemanı Oluşturma)

Web, nesneler üzerinde gerekli olan yerlerde destek elemanı oluşturmak için kullanılır. Destek elemanı 
Sketch ortamında çizilen bir çizgi, yay, eğri ya da daire olabilir.

Uygulama: Çizgi İzleyen Araba Tekerleği Çizimi

Çizgi izleyen araba tekerleği oluşturmak için aşağıdaki yönergeleri uygulayınız.
• XY düzlemini seçerek aşağıda 50 mm çapında bir daire çiziniz. Şekli çizdikten sonra Finish Skecth 

tıklayınız.
• O kısayol tuşu ile çizdiğiniz daireyi 4 mm dışa doğru ofsetleyiniz.
• E kısayol tuşu ile çizdiğiniz şekle 30 mm kalınlık veriniz. 

http://kitap.eba.gov.tr/KodSor.
php?KOD=21380
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Görsel 3.67: Extrude ile kalınlık verme

• XY düzleminde Sketch oluşturunuz ve Line komutu ile merkezden daireye bir doğru parçası çiziniz ve 
Circular Pattern komutu ile 6 adet çoğaltınız.

Görsel 3.68: Sketch ortamında doğru parçası çizimi ve çoğaltma

• Create > Web komutunu seçiniz. 
Curve olarak çizdiğiniz doğru 
parçalarını seçiniz. Depth Options 
olarak Depth seçiniz. Thickness 
değeri olarak 2 mm, Depth değeri 
olarak 15 mm giriniz. 

Görsel 3.69: Web komutu ile destek elemanlarını oluşturma
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Görsel 3.70: Hole komutu ile delik açma

3.4.3. Profil Nesnelerini Çoğaltma

Dijital üretim programında istenilen nesneler ve özellikler belirli yöntemlerle çoğaltılabilir.

3.4.3.1. Gövdeleri Taşıma / Kopyalama / Döndürme

Çizim alanındaki nesnelerin konumlarını değiştirmek için kullanılır. Modeller taşınır, kopyalanır, 
döndürülür ya da diğer modellerle ilişkilendirilir. 

Uygulama: Çizilen Bir Nesnenin Taşınması / Kopyalanması

Belirlenen nesneyi taşıma ve kopyalama işlemlerini yapmak için aşağıdaki yönergeleri uygulayınız.
• Box komutu ile bir kutu, Cylinder komutu ile bir silindir oluşturunuz. 
• Modify > Move / Copy komutunu seçiniz.
• Silindirik parçayı seçiniz. Fare yardımıyla ya da XYZ eksenlerinden taşımak istediğiniz mesafeyi giriniz 

ve kutunun yanına taşıyınız. 

• Create > Hole komutunu seçiniz. Origin noktasında bir 
delik oluşturunuz. Delik çapı olarak 2 mm giriniz ve uzun-
luk olarak All seçiniz. 

• OK tuşuna basarak işlemi tamamlayınız. Çalışmanızı kay-
dediniz.
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Görsel 3.71: Move / Copy komutuyla taşıma işlemi

• İki parçanın belirlenen noktalardan birleştirilmesi için Move diyalog kutusundan Move Type olarak 
Point to Point komutunu seçiniz. 

• Origin Point için silindirin orta noktasını seçiniz. 
• Target Point için kutu yüzeyinin orta noktasını seçiniz.

Görsel 3.72: Move / Copy komutuyla Point to Point taşıma işlemi

• Kopyalama işlemi yapmak için Move Object olarak Bodies seçiniz. Kopyalanacak gövde nesnesini 
seçiniz. 

• Diyalog kutusundan Create Copy işaretleyiniz. 
• Gövde nesnesinin kopyalanacağı mesafeyi giriniz ya da fare yardımıyla gövdeyi istenilen yere sürükleyip 

bırakınız.

Dikkat

Kopyalama işlemi için kopyalanacak parça seçildikten sonra Create Copy işaretlenmelidir 
yoksa taşıma işlemi yapılmış olur.
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Görsel 3.73: Move / Copy komutuyla Point to Point kopyalama işlemi

3.4.3.2. Rectangular Pattern (Doğrusal veya Dikdörtgensel Çoğaltma) 

 Rectangular Pattern; nesneleri, yüzeyleri ya da katı gövdeleri doğrusal olarak belirlenen mesafede ve 
sayıda çoğaltmak için kullanılır. Tek yönde işlem yapılırsa doğrusal çoğaltma yapar. İkinci yön seçilir ve iki 
yönde işlem yapılırsa dikdörtgensel çoğaltma yapar.
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Uygulama: Çizilen Bir Nesnenin Doğrusal Olarak Çoğaltılması

Görsel 3.74: Rectangular Pattern diyalog kutusu

Çizilen bir nesnenin doğrusal 
olarak çoğaltılması için aşağıdaki 
yönergeleri uygulayınız.
• Daha önce çizdiğiniz çizgi iz-

leyen araba tekerleği mode-
lini açınız.

• Pattern > Rectangular Pat-
tern komutunu seçiniz. 

• Rectangular Pattern diyalog 
kutusundan Objects olarak 
tekerleği seçiniz. 

• Directions olarak X eksenini 
seçiniz. 

• Quantity olarak her iki yön 
için de 3 değerini giriniz. 

Görsel 3.75: Rectangular Pattern komutu ile çoğaltma işlemi

• OK tuşuna tıklayınız ve işlemi tamamlayınız.
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3.4.3.3. Circular Pattern (Dairesel Çoğaltma)

Circular Pattern; nesneleri, yüzeyleri ya da nesne gövdelerini bir eksen etrafında döndürerek belirlenen 
açıda dairesel olarak çoğaltma için kullanılır. Döndürme ekseni olarak parçanın eksen çizgisi veya dairesel 
parçanın kenar çizgisi seçilebilir. 

Uygulama: Çizilen Bir Nesnenin Dairesel Olarak Çoğaltılması

Çizilen bir nesnenin dairesel olarak çoğaltıl-
ması için aşağıdaki yönergeleri uygulayınız.
• 50 mm çapında, 20 mm yüksekliğinde bir si-

lindir çiziniz. 
• Çizdiğiniz silindirin üstüne kenar uzunluğu 5 

mm olan bir küp çiziniz ve Operations olarak 
New Body seçiniz.

Görsel 3.76: Box komutu ile oluşturulan silindir üzerine kutu ekleme

• Pattern > Circular Pattern komutunu 
seçiniz. Objects olarak çizdiğiniz küpü 
seçiniz.

• Axis olarak silindirin dairesel yüzey çiz-
gisini seçiniz ve Quantity olarak 4 de-
ğerini giriniz.

Görsel 3.77: Circular Pattern komutu

3.4.3.4. Pattern on Path (Yol Üzerinde Çoğaltma)

Bu yöntem ile bir unsur, yüzey ya da nesnenin çizilen bir eğri yol boyunca belirlenen sayıda çoğaltılması 
sağlanır. Çizilecek yol, tek parça olmalıdır. 

Sıra Sizde 7

15,8 mm genişliğinde, 31,8 mm uzunluğunda, 9,6 mm 
yüksekliğinde, üzerinde 8 tane 5 mm çapında silindir 
olan parçayı tasarlayınız .

Dikkat

Eksen çizmeden çoğaltma yapılmak istenirse parçanın dış silindirik yüzeyi ya da kenar 
çizgisi seçilebilir.
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Uygulama: Çizilen Bir Nesnenin Yol Boyunca Çoğaltılması

Çizilen bir nesnenin yol boyunca çoğaltılması 
için aşağıdaki yönergeleri uygulayınız.
• Dairesel Çoğaltma konusunda çizdiğiniz silin-

dirik parçanın XY düzleminde bir Sketch açınız.
• Spline komutu ile şekildeki gibi rastgele eğri-

sel bir yol çiziniz.
• Finish Sketch tıklayınız. 

Görsel 3.78: Spline komutu ile eğrisel yol çizimi

• Pattern > Pattern on Path komutunu seçiniz. 
• Objects olarak silindirik basit modeli seçiniz.
• Path olarak çizdiğiniz eğri yolu seçiniz. 
• Quantity olarak 5 değerini giriniz. Fare yardımıyla 

çizdiğiniz yolu tarayınız veya belirlenen Distance 
değerini giriniz.

Görsel 3.79: Pattern on Path komutu

Görsel 3.80: Pattern on Path komutuyla Distance ayarı
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3.4.3.5. Mirror (Profil Nesnelerini Aynalama)

Mirror, nesnelerin ya da yüzeylerin bir eksen ile simetriğini alma işlemi için kullanılır. Simetri ekseni 
olarak düzlemler veya nesnelerin yüzeyleri alınabilir.

Uygulama: Çizilen Bir Nesnenin Aynalanması

Çizilen bir nesnenin aynalanması için aşağıdaki yönergeleri uygulayınız.
• XY düzleminde Length 55 mm, Width 40 mm ve Height 15 mm olacak şekilde bir dikdörtgen prizma 

çiziniz. 
• Dikdörtgen prizma üst yüzeyinde bir Sketch oluşturunuz ve 

Text komutunu kullanarak MEB yazınız. 
• E kısayol tuşunu kullanarak yazıya 10 mm kalınlık veriniz.
• Create > Mirror komutunu seçiniz. 
• Objects olarak oluşturduğunuz nesneyi seçiniz.
• Mirror Plane olarak XY düzlemini seçiniz.
• OK tuşuna basarak işlemi tamamlayınız. Çalışmanızı kaydediniz.

Görsel 3.81: Nesnenin aynalanmış hâli

3.5. Komut Yardımıyla Nesneleri Düzenleme
Dijital üretim programında oluşturulan nesneler, komutlar yardımıyla düzenlenebilir. 

3.5.1. Nesneden Başka Bir Nesne Çıkarma

Dijital üretim programında çizilen nesneler, birbirinden çıkarılarak yeni nesneler oluşturulabilir.

3.5.1.1. Döndürerek Katıları Birbirinden Çıkarma

Kullanılan yöntemler ve parametreler Revolve komutu ile aynıdır. Diyalog kutusundan Operation 
bölümünde Cut seçimi yapılıp keserek çıkarma işlemi gerçekleştirilir. Komutun aktif olabilmesi için çizim 
alanında bir nesnenin bulunması gerekir. 

Uygulama: Vida Başı Oluşturma 

Vida başı oluşturmak için aşağıdaki yönergeleri uygulayınız.
• XZ düzleminde 30 mm yarıçapında bir altıgen çiziniz.
• E kısayol tuşu ile altıgene 20 mm kalınlık veriniz. 
• Sketch ortamında XY düzleminde Line komutu ile 

oluşturduğunuz nesnenin bir köşesini 2 mm kesen üçgen çiziniz. 
Finish Sketch tıklayınız.

Görsel 3.82: Üçgen çizimi

http://kitap.eba.gov.tr/KodSor.
php?KOD=21381
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• Create > Revolve komutunu seçiniz. Ekrana gelen diyalog 
kutusundan Profil olarak çizdiğiniz üçgeni seçiniz. 

• Axis olarak X eksenini seçiniz.
• Angle olarak 360° giriniz. 
• Operation olarak Cut işlemini seçiniz. 
• OK tuşuna tıklayarak işlemi tamamlayınız. Çalışmanızı 

kaydediniz.

Görsel 3.83: Çıkarma / kesme işlemi sonrası vida başı

3.5.1.2. Yol Kullanarak Nesneleri Birbirinden Çıkarma

Komutun kullanımı ve çizim mantığı Sweep komutu ile aynıdır. Operation bölümünde Cut seçimi 
yapılıp keserek çıkarma işlemi gerçekleştirilir. Komutun aktif olabilmesi için çizim alanında bir nesnenin 
bulunması gerekir. 

Uygulama: Yol Kullanarak Nesneleri Birbirinden Çıkarma
Yol kullanarak nesneleri birbirinden çıkarma işlemiyle sehpa tablası oluşturmak için aşağıdaki yöner-

geleri uygulayınız.
• Sketch ortamında XY düzlemine 50 cm kenar uzunluğunda 

bir kare çiziniz.
• Finish Sketch tıklayınız.
• E kısayol tuşu ile çizdiğiniz kareye 36 mm kalınlık veriniz.
• Sketch ortamında XY düzleminde oluşturduğunuz nesne-

nin köşe noktasını merkez alarak 15 mm çapında bir daire 
çiziniz.

• Finish Sketch tıklayınız.

Görsel 3.84: Daire çizimi

• Create > Sweep komutunu seçiniz. 
• Diyalog kutusundan Profile olarak çizdiğiniz daireyi seçiniz. 
• Path olarak ilk çizdiğiniz karenin kenarını seçiniz. 
• Distance olarak 1 değerini giriniz.
• Operation olarak Cut seçiniz.

Görsel 3.85: Kenarları çıkarılmış sehpa tablası
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3.5.1.3. Profiller ve Yüzeyler Arasında Çıkarma

Loft komutu, farklı düzlemlerde ve taslaklarda çizilmiş profiller arasında çıkarma işlemi yaparak nesne 
oluşturur. 

Uygulama: Profiller ve Yüzeyler Arasında Çıkarma

Profiller ve yüzeyler arasında nesneleri birbirinden çıkararak sehpa ayağı oluşturmak için aşağıdaki 
yönergeleri uygulayınız.
• XY düzleminde 300 mm yarıçapında uzunluğunda bir altıgen çiziniz. 

Görsel 3.86: Çizimlerin yukarıdan ve yandan görünüşü

• O kısayol tuşunu kullanarak çizdiğiniz altıgeni 50 mm içeri doğru ofsetleyiniz. Finish Sketch tıklayınız.
• Construct > Offset Plane seçiniz ve XY düzlemine 300 mm uzaklıkta yeni bir düzlem oluşturunuz. Bu 

düzlemde 300 mm çapında bir daire çiziniz.
• O kısayol tuşunu kullanarak çizdiğiniz daireyi 50 mm içeri doğru ofsetleyiniz. Finish Sketch tıklayınız.
• Construct > Offset Plane seçiniz ve üst düzleme 300 mm uzaklıkta yeni bir düzlem daha oluşturunuz.
• Yeni düzlem üzerine bir Sketch açınız ve 400 mm kenar uzunluğunda bir kare çiziniz.
• O kısayol tuşunu kullanarak çizdiğiniz kareyi 40 mm içeri doğru 

ofsetleyiniz. Finish Sketch tıklayınız.
• Create > Loft komutunu çalıştırınız ve ilk çizdiğinizden başlayarak 

dış profilleri sırasıyla seçiniz.
• Body1 görünümünü kapatınız. 
• Create > Loft komutunu çalıştırınız ve ofsetleyerek oluşturduğunuz 

iç profilleri ilk çizdiğinizden başlayıp sırasıyla seçiniz.

Görsel 3.87: Nesnenin oluşturulması
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Görsel 3.88: Loft komutu ile nesnenin çıkarılması

• Operation olarak Cut seçiniz. 
• Body1 görünümünü açınız.

Görsel 3.89: Loft komutu ile nesnenin çıkarılması

• OK tuşuna tıklayarak işlemi tamamlayınız.

Görsel 3.90: Çıkarma işlemi sonrası nesnenin üstten görünümü
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3.5.1.4. Silindirik Yüzeylere Diş Açma

Silindirik yüzeylere diş açma iki biçimde gerçekleştirilebilir.
Birinci yöntem, Threat komutuyla silindirik yüzeylere diş açmadır. Threat komutu, var olan standartlara 

göre silindirik yüzeylere diş açılmasını sağlar. 

Uygulama: Threat Komutuyla Diş Açma

Threat komutuyla nesnenin yüzeyine 
belirlenen uzunlukta diş açarak cıvata 
yapmak için aşağıdaki yönergeleri 
uygulayınız.
• Revolve komutu ile daha önce 

oluşturduğunuz vida başlığı nesnesini 
açınız. 

• Create > Cylinder komutu ile vidanın 
arka yüzüne bir silindir oluşturunuz. 

• Oparetion olarak Join seçiniz.

Görsel 3.91: Vida başlığına silindirin eklenmesi

• Modify > Fillet komutunu seçiniz. 
• Silindirin başlangıç ve vida başı ile 

birleştiği yüzeyleri 2 mm yuvarlama 
yapınız.

• Create > Threat komutunu seçiniz.
• Faces olarak silindir nesnesini 

seçiniz. 
• Modeled seçimini yapıp dişlerin 

fiziksel olarak açılmasını sağlayınız.
• Full Length seçimi ile silindirin 

tamamına diş açılmasını sağlayınız.
• Full Length seçimini kaldırınız. 

Başlangıç noktası için Offset olarak 
0 mm, diş uzunluğu belirlemek için 
Length değeri olarak 50 mm giriniz. 

Görsel 3.92: Silindirin başlangıç ve birleşim yüzeylerinin yuvarlanması

Dikkat

Dişin anma ölçüsü, seçilen yüzeyi oluşturan çapa göre otomatik olarak belirlenecektir. 
İstenirse farklı bir çapa göre diş profilinde vida da açılabilir.
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Görsel 3.93: Belirlenen uzunlukta diş açılması

• OK tuşuna tıklayarak işlemi tamamlayınız. Çalışmanızı kaydediniz.
İkinci yöntem ise Coil komutuyla silindirik yüzeylere diş açmadır. Mevcut standartların dışında bir 

ölçüyle vida açılacağı zaman Coil komutu kullanılabilir. Komutun kullanılabilmesi için çizim alanında diş 
açılacak nesnenin bulunması gerekir. 

Uygulama: Coil Komutuyla Diş Açma

Coil komutuyla nesne yüzeyine belirlenen uzunlukta diş açarak cıvata yapmak için aşağıdaki yönergeleri 
uygulayınız.
• Threat komutu ile daha önce oluşturduğunuz cıvata nesnesini açınız.
• Timeline bölümünden Threat komutunun öncesine geliniz. 
• Create > Coil komutunu seçiniz. 
• Çizim düzlemi olarak cıvatanın dairesel yüzeyini seçiniz. 
• Çizim merkez noktası ile silindirin merkez noktasını eşleştiriniz ve yay oluşturunuz.

Görsel 3.94: Coil komutuyla yay oluşturma
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• Coil diyalog kutusundan Diameter değerini 43 mm, Height değerini -55 mm, Section Size değerini 2 
mm olarak giriniz. 

• Coil diyalog kutusundan Revolutions değerini 15 mm giriniz. Section olarak Triangular (Internal) 
seçiniz. 

Görsel 3.95: Diş tipi ve diş tur değerinin ayarlanması

• Operation olarak Cut seçiniz.
• OK tuşuna tıklayarak işlemi tamamlayınız. Çalışmanızı kaydediniz.

3.5.2. Chamfer (Nesnelerde Pah Kırdırmak)

Chamfer, nesnelerin kenar ya da köşelerine farklı şekilde pahlar kırmak için kullanılır. 

Uygulama: Pah Kırma

Pah kırdırarak nesnenin kenarlarını düzletmek için aşağı-
daki yönergeleri uygulayınız.
• XY düzleminde Length 90 mm, Width 60 mm, Height 20 

mm olacak şekilde bir kutu oluşturunuz. 
• Oluşturduğunuz kutunun üst yüzeyine Length 40 mm, 

Width 25 mm, Height 10 mm olacak şekilde bir kutu 
daha oluşturunuz. 

Görsel 3.96: Box komutu ile ikinci nesnenin oluşturulması

Dikkat

Coil ile diş açılırken çizilecek yayın çapı diş açılacak yüzeyden çok küçük olursa parçanın 
yüzeyine değil içine diş açılır.
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• Modify > Chamfer komutunu seçiniz. 
Edges (Kenar) olarak büyük kutunun 
uzun kenarını seçiniz.

• Chamfer Type olarak Equal Distance 
(Eşit Uzaklık) seçiniz. Distance değeri 
olarak 3 mm giriniz.

Görsel 3.97: Chamfer komutu ile Equal Distance (Eşit Uzaklık) pah kırma

• Chamfer komutunu seçiniz. 
Edges olarak küçük kutunun 
uzun kenarını seçiniz.

• Chamfer Type olarak Two 
Distance (İkili Uzaklık) seçi-
niz. X ekseni Distance değeri  
olarak 15 mm, Y ekseni Dis-
tance değeri  olarak da 5 mm 
giriniz.

Görsel 3.98: Chamfer komutu ile Two Distance (İkili Uzaklık) pah kırma

• Modify > Chamfer komutunu seçiniz.
• Edges olarak büyük 

kutu ile küçük kutunun 
birleştiği kısa kenarı 
seçiniz. 

• Chamfer Type olarak 
Distance and Angle 
(Uzaklık ve Açı) seçiniz. 
Distance değeri olarak 
5 mm, Angle değeri 
olarak 65° giriniz.

• OK tuşuna tıklayarak 
işlemi tamamlayınız. 
Çalışmanızı kaydediniz.

• Coil diyalog kutusundan Diameter değerini 43 mm, Height değerini -55 mm, Section Size değerini 2 
mm olarak giriniz. 

• Coil diyalog kutusundan Revolutions değerini 15 mm giriniz. Section olarak Triangular (Internal) 
seçiniz. 

Görsel 3.95: Diş tipi ve diş tur değerinin ayarlanması

• Operation olarak Cut seçiniz.
• OK tuşuna tıklayarak işlemi tamamlayınız. Çalışmanızı kaydediniz.

3.5.2. Chamfer (Nesnelerde Pah Kırdırmak)

Chamfer, nesnelerin kenar ya da köşelerine farklı şekilde pahlar kırmak için kullanılır. 

Uygulama: Pah Kırma

Pah kırdırarak nesnenin kenarlarını düzletmek için aşağı-
daki yönergeleri uygulayınız.
• XY düzleminde Length 90 mm, Width 60 mm, Height 20 

mm olacak şekilde bir kutu oluşturunuz. 
• Oluşturduğunuz kutunun üst yüzeyine Length 40 mm, 

Width 25 mm, Height 10 mm olacak şekilde bir kutu 
daha oluşturunuz. 

Görsel 3.96: Box komutu ile ikinci nesnenin oluşturulması

Dikkat

Coil ile diş açılırken çizilecek yayın çapı diş açılacak yüzeyden çok küçük olursa parçanın 
yüzeyine değil içine diş açılır.

Görsel 3.99: Chamfer komutu ile Distance and Angle (Uzaklık ve Açı) pah kırma
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3.5.3. Düzenleme Komutlarıyla Nesneler Oluşturma

Dijital üretim programında düzenleme komutları aracılığıyla nesneler oluşturulabilir.

3.5.3.1. Fillet (Nesnelerde Yuvarlatma) 

Fillet; nesnelerin kenarlarını, köşelerini, kenarlar veya yüzeyler arasını yuvarlatmak için kullanılır.

Uygulama: Nesnelerde Yuvarlatma

Nesnelerin kenarlarını yuvarlatmak için aşağıdaki yönergeleri uygulayınız.
• Pah kırdırmada oluşturduğunuz nesneyi açınız. 
• Modify > Fillet komutunu seçiniz. 
• Edges olarak büyük kutunun üç kenarını seçiniz. 

Görsel 3.100: Fillet komutu ile kenarların seçimi

• Radius Type olarak Constant Radius seçiniz.
• Yuvarlatma yarıçapı olarak 4 mm giriniz. 
• OK tuşuna tıklayarak işlemi tamamlayınız.

Görsel 3.101: Fillet komutu ile sabit yarıçaplı yuvarlatma

• Modify > Fillet komutunu seçiniz. Edges olarak küçük kutunun üç kenarını seçiniz. 
• Radius Type olarak Chord Length seçiniz. Uzunluk olarak 4 mm giriniz. 
• OK tuşuna tıklayarak işlemi tamamlayınız.
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Görsel 3.102: Fillet komutu ile sabit uzunlukla yuvarlatma

• F kısayol tuşu ile Fillet komutunu açınız.
• Edges olarak büyük kutunun arka uzun kenarını seçiniz. 
• Radius Type olarak Variable Radius seçiniz. 

Görsel 3.103: Fillet komutu ile sabit uzunlukla yuvarlatma

• Fare yardımıyla ikinci yuvarlatma noktasını belirleyiniz. 

Görsel 3.104: İkinci yuvarlatma noktası belirleme
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• Fillet diyalog kutusu Radius Points (Yarıçap Noktaları) bölümünden Start değerini 2 mm, Point 1 
değerini 10 mm, End değerini 0 mm olarak giriniz. 

• OK tuşuna tıklayarak işlemi tamamlayınız. Çalışmanızı kaydediniz.

Görsel 3.105: Değişken yarıçaplı yuvarlatma

3.5.3.2. Draft (Yüzeylere Eğim Verme) 

Draft, nesne üzerinde seçilen bir veya birden fazla yüzeye istenilen açıda eğim vermek için kullanılır.

Uygulama: Nesnelerin Yüzeylerine Eğim Verme

Nesnelerin yüzeylerine eğim vermek için aşağıdaki yönergeleri uygulayınız.
• Box komutu ile XY düzleminde 

Length 150 mm, Width 55 mm, 
Height 5 mm olacak şekilde bir 
kutu oluşturunuz. 

• Nesnenin üst yüzeyinde bir 
Sketch oluşturunuz. Text ko-
mutu ile M E B yazınız. Height 
değerini 50, Angle değerini 
-180° giriniz.

• E kısayol tuşunu kullanarak ya-
zınıza 10 mm kalınlık veriniz. 

Sıra Sizde 8

Silindir başlı, altıgen alyan anahtar oyuklu, uzunluğu 
70 mm, diş uzunluğu 35 mm, vida adımı, M25x1,5 olan 
cıvatayı oluşturunuz. 

Görsel 3.106: Yüzeylere eğim verilmesi



DİJİTAL ÜRETİM

1413. ÖĞRENME BİRİMİ

• Modify > Draft komutunu seçiniz.
• Plane olarak “M” harfinin üst yüze-

yini seçiniz.
• Faces olarak “M” harfinin yan yüze-

yini seçiniz. 
• Angle olarak 30° giriniz. 
• OK tuşuna tıklayarak işlemi tamam-

layınız.
• Draft komutunu seçiniz. Plane ola-

rak “M” harfinin üst yüzeyini seçiniz. 
• Faces olarak Ctrl tuşuyla birlikte 

eğim vermek istediğiniz yüzeyleri se-
çiniz. 

• Angle olarak 30° giriniz.

3.5.3.3. Shell (Nesnelere Et Kalınlığı Verme)

Shell, nesneleri belirli bir et kalınlığına bağlı kabuk model hâline getirmek için kullanılır.

Uygulama: Nesnelere Et Kalınlığı Verme

Nesnelere et kalınlığı vermek için aşağıdaki yönergeleri uygulayınız.
• Bir önceki uygulamada yazdığınız MEB 

yazısını açınız.
• Modify > Shell komutunu seçiniz.
• Faces / Body olarak MEB harflerinin 

hepsini seçiniz.
• Direction olarak Outside seçiniz. Out-

side Thickness değerini 1 mm giriniz. 
• OK tuşuna tıklayarak işlemi tamamlayı-

nız. Çalışmanızı kaydediniz.

Görsel 3.109: Et kalınlığı verilen yüzey

Görsel 3.107: Yüzeylere eğim verilmesi

Görsel 3.108: Et kalınlığı verilecek yüzey seçimi
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3.5.3.4. Split (Nesneleri Parçalara Ayırma) 

Split, bir nesneyi üzerine çizilmiş çizgiler yardımıyla bölerek parçalara ayırmak için kullanılır. Çizgilerin 
uzantısı nesneyi kesebilecek şekilde olmalıdır. İşlem sonunda iki ayrı gövde oluşur.

Uygulama: Nesneleri Parçalara Ayırma

Nesneleri parçalara ayırmak için aşağıdaki yönergeleri uygulayınız.
• XZ düzlemine bir silindir çiziniz. 
• Sketch ortamında XY düzlemine bir Spline çiziniz.
• Modify > Split komutunu seçiniz.
• Bölünecek nesne (Body to Split) olarak oluşturduğu-

nuz silindiri seçiniz.
• Bölme aracı (Spliting Tool) olarak çizdiğiniz Spline seçi-

niz. 

Görsel 3.110: Silindir üzerine spline çizme

Görsel 3.111: Split komutu ayarları ve nesneyi bölme

3.5.3.5. Combine (Birleştir) 

Combine, aynı çalışma ortamında bulunan farklı nesnelerin birleştirilmesinde, çıkarılmasında veya 
kesişimlerinin alınmasında kullanılır. Komutun uygulanabilmesi için aynı çalışma sayfasında birden fazla 
nesne bulunmalıdır. 

Uygulama: Nesneleri Birleştirme

Nesneleri birleştirmek için aşağıdaki yönergeleri uygulayınız.
• Split ile iki parçaya ayırdığınız nesneyi açınız. 
• Modify > Combine komutunu seçiniz. Target Body olarak alttaki büyük nesneyi seçiniz.
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Görsel 3.112: Combine birleştirilecek nesne seçme

• Tool Bodies olarak üstteki büyük nesneyi seçiniz.
• Operations olarak Join seçiniz. 
• OK tuşuna tıklayarak birleştirme işlemini tamamlayınız. 
• Bu işlemden sonra unsur ağacındaki Bodies menüsün-

de nesnelerin birleşerek tek bir Body olduğu görülür.

Görsel 3.113: Birleştirilmiş nesne

3.5.3.6. Press Pull (Yüzey Öteleme)

Press Pull, nesnelerin seçilen yüzeylerini belirli bir miktar ötelemek ve taşımak için kullanılır.

Uygulama: Yüzeyleri Öteleme

Yüzeyleri öteleme işlemi için aşağıdaki yönergeleri uygulayınız.
• Daha önce oluşturduğunuz MEB yazı uygulamanızı açınız. 
• Modify > Press Pull komutunu seçiniz. 
• Selection olarak yazının üst yüzeyini seçiniz.
• Distance değeri olarak 15 mm giriniz. 
• Offset Type kısmında Automatic işaretleyip seçilen yüzeyi toplam 15 mm öteleyiniz. 
• Q kısayolu ile tekrar Press Pull komutunu açınız, aynı yüzeyi seçiniz. 
• Distance değeri olarak 15 mm giriniz. 

Dikkat

Cut seçilirse çıkarma işlemi yapılır. Intersect seçilirse kesişim alanı kalır.
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• Offset Type kısmında New Offset işaretleyip seçilen yüzeyi 15 mm öteleyerek toplamda 30 mm kalınlık 
elde ediniz. 

Görsel 3.114: Seçilen yüzeyi öteleme

3.5.4. Align (Nesnelerin Hizalanması)

Align, nesnelerin seçilen yüzeylerini ve noktalarını birbirlerine göre hizalamak için kullanılır. 

Uygulama: Yüzeyleri veya Noktaları Hizalama

Yüzeyleri veya noktaları hizalamak için aşağıdaki yönergeleri uygulayınız.
• XZ düzleminde uzunluğu 60 mm, genişliği 40 mm, yük-

sekliği 10 mm olacak şekilde bir kutu ve 35 mm çapında 
50 mm yüksekliğinde bir silindir oluşturunuz.

• Modify > Align komutunu seçiniz. From olarak kutunun 
üst yüzeyinin orta noktasını seçiniz.

• To olarak silindirin üst tablasının orta noktasını seçiniz. 
Angle tıklayarak kutunun yönünü değiştiriniz.

• Ctrl+Z kısayol tuşu ile yaptığınız hizalama işlemini geri 
alınız.

• Modify > Align komutunu seçiniz. 
• From olarak kutunun üst yüzeyini seçiniz.

Görsel 3.116: Nesneleri hizalama

Görsel 3.115: Align komutu ile noktaları seçme
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Görsel 3.117: Align komutuyla yüzeyleri seçme

• To olarak silindirin üst yüzeyini seçiniz.

Görsel 3.118: Align komutuyla yüzeyleri hizalama

3.6. Assembly (Nesnelerin Montajı)
Assembly; bir makineyi, bir sistemi veya bir mekanizmayı oluşturan parçaların belirli bir sıraya ya 

da düzene göre bir araya getirilmesi işlemidir. Montaj birkaç parçadan oluşabildiği gibi binlerce parçadan 
da oluşabilir. Bu nedenle montaj sırasında küçük küçük montaj grupları oluşturularak montajlama işlemi 
kolaylaştırılabilir. Bu şekildeki montajlama işlemine alt montaj adı verilir. Nesneler, yüzlerce alt montajdan 
oluşabilir.

3.6.1. Montaj Sayfasının Açılması

Dijital üretim programında montaj işlemi Design ortamında doğrudan yapılabilmektedir. 
3.6.2. Montaj İlişkisi Ekleme ve Eşleme 

Dijital üretim programında As-Built Joint ve Joint komutları ile yararlanılabilecek yedi farklı Joint 
(Montaj İlişkisi) türü bulunmaktadır. Her montaj ilişkisinin farklı bir kullanımı vardır ve hareket tanımlamak 
için izin verilen serbestlik biçimleri farklıdır. Her montaj ilişkisinde, ilişki değerlerinin parametrik bir sayısal 
değer oluşturacağına da dikkat edilmelidir. Montaj ilişkileri ile çalışırken mümkün olan en az serbestlik 
derecesi açık tutulmalıdır. 

Montaja başlanacağı zaman bir tane temel parça olmasında fayda vardır. Montaj ilişkilerinin bu parçadan 
yürütüleceği düşünülmelidir. İlk getirilecek parça bu nedenle iyi seçilmelidir. Parça, montaj amacıyla çizim 
alanına getirilirse unsur ağacında parçanın üzerindeyken farenin sağ tuşuna tıklanır ve Ground (Yer) seçimi 
yapılır. Joint (Eklem) komutu çalıştırıldığında program bu parçadan başlayarak montaj ilişkisi oluşturur.

Montaj ilişkisi; bir kenara, bir yüzeye, bir köşeye ve bir noktaya göre verilebilir. Montaj ilişkisi belirlenirken 
parçaların neresinin seçileceği, diğer parça ile montaj ilişkisine göre belirlenmeli ve kararlaştırılmalıdır.

Uygulama: Montaj İçin Taslak Çizim Oluşturma

Görselde yer alan taslak çizimi oluşturmak için aşağıdaki yönergeleri uygulayınız.
• Sketch komutu ile bir taslak oluşturunuz.
• Taslak çizimleri yapınız.
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Görsel 3.119: Yatak nesnesi ve kayan nesne taslağı

• Finish Sketch komutu ile taslağı tamamlayınız.
• Extrude komutunu her iki çizim için ayrı ayrı çalıştırınız.
• Yatak Nesnesi için Distance değerini 300 mm, Kayan Nesne için Distance değerini 20 mm olarak 

belirleyiniz.

Görsel 3.120: Nesneler

• Unsur ağacındaki Bodies dalı altında nesneleri listeleyiniz. 
• Body1 nesnesinin adını Yatak, Body2 nesnesinin adını da Kayan Nesne olarak değiştiriniz. 
• Browser > Bodies altında listelenen ögelerin her birinin üzerine farenin sağ tuşu ile ayrı ayrı tıklayınız. 

Gelen sağ tuş menüsünden Create Companents from Bodies komutuyla nesneleri bileşen hâline 
getiriniz.

• Yatak bileşeni üzerine farenin sağ tuşu ile tıklayıp menüden Ground seçeneğini işaretleyiniz ve Yatak 
bileşenini yere sabitleyiniz.

Dikkat

Bileşenin tasarım düzlemindeki yeri değiştirilirse komut ikon penceresinin en sağında Position 
(Konum) komutu belirir. Bileşen, Revert (Eski Hâline Getir) komutu ile  konumu değiştirilmeden 
önceki yerine geri gelir.

Dikkat
Üzerinde çalışılmak istenen Companent, Browser altından seçilmelidir. Seçme işlemi, 
bileşen üzerine farenin sağ tuşu ile tıklanıp gelen menüden Activate (Etkinleştir) 
seçeneğiyle gerçekleşir. 
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Uygulama: Rigid (Sabit) Montaj İlişkisi

Rigid, iki montaj bileşenini hiçbir harekete olanak vermeyecek şekilde birleştirir. Sabit montaj oluştur-
mak için aşağıdaki yönergeleri uygulayınız.
• Asssemble>Joint komutunu seçiniz.
• Joint komut menüsünden Motion sekmesini seçiniz.
• Motion Type (Hareket Tipi) olarak Ri-

gid (Sert) hareket türünü seçiniz. 
• Component1 ve Component2 alan-

larını kullanarak montaj nesnelerini 
seçiniz.

• Seçim esnasında parçaların monte 
edileceği Joint Origin noktalarını sıra-
sıyla gösteriniz.

Görsel 3.121: Yatak parçası montaj noktası belirleme

• Angle alanından açısal konumu; Offset X, Off-
set Y ve Offset Z alanlarından da doğrusal ko-
numu belirleyiniz.

• OK düğmesine basarak işlemi bitiriniz. Çalış-
manızı kaydediniz.

Görsel 3.122: Rigid Joint işlem sonucu

Uygulama: Revolute (Dönüş) Montaj İlişkisi

Dönüş montaj ilişkisinde kullanılmak üzere örnek nesneleri oluşturmak için aşağıdaki yönergeleri 
uygulayınız.
• Genişliği ve uzunluğu 50 mm, yüksekliği 10 mm bir kutu oluşturunuz.
• Kutunun ortasına Hole komutu ile 20 mm genişliğinde bir delik açınız.
• XY düzlemine 19 mm çap genişliğinde bir silindir çiziniz ve silindire 40 mm yükseklik değeri veriniz.
• Dönüş hareketini görebilmek için silindirin üst tabanında bir Sketch oluşturup 4 mm çaplı bir çember 

çiziniz.
• Extrude komutu ile yukarı yönlü 5 mm yükseklik veriniz. 
• Operation türünü Join olarak ayarlayınız.
• Unsur ağacından Body1 adını Yatak, Body2 adını Dönen Nesne olarak değiştiriniz.
• Create Companents from Bodies komutuyla nesneleri bileşen hâline getiriniz.
• Yatak bileşenini Ground olarak seçiniz ve yere sabitleyiniz. 
• Asssemble > Joint komutunu seçiniz. 
• Joint komut menüsünden Motion sekmesini seçiniz.
• Motion Type olarak Revolute (Dönüş) hareket türünü seçiniz. 
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• Component1 ve Component2 alanlarını kullanarak montaj nesnelerini seçiniz.
• Angle alanından açısal konumu; Offset X, Offset Y ve Offset Z alanlarından da doğrusal konumu 

belirleyiniz.
• Yatak ve Dönen Nesne tabanlarının aynı hizada olması için 

Joint paletinde Offset Z değerini -10 mm olarak giriniz.
• Motion sekmesinde bulunan Rotate kısmından dönüş ek-

senini belirleyiniz. 
• Animate düğmesine tıklayarak işlemin doğruluğunu kont-

rol ediniz.
• OK düğmesine basarak işlemi bitiriniz. Çalışmanızı kaydediniz.

Görsel 3.123: Revolute Joint işlem sonucu

Uygulama: Slider (Sürgü) Montaj İlişkisi

Slider, iki montaj bileşenini bir eksende doğrusal hareket yapabilecek şekilde birleştirir. Sürgü montaj 
ilişkisi için aşağıdaki yönergeleri uygulayınız.
• Daha önceki taslak uygulamasını açınız.
• Yatak bileşen nesnesine Ground özelliği veriniz.
• Asssemble > Joint komutunu seçiniz. 
• Joint komut menüsünden Motion sekmesini seçiniz. Motion Type olarak Slider (Sürgü) hareket türünü 

seçiniz.
• Joint paleti Position sekmesinden Component1 ve Component2 alanlarını kullanarak montaj nesne-

lerini seçiniz. 
• Angle alanından açısal konumu; Offset X, Offset Y 

ve Offset Z alanlarından da doğrusal konumu belir-
leyiniz. 

• Motion Type olarak Slider seçiniz. Slider alanından 
kaydırılacak aks (eksen) için -Y eksenini seçiniz. 

• Animate düğmesine tıklayarak işlemin doğruluğunu 
kontrol ediniz.

• OK düğmesine basarak işlemi bitiriniz.

Görsel 3.124: Slider Joint işlem sonucu

Uygulama: Cylindrical (Silindirik) Montaj İlişkisi

Cylindrical, iki montaj bileşenini bir eksende dairesel ve doğrusal hareket yapabilecek şekilde birleştirir. 
Silindirik montaj ilişkisi için aşağıdaki yönergeleri uygulayınız.

• Revolute montaj ilişkisi konusunda kullanılan taslak çizimleri açınız.
• Yatak bileşen nesnesine Ground özelliği veriniz.
• Asssemble > Joint komutunu seçiniz.
•  Motion Type olarak Cylindirical hareket türünü seçiniz.
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• Joint paleti Position sekmesinden Component1 ve Component2 alanlarını kullanarak montaj 
nesnelerini seçiniz.

• Parçaların monte edileceği Joint Origin noktalarını sırasıyla gösteriniz.
• Angle alanından açısal konumu; Offset X, Offset Y ve Offset Z alanlarından da doğrusal konumu 

belirleyiniz.
• Axis kısmından doğrusal ve dairesel hareketin yapılacağı mil eksenini -Z ekseni olarak belirleyiniz.
• Animate düğmesine tıklayarak işlemin doğruluğunu kontrol ediniz.
• OK düğmesine basarak işlemi bitiriniz.

Görsel 3.125: Cylindirical Joint işlem sonucu

Uygulama: Pin-Slot (Yuva-Kanal) Montaj İlişkisi

Pin-Slot, iki montaj bileşenini bir pin yuvası ve kanal ilişkisi ile birleştirir. Bir eksende dairesel, bir ek-
sende doğrusal hareket yaptırır. 

Pin-Slot montaj ilişkisi için aşağı-
daki yönergeleri uygulayınız.
• XY düzleminde genişliği ve uzunlu-

ğu 50 mm, yüksekliği 10 mm olan 
bir kutu oluşturunuz.

• Kutunun üst yüzeyine Sketch oluş-
turarak 10 mm çapında iki çember 
çiziniz. Çemberlerin alt ve üst nok-
talarından 30 mm uzunluğunda 
çemberlere teğet olacak biçimde 
iki doğru çiziniz.

Görsel 3.126: Pin Slot Joint yatak nesnesi taslağı
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• Extrude komutunu çalıştırarak oluşturulan kama yolunun 
içini boşaltınız.

• Body1 nesnesinin ismini Yatak olarak değiştiriniz.

Görsel 3.127: Pin Slot Joint yatak nesnesi 

• XY düzlemine taban çapı 9 mm, yüksekliği 40 mm olan bir silindir oluşturunuz.
• Body2 ismini Dönen Nesne olarak değiştiriniz. 
• Create Companents from Bodies komutuyla nesneleri bileşen hâline getiriniz.
• Yatak bileşen nesnesine Ground özelliği veriniz.
• Asssemble > Joint komutunu seçiniz.
• Joint komut menüsünden Motion sekmesini seçiniz. 
• Motion Type olarak Pin-Slot hareket türünü seçiniz.
• Component1 ve Component2 alanlarını kullanarak montaj nesnelerini seçiniz.
• Parçaların monte edileceği Joint Origin noktalarını sırasıyla gösteriniz.

    Görsel 3.129: Yatak parçası montaj noktası belirleme

• Angle alanından açısal konumu; Offset X, Offset Y ve Offset Z alanlarından da doğrusal konumu 
belirleyiniz. 

• Rotate kısmından dairesel hareketin yapılacağı mil eksenini -Z ekseni olarak belirleyiniz.
• Slider kısmından dairesel hareket yapılırken izlenecek yuva eksenini -X ekseni olarak belirleyiniz.
• Animate düğmesine tıklayarak işlemin doğruluğunu kontrol ediniz.
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• OK düğmesine basarak işlemi bitiriniz.

Görsel 3.130: Pin- Slot Joint işlem sonucu

Uygulama: Planar (Düzlemsel Yörünge) Montaj İlişkisi

Planar, iki montaj bileşenini bir düzlemde doğrusal hareket yapabilecek şekilde birleştirir. Hareket 
daha çok bir yörünge olarak tanımlanmalıdır. 

Düzlemsel yörünge montaj ilişkisi için aşağıdaki yönergeleri uygulayınız.
• XY düzlemine iki kutu çiziniz. Birinci kutu için 50x50x10 mm, ikinci kutu için 25x25x5 mm ebatlarını kullanınız. 
• Bu kutuları bileşen nesnesine dönüştürünüz.
• Body1 nesnesinin adını Yatak, Body2 ismini Planar Nesne olarak değiştiriniz.
• Create Companents from Bodies komutuyla nesneleri bileşen hâline getiriniz.
• Asssemble > Joint komutunu seçiniz.
• Joint komut menüsü Motion sekmesinden Planar seçimini yapınız.
• Component1 ve Component2 alanlarından montaj nesnelerini seçiniz.
• Parçaların monte edileceği Joint Origin noktalarını sırasıyla gösteriniz.
• Angle alanından açısal konumu; Offset X, Offset Y ve Offset Z alanlarından da doğrusal konumu belirleyiniz.
• Normal kısımdan hareketin yapılacağı ekseni -Z ekseni olarak belirleyiniz.
• Slider kısmından daire-

sel hareket yapılırken 
izlenecek yörünge ek-
senini -X ekseni olarak 
belirleyiniz.

• Animate düğmesine 
tıklayarak işlemin doğ-
ruluğunu kontrol edi-
niz.

• OK düğmesine basarak 
işlemi bitiriniz.

Görsel 3.131: Planar Joint işlem sonucu
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Uygulama: Ball (Küre) Montaj İlişkisi

Ball, iki montaj bileşenini bir eklem hareketi yapacak şekilde birleştirir. Hareket daha çok bir küresel 
yatak içinde gerçekleşen dirsek hareketi olarak tanımlanmalıdır.

Küre montaj ilişkisi için aşağıdaki yönergeleri uygulayınız.
• XZ düzleminde bir Sketch oluşturunuz.

Görsel 3.132: İçi boş küre taslak çizimi

• Yukarıda görüldüğü gibi daire ve doğru çiziniz.
• Trim komutu ile gerekli yerleri budayınız. 
• Offset komutu ile içeri doğru 1 mm öteleyiniz. Çizimin düzlem olması için boşta kalan daire kesitinin 

uçlarını Line komutuyla birleştiriniz. 
• Finish Sketch komutu ile çizimi sonlandırınız. 
• Revolve komutunu kullanarak çizilen düzlemi ve aks düzlemini seçiniz. Ayarları uygulayıp OK tuşuna 

basarak içi boş bir küre oluşturunuz.

Görsel 3.133: Revolve komutu ile içi boş küre oluşturma

• XZ düzleminde 18 mm çaplı bir küre çiziniz.
• XZ düzleminde yeni bir Sketch oluşturunuz ve 20 mm uzunluk, 1 mm genişliğinde bir dikdörtgen çiziniz. 

Dikdörtgenin sol alt köşesinin, içi dolu kürenin merkezinde olmasına dikkat ediniz.
• Finish Sketch komutu ile çizimi sonlandırınız.
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Görsel 3.134: Küre ve uzantısını oluşturma

• Çizilen dikdörtgensel düzlemi Create > Revolve komutuyla kendi uzun kenarı etrafında döndürerek 
Join işlemi ile küreye bağlı bir uzantı hâline getiriniz.

• Body1 nesnesinin adını Yatak, Body2 nesnesinin adını Ball Nesne olarak değiştiriniz.
• Create Companents from Bodies komutuyla nesneleri bileşen hâline getiriniz.
• Asssemble > Joint komutunu seçiniz.
• Joint komut menüsünde Motion sekmesinde yer alan Ball hareket türünü seçiniz.
• Component1 ve Component2 alanlarını kullanarak montaj nesnelerini seçiniz. Parçaların monte 

edileceği Joint Origin noktalarını gösteriniz.
• Angle alanından açısal konumu; Offset X, Offset Y ve Offset Z alanlarından da doğrusal konumu 

belirleyiniz.
• Pitch kısmından dairesel eklem hareketinin yapılacağı eklem eksenini belirleyiniz.
• Yaw kısmından bir pusula yüzeyinde yapılırken dairesel hareketin izlenecek yörünge eksenini 

belirleyiniz.
• Animate düğmesine tıklayarak işlemin doğruluğunu kontrol ediniz.
• OK düğmesine basarak işlemi bitiriniz.

Görsel 3.135: Ball Joint işlem sonucu
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Uygulama: As-Built Joint Montaj İlişkisi

Montaj bileşenleri, yapılışları açısından belli bir konumda bulunabilir veya bir alt montajda yer alabilir. 
Bir montajda yer alan parçaya montaj ilişkisi atanacağında tüm montajın bu ilişkiye uyması beklenir. Bir 
alt montaj, diğer bir alt montaja montaj ilişkisi ile bağlanacağında o alt montajın tüm konumları korunarak 
montaj oluşturulmalıdır.

As-Build Joint montaj ilişkisi için aşağıdaki yönergeleri uygulayınız.
• Asssemble > As-Built Joint komutunu seçiniz.
• Komut menüsünde Component alanı kullanılarak montaj nesnelerini seçiniz. Seçim esnasında 

parçaların monte edileceği Joint Origin noktalarını sırasıyla gösteriniz. 
• Motion alanından montaj ilişkisini oluşturacak Joint tipini seçiniz. 
• Animate düğmesine tıklayarak işlemin doğruluğunu kontrol ediniz.
• OK düğmesine basarak işlemi bitiriniz. 

3.6.3. Motion Link (Hareket Bağlantısı) Kurmak

Motion Link, iki ya da daha fazla montaj ilişkisini birbirine bağlayarak hareketi sağlamak için kullanılır. 

Uygulama: Hareket Bağlantısı Kurma

Hareket bağlantısı kurmak için aşağıdaki yönergeleri uygulayınız.
• Daha önceden oluşturduğunuz sürgü montaj ilişkisi uygulamasını açınız.
• Yatak nesnesinin yan yüzeyinde bir Sketch oluşturup 10 mm çapında bir çember çiziniz.
• Extrude komutu ile çembere 40 mm yükseklik değeri veriniz.

Görsel 3.136: Yan yüzeyde Sketch oluşturmak

• Herhangi bir düzlemde iç içe 50 mm ve 10 mm çapında iki çember çiziniz. Çemberler arasında kalan 
düzlem seçili iken Extrude komutunu çalıştırınız ve düzleme 10 mm yükseklik değeri veriniz.

• Çarkın döndüğünü görebilmek için çarkın üzerine bir çember çiziniz ve Extrude komutunu çalıştırarak 
çembere hacim kazandırınız.
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• Create Companents from Bodies komutuyla nesneleri bileşen hâline getiriniz.
• Asssemble > Joint komutunu tekrar çalıştırınız. 
• Joint komut menüsünde Motion sekmesini seçiniz. Motion Type olarak Revolute hareket türünü 

seçiniz.
• Component1 ve Component2 montaj nesnelerini seçiniz. 
• Angle alanından açısal konumu; Offset X, Offset Y ve Offset Z alanlarından da doğrusal konumu belirleyiniz.
• Joint paletinde Offset Z değerini -10 mm olarak belirleyiniz.
• Motion sekmesinde bulunan Rotate kısmından dönüş eksenini belirleyiniz.
• Flip seçimine tıklayarak parçanın konumunu değiştiriniz.
• Animate düğmesine tıklayarak işlemin doğruluğunu kontrol ediniz. 
• OK düğmesine basarak işlemi bitiriniz.
• Bileşenlere iki montaj türünü ayrı ayrı uyguladıktan sonra Asssemble > Motion Link komutunu 

çalıştırınız. Motion Link paleti açılır. 
• Çalışma sayfasında birbirine bağlanacak hareketleri seçiniz.

Görsel 3.137: Montaj işlemi sonucu

3.6.4. Contact Sets (Birleştirme Seti)

Bu araç aktif olduğunda bir bileşenin hareket aralığı boyunca karşılaşacağı müdahaleleri analiz eder. 
Contact Sets aracı yardımıyla bir bileşenin hareket aralığı kısıtlanabilir ya da tanımlanabilir.

Uygulama: Contact Sets 

Contact Sets için aşağıdaki yönergeleri uygulayınız.
• Motion Link uygulamasını açınız.
• Yatak nesnesinin her iki ucunda R kısayolu ile genişliği 70 mm, uzunluğu 10 mm olan bir dikdörtgen 

çizerek gerekli taslak çizimlerini oluşturunuz.
• Extrude komutu ile 15 mm olacak şekilde taslağı nesneye dönüştürünüz.
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Görsel 3.138: Yatak nesnesinin uçlarının kapatılması

• Çark nesnesi kendi etrafında döndürüldüğünde Kayan nesnenin kapatılan uçlardan çıkıp uzaklaşabileceği 
görülebilir.

Görsel 3.139: Yatak nesnesi ve kayan nesne

• Bu durumun önüne geçmek, Kayan nesnenin Yatak nesnesinin kapatılan uçlarına gelince durmasını 
sağlamak için Contact Set atamasını yapınız.

• Assemble > Enable Contact Sets komutu ile çalışma sayfasında Contact Sets kullanımını etkinleştiriniz. 
• Yatak bileşeni için New Contact Set komutunu çalıştırınız.
• Contact Set ilişkisi kurulacak nesneleri seçiniz ve OK tuşuna basarak Kayan nesnenin Yatak nesnesinin 

uçlarından geçmediğini görünüz.

Görsel 3.140: New Contact Set paleti

3.6.5. Motion Study (Çalışma Hareketi)

Motion Study, montaj ilişkilerine dayalı kinematik hareket analizi yapar. Eklenecek montaj ilişkileri 
seçilir, ardından hareket için noktalar ve değerler belirtilir. 
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Uygulama: Motion Study

Motion Study için aşağıdaki yönergeleri uygulayınız.
• Assemble > Motion Study komutunu seçiniz. Gelen pencerede montaj ilişkisi için Slider3 sürgüsünü 

seçiniz.

Görsel 3.141: Motion Study penceresi

• Çizgi üzerinde bir Key (Anahtar) seçiniz. Seçilen anahtarın başlangıç konumuna göre Distance değeri 
ile o mesafeyi kaç adımda (Step) alacağını belirleyiniz.

• Play (Oynat) tuşuna basarak başlangıç ile belirtilen anahtar arasındaki hareketi oynatınız.
 

3.6.6. Montajda Yeni Parça Oluşturma

Assemble > New Component komutu, montaj ortamına yeni bir parça eklemek istenildiğinde kullanılır.  

Uygulama: Montajda Yeni Parça Oluşturma

• Assemble > New Component komutunu seçiniz. İstenirse unsur ağacında en üstteki montaj ikonuna 
sağ tıklanıp New Component seçimi de yapılabilir. 

• Çizim yapılacak düzlemi seçip Sketch açınız ve çizim yapınız. Çizim sırasında montaj şeffaflaşır. Çizim 
kaydedildiğinde parça, montaja eklenmiş olur.

• Unsur ağacında kaydedilen yeni parçanın üstünde sağ taraftaki daire seçilirse diğer montaj unsurları 
şeffaflaşır ve yeniden gerekli düzenleme işlemleri yapabilir. Yapılan düzenlemeler, montaj ortamına 
otomatik olarak yansır.

Sıra Sizde 9

Sabit kısmının genişliği 20 mm, uzunluğu 90 mm, yüksekliği 3 mm olan kapı menteşesini 
oluşturunuz ve montaj ilişkilerini belirleyiniz.

Dikkat

Kaydedilen parçayı istediğiniz gibi hareket ettirebilirsiniz. Parçanın tasarlandığı yüzeyle 
bir montaj ilişkisi yoktur. Parçanın montaj ilişkisini burada yapabilirsiniz. 
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Görsel 3.142: Montaj ortamında yeni parça oluşturmak

• Oluşturduğunuz yeni parçayı üstüne çizdiğiniz parça ile ilişkilendirebilirsiniz. 

• Oluşturulan parçanın çalışma klasörünün içinde ayrıca kayıtlı olarak yer almasını isterseniz unsur 
ağacında üzerine sağ tuş tıklayıp Save Copy As seçerek ayrı bir parça kaydı yapabilirsiniz.

3.6.7. Montaja Alt Montaj Ekleme

Ana montaja eklenen montaj gruplarına alt montaj denir. Bu işlem, büyük montaj ortamlarına küçük 
montajların çağrılıp eklenmesidir. Montaj sayfasına nesneler eklenebilir veya başka bir montaj dosyası da 
parça gibi eklenebilir. Genellikle çok parçalı montajlarda montajı rahatlatmak için bu yöntem kullanılır.    

Uygulama: Montaja Alt Montaj Ekleme

Alt montaj eklemek için aşağıdaki yönergeleri uygulayınız.
• New Component seçimini yaparak montajın altında yeni bir montaj açınız. Assemble > New Component 

komutunu seçerek de aynı işlemi gerçekleştirebilirsiniz. 
• Unsur ağacında Component1:1 adında oluşan montajın altına boş bir parça eklediğinizde yeni parçanın 

doğrudan Component2:1 adını aldığını gözlemleyiniz.
• Alt montaj grubuna başka parça eklenecekse alt montajı aktifleştirmek gerekir. Bunun için sağ taraftaki 

daireyi tıklayarak alt montajı aktifleştiriniz.  
• Alt montaj aktif değilse birleştirmelerle eklenen parçaları veya delik işlemlerini genel montaja 

uygulayınız. Bunun için unsur ağacında alt montajın üzerinde iken sağ taraftaki daire seçilmelidir. 

Dikkat

Parçanın ayrıtları Project komutu ile izdüşürülerek oluşturulmuşsa o parça üzerinde 
yapılan değişiklikler, ilişkili olduğu yeni parçaya da yansır. 
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3.6.8. Edit Component (Montaj İlişkilerini Düzenleme)  

Montaj sayfasından çıkmadan parça ya da bileşenleri düzenlemek için kullanılır. Montaj ortamında 
oluşturulmuş parçalar doğrudan değiştirilebilir. Montaj, Data Panelde ilgili klasör içindeki parçalar 
sürüklenip montaj ortamına bırakılarak oluşturulmuşsa bu parçalar üzerinde değişim ancak parçanın 
üzerinde sağ tuşa basarak Open işlemi ile gerçekleştirilir. Parça üzerinde yapılan değişiklikler güncellenerek 
montaj yenilenmelidir. 

Sürükle bırak ile yerleştirilen parçalar üzerinde bulunan zincir işaretiyle (Link) parçaların ayrı bir parça 
olarak bağlandığı anlaşılmalıdır. Parça, o montaja ait bir parçaya dönüştürülecekse üzerinde sağ tuşa basarak 
Break Link komutu çalıştırılmalıdır. Bu işlem sonrasında parça, asıl parça ile olan ilişkisinden kurtulur ve o 
montaja ait hâle gelir. Üzerinde yapılan değişiklikler artık asıl (klasörde kayıtlı) parçayı etkilemez. 

Uygulama: Montaj İlişkilerini Düzenleme

• Çizim alanından ya da unsur ağacından düzenlenecek parça ya da montajı sağ taraftaki daireyi seçerek 
aktif ediniz.  

• Unsur ağacında seçilen parça olduğu gibi kalırken aktif parça dışındakiler şeffaflaşır.  
• Design sayfasında çalışıyor gibi gerekli çizim ve düzenlemeleri yapınız.  
• Parça üzerinde yapılan değişiklikler unsur ağacında bileşene ait kısma yansır. Kaydetme işlemi 

yapıldığında ise hem montaja hem de parçaya yansır.

3.6.9. Montaja Akıllı Bağlantı Elemanları Ekleme 

Add-Ins, firmalar  ya da programı hazırlayan kurumlar tarafından oluşturulan hazır parça kütüphanesidir. 
Buradan cıvata gibi standart montaj elemanları alınıp montaja yerleştirilebilir. 

Uygulama: Montaja Akıllı Bağlantı Elemanları Ekleme

Montaja akıllı bağlantı elemanları eklemek için aşağıdaki yönergeleri uygulayınız.
• Tools > Add-Ins araç çubuğundan Scripts and Add-Ins seçiniz.  Ekrana Scripts and Add-Ins diyalog 

kutusu gelir.  
• Eklenecek montaj elemanını seçiniz (örneğin bolt / cıvata). Run tuşuna basınız.
• Ekrana Create Bolt menüsü gelir. Uygun değerleri girerek cıvata oluşturunuz. 
• Solid > Insert araç çubuğundan firma bileşenlerini seçiniz. Ekranda firmanın ürünleri listelenir. 
• Mağazadan istenilen ürün seçilir, ürün adedi belirlendikten sonra ücret ödenip Companent sipariş 

edilebilir. 
• Ürünü projeye eklemek için Product Details (Ürün Detayı) bağlantısına tıklayarak ürün detay sayfasına 

gidebilirsiniz.
• Ürünün hangi dijital üretim programı için indirileceği belirlendikten sonra Save (Kaydet) tuşuna basarak 

bileşeni projeye ekleyiniz. Bileşen unsur ağacında seçili Companent altına eklenir.
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3.6.10. Show / Hidden Components (Montaj İlişkilerini Göster / Gizle) 

Show / Hidden Components, çok sayıda parçadan oluşan montajlarda seçilen parçanın görüntüsünü 
ekrandan kaldırmaya veya tekrar geri getirmeye yarar. Gerçekte nesne montajdan kaldırılmaz, sadece 
parçanın ekrandaki görünürlüğü kalkar. Show / Hidden Components komutu ile saklanan parçanın 
unsur ağacındaki göz sembolü siliktir, üzerinde sola yatık bir çizgi olur. Bu komut ile birden fazla parçanın 
ekrandaki görünürlüğü kaldırılıp geri getirilebilir.  

Uygulama: Montaj İlişkilerini Göster / Gizle

Montaj ilişkilerini göster / gizle için aşağıdaki yönergeleri uygulayınız.
• Unsur ağacından parça seçildiğinde ekrana gelen pencereden Hide Component (Bileşenleri Gizle) 

seçiniz. Parça ekrandan gizlenir.
• Tekrar görünür hâle getirmek için unsur ağacından pasif durumda olan parçayı seçiniz. 
• Açılan pencereden Show Component (Bileşenleri Göster) komutunu seçiniz.

  

Görsel 3.143: Montaj ilişkilerini göstermek / gizlemek

3.6.11. Assembly Features (Montaja Unsur Ekleme)

Assembly Features, parçalar üzerine bazı nesne unsurlarını eklemek için kullanılır. Montaj sayfasına 
montaj elemanları eklendiği zaman aktif hâle gelir. Montaja eklenen unsurlar parçaya da otomatik olarak 
yansır.
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Uygulama: Montaja Unsur Ekleme

Montaja unsur eklemek için aşağıdaki yönergeleri uygulayınız.
• Unsur ağacında en üstte yer alan montaj elemanına sağ tıklayıp New Component işaretleyiniz ya da 

Assemble > New Component tıklayınız. Unsur ağacının sonunda Component adında yeni bir unsur 
oluşur. 

• Çalışma alanından bir düzlem seçerek yeni montaj bileşeni oluşturunuz. İşlem sonrasında diğer parçalar 
şeffaflaşır ve çalışma yeni parça üzerinde gerçekleşir. 

3.6.12. Hole Wizard (Delik Sihirbazı) 

 Hole Wizard, montaj sayfasında iken montaj 
parçaları üzerinde belirlenen noktalardan hızlı delik 
açmak için kullanılır. Bu komutla montaj parçaları 
üzerine açılan delikler, parçanın modeline de yansır 
ve unsur ağacına delik unsuru eklenir. Delme işlemi, 
montajı oluşturan parçalara denk gelirse bu parçala-
rın tümünde delik boyu kadar delik açılmış olur.

 

            Görsel 3.144: Delik sihirbazı ile delik açma

Uygulama: Hole Wizard (Delik Sihirbazı) 

Delik sihirbazı için aşağıdaki yönergeleri uygulayınız.
• Create > Hole komutunu seçiniz.
• Ekrana gelen menüde Placement bölümünden At Point (Single Hole) seçimi yapınız. Parça üzerinde 

deliklerin açılacağı katı yüzeyi (Face / Point) seçiniz. 
• Hole Type kısmından delik tipini seçiniz.
• Depth ve Diameter kısmından delik ölçülerini, Tip Angle kısmından da matkap uç açısını giriniz.
• Delik boyu ve yönünü belirleyiniz. 
• OK tuşu ile delme işlemini tamamlayınız.  

Uygulama: Delik Dizisi

Delik dizisi için aşağıdaki yönergeleri uygulayınız.
• Create > Hole komutunu seçiniz. 
• Ekrana gelen menüde Placement bölümünden From Sketch (Multiple Hole) seçimini yapınız. Parça 

üzerinde deliklerin açılacağı katı yüzeyi (Face / Point) seçiniz ve birden çok delik için taslaktaki ayrıt 
veya noktaları sırasıyla seçiniz. 

• Hole Type kısmından delik tipini seçiniz. 
• Depth ve Diameter kısmından delik ölçülerini, Tip Angle kısmından da matkap uç açısını giriniz. 
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• Delik boyu ve yönünü belirleyi-
niz. 

• OK tuşu ile delme işlemini 
gerçekleştiriniz.

Görsel 3.145: Delik dizisi

3.7. Tasarlanan Modelin Üç Boyutlu Baskısını Alma
Dijital üretim programında hazırlanan modellerin baskısı, dilimleme programları ve üç boyutlu yazıcılar 

aracılığıyla alınabilir.
3.7.1. Slicing (Dilimleme) Programı

Dilimleme programı, belirlenen parametrelere göre modeli katlara bölen ve yazıcı için yapacağı her 
işlemi tarif eden bir komut kümesi oluşturur. Bu komutlara G-code adı verilir. G-code temel olarak üç boyutlu 
yazıcının X-Y-Z koordinatlarını, nozzle (ağızlık) sıcaklığını, tabla sıcaklığını ve soğutma fanı çalışmasını içerir. 
G-code komutları CNC cihazlar için standarttır. CNC cihazların büyük bölümü G-code komutları ile çalışır. 

Dilimleme yazılımının oluşturduğu G-codelar üç boyutlu yazıcıya hafıza kartı ya da USB bağlantısı 
üzerinden seri iletişimle gönderilir.

Üç boyutlu tasarım (CAD) programları aracılığıyla çizilen üç boyutlu nesnelerin üç boyutlu yazıcılar 
tarafından baskı yapabilmesi için dilimleme programlarınca tanınan dosya formatıyla dışa aktarılması 
gereklidir.

Uygulama: Tasarımı Üç Boyutlu Yazıcıya Aktarma

Tasarımı üç boyutlu yazıcıya aktarmak için aşağıdaki yönergeleri uygulayınız.

• Dijital üretim programını açınız. Daha önce oluşturduğunuz üç boyutlu MEB yazı nesnesini açınız.
• File > 3D Print komutunu 

açınız. 
• Selection olarak dilimleme 

programı için tüm nesneyi 
seçiniz. 

• Preview Mesh seçerek 
mesh yapısının görünmesi-
ni sağlayınız.

Görsel 3.146: Mesh yapısı görüntüsü

Dikkat

Dilimleme programları genel olarak  STL, OBJ veya 3MF dosya formatlarını tanımaktadır.
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• Refinement olarak baskı kalitesine uygun seçeneği işaretleyiniz.
• Refinement Options kısmından istenirse daha detaylı ayarlar yapılabilir.
• Output özelliklerinden Send to 3D Utility seçeneğini kaldırınız ve .stl uzantılı dilimleme programı için 

kaydediniz.
• Bilgisayarınızda bir dilimleme programı yüklüyse Send to 3D Utility seçeneğini kaldırmayınız. Application 

bölümünden dilimleme programını seçerek doğrudan dilimleme programına gönderebilirsiniz.

3.7.2. Dilimleme Programı Yardımıyla Üç Boyutlu Baskı Alma

Kurulum tamamlandıktan sonra model, dilimleme yazılımı ile açılarak üç boyutlu yazıcıya gönderilebilir.

Uygulama: Dilimleme Programı Yardımıyla 

Üç Boyutlu Baskı Alma

Dilimleme programı yardımıyla üç boyutlu baskı almak için aşağıdaki yönergeleri uygulayınız.
• Üç boyutlu baskısı alınacak dosyayı açınız.
• Baskı alınacak nesneyi uygun şekilde tablaya yerleştiriniz. Gerekirse nesneyi döndürme ve taşıma 

işlemi yapabilirsiniz.
• Konfigürasyon panelinden kullanılacak malzeme (filament) ve renk gibi ayarları seçiniz.
• Yazdırma Ayarları panelinden baskı için gerekli ayarları yapınız.
• Gerekli ayarları yaptıktan sonra Dilimle düğmesine tıklayınız. 

Görsel 3.147: Dilimleme yazılımı

• Üç boyutlu yazıcıya göndermek için G-code dosyasını kaydediniz.
• Modele ait G-code dosyasını yazıcıda çalıştırarak yazdırma işlemini başlatınız.

http://kitap.eba.gov.tr/KodSor.
php?KOD=21382
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Aşağıdaki soruları dikkatle okuyarak doğru seçeneği işaretleyiniz.

1. Tasarım çizgisi çizmek için aşağıdaki komutlardan hangisi kullanılır?

A) Control Point Spline     B) Construction Line C) Spline

                     D) Fit Spline E) Line

2. Taslak çizim oluşturmak için aşağıdaki hangi komut kullanılmaktadır?

A) Exit Sketch B) 3D Sketch C) Sketch Xpert

           D) Sketch                          E) Finish Sketch

3. Yatay çizgi çizmek için aşağıdaki Sketch Palette komutlarından hangisi kullanılmalıdır?  

A) As Sketched B) Parallel C) Coincident

               D)  Vertical / Horizontal                                E) Angle

4. Aşağıdakilerden hangisinde Polygon (Çokgen) komutu ile çizilen en az kenar sayısı verilmiştir?
 
A) 3 B) 4 C) 5

D)  6 E) 8

5. Nesne köşelerine kavis vermek için aşağıdaki hangi komut kullanılır?  

A) Fillet B) Ellipse C) Extend

D)  Trim E) Chamfer

6. Aşağıdaki komutlardan hangisi uzantıları kesiştirmek için kullanılır?

A) Trim B) Extend C) Corner 

D) Closest E) Node

Ölçme ve Değerlendirme
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7. Nesnelerin yüzeyler ya da düzlemler üzerine izdüşümünün alınması için aşağıdaki hangi komut  
kullanılır?

A) Intersection B) Offset C) Project  

                   D) Entities                              E) Chain Selection

8. Aşağıdaki komutlardan hangisi bir eksen etrafında dairesel çoğaltma yapar?

A) Circular Pattern B) Sketch Pattern C) Linear Pattern  

                        D) Stretch Pattern                             E) Pattern on Path

9. Aşağıdaki geometrik ilişkilerden hangisi seçilen nesneleri eş merkezli hâle getirir?

A) Collinear B) Concentric C) Coincident  

D) Equal E) Parallel

10.  Aşağıdaki nesne kenetleme komutlarından hangisi seçilen öbür nesneye dik olan noktadan  
yakalar?

A) Quadrant B) Nearest C) Perpendicular 

           D) Intersection E) Tangent

11.  Sketch ortamında oluşturduğunuz bir çizimi belirli bir eksen etrafında döndürerek nesne 
oluşturmak için aşağıdaki komutlardan hangisi kullanılır?

A) Extrude B) Revolve C) Loft 

D) Sweep E) Web

12.  Farklı düzlemler üzerinde çizilmiş profiller arasına malzeme atayarak nesne oluşturan komut 
aşağıdakilerden hangisidir?

A) Revolve B) Web C) Sweep 

D) Extrude E)  Loft 
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13.  Nesneleri taşımak için aşağıdaki hangi kısayol tuşu kullanılır?

A) C B) D C) M 

D) F E) K

14. Cıvatanın dişlerini oluşturmak için aşağıdaki komutlardan hangisi kullanılır?

A) Threat ve Coil B) Extrude ve Spline C) Hole  

    D) Loft ve Cut E) Web ve Rib

15. Circular Pattern komutunun kullanım amacı aşağıdakilerden hangisidir?

A) Nesnenin dairesel olarak çıkarılması   
B) Nesnenin doğrusal olarak çıkarılması 
C) Nesnenin dairesel olarak çoğaltılması   
D) Nesnenin doğrusal olarak çoğaltılması 
E) Nesnenin aynalanması

16. Payandalar aşağıdaki hangi komut kullanılarak çizilir?

A) Shell B) Revolve C) Draft  

D) Hole E) Rib

17. Belirli bir yol üzerinde çizimin süpürülmesiyle model oluşturmak için kullanılan komut 
aşağıdakilerden hangisidir?

A) Revolve B) Sweep C) Web

D) Loft E) Coil

18.  Hole komutunun görevi aşağıdakilerden hangisidir?

A) Çizim alanı temizler. B) Nesnelerin özelliklerini değiştirir. C) Çizimleri silerek ortadan kaldırır.

D) Nesnelerin üzerinde delik açar. E) Nesnelere vida dişi açar.

19.  Yüzeye paralel yeni bir düzlem oluşturmak için hangi komut kullanılır? 

A) Point  B) Horizantal  C) Move

D) Offset Plane E) Split
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20. Yuvarlatma işleminde kullanılan Variable Radius anlamı aşağıdakilerden hangisidir? 

A) Değişken yarıçaplı yuvarlatma B) Değişken pah kırma C)Kavis oluşturma

                                  D) Yarıçaplı yuvarlatma        E) Değişken yarıçaplı vidalama

21. Montaj sayfası ve yeni parça oluşturulması için programın açılışında aşağıda verilen hangi 
komutun kullanılması gerekir?

A) Motion Link B) New Component  C) New

        D) Drawing E) Motion Link

22. Montaj sayfasına klasördeki bir parçayı eklemek için aşağıda verilen hangi işlem uygulanmalıdır?

A) Edit Component komutu ile parça eklenmelidir.
B) Move Component komutu ile parça taşınmalıdır.
C) Rotate Component komutu ile parça dönüştürülmelidir.
D) Data Panelden parça sürüklenerek montaj ortamına bırakılmalıdır.
E) Gövde, Split Body komutu ile parçalara bölünmelidir.

23. Seçilen silindirik parçaları ortak merkezli hâle getirmek için aşağıda verilen hangi eşleştirme 
komutu kullanılır?

A) Cylindirical B)  Parallel C) Width

       D) Coincident E) Revolute

24. Aşağıda verilen parça ilişkilendirmelerinden hangisi standart ilişkilerden değildir?

A) Revolute B) Rigid C) Cylindirical

D) Pin-Slot                E) Width

25. Aşağıda verilen gelişmiş montaj ilişkilerinden hangisi çoklu parçalara montaj ilişkisi 
vermek için kullanılır?

A) Revolute B) Path Mate C) As-Built Joint

  D) Angle          E) Joint Origin
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26. Aşağıdaki mekanik montajlardan hangisi silindirik parçalara dönme ilişkisi verir?

A) Hinge B) Rack Pinion C) Gear

D) Contact Sets                               E) Revolute

27. Bir eksen etrafında küresel hareket sağlayan mafsal gibi parçaları birleştirmek için hangi yöntem 
kullanılır?

A) Ball B) Gear C) Rack Pinion

D) Screw                                E) Pin

28. Montaj sırasında parçalara montaj ilişki merkezi eklemek için aşağıdaki hangi komut kullanılır?

A) New Part B) Copy With Mates                                 C) Edit Component

D) Joint Origin                  E) Motion Study

29. Montaj sayfasından çıkmadan parça ya da bileşenleri düzenlemek için aşağıda verilen 
komutlardan hangisi kullanılır?

A) Rotate Component B) Linear Component Pattern C) Edit Component

      D) Circular Component Pattern                         E) Revolute Cut

30. Aşağıdakilerden hangisi Add-Ins kütüphanesinde hazır bulunan birleştirme elemanlarını otomatik 
olarak montaja ekler?

A) Bill of Materials B) Assembly Features C) Show / Hidden Components

                                  D) Ground    E) Script and Add ins

Aşağıdaki cümleleri dikkatle okuyarak boş bırakılan yerlere doğru sözcükleri yazınız.

31. Chamfer komutu nesnelerin ……………………………………………....... için kullanılır.

32. Draft komutu model üzerinde seçilen bir veya birden fazla yüzeye …………………………………………….......... 
için kullanılır.

33. Nesneleri hizalamak için …................................. komutu kullanılır.

34. Oluşturulan bir nesneye et kalınlığı vermek …................................. komutu kullanılır.

35. Split komutu nesneleri ……………………………………………………………………  için kullanılır.
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1. D Cevabınız yanlış ise Çizgi Çeşitleri ve Çizgilerin Kullanıldığı Yerler konusunu gözden geçiriniz.

2. C Cevabınız yanlış ise Teknik Resimde Kullanılan Araç Gereçler konusunu gözden geçiriniz.

3. A Cevabınız yanlış ise Standart Yazı Tipleri ve Norm Yazı konusunu gözden geçiriniz.

4. E Cevabınız yanlış ise Teknik Resimde Kullanılan Araç Gereçler konusunu gözden geçiriniz.

5. B Cevabınız yanlış ise Standart Kâğıt Ölçüleri konusunu gözden geçiriniz.

6. C Cevabınız yanlış ise Doğru Çizimi konusunu gözden geçiriniz.

7. A Cevabınız yanlış ise İzdüşüm Tanımı ve Sınıflandırılması konusunu gözden geçiriniz.

8. C Cevabınız yanlış ise İzdüşüm Tanımı ve Sınıflandırılması konusunu gözden geçiriniz.

9. D Cevabınız yanlış ise İzdüşüm Tanımı ve Sınıflandırılması konusunu gözden geçiriniz.

10. E Cevabınız yanlış ise Noktanın İzdüşümü konusunu gözden geçiriniz.

11. A Cevabınız yanlış ise İzdüşüm Düzlemleri konusunu gözden geçiriniz.

12. A Cevabınız yanlış ise Noktanın İzdüşümü konusunu gözden geçiriniz.

13. B Cevabınız yanlış ise Ölçeklendirme konusunu gözden geçiriniz.

14. B Cevabınız yanlış ise Ölçekler konusunu gözden geçiriniz.

15. C Cevabınız yanlış ise Ölçekler konusunu gözden geçiriniz.

CEVAP ANAHTARI

Sıra Sizde Cevap Anahtarları

1. ÖĞRENME BİRİMİ / TEMEL TEKNİK RESİM

Sıra Sizde 1
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Sıra Sizde 2

Sıra Sizde 3

Sıra Sizde 4
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Sıra Sizde 5

Sıra Sizde 6

Sıra Sizde 7
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1. B Cevabınız yanlış ise Temel İşlem Kontrolleri konusunu gözden geçiriniz.

2. B Cevabınız yanlış ise Görünüm Kontrolleri konusunu gözden geçiriniz.

3. C Cevabınız yanlış ise Görünüm Kontrolleri konusunu gözden geçiriniz.

4. D Cevabınız yanlış ise Gruplama konusunu gözden geçiriniz.

5. C Cevabınız yanlış ise Hizalama konusunu gözden geçiriniz.

6. D Cevabınız yanlış ise İçe Aktar konusunu gözden geçiriniz.

7. D Cevabınız yanlış ise Dışa Aktar konusunu gözden geçiriniz.

8. A Cevabınız yanlış ise Görünüm Kontrolleri konusunu gözden geçiriniz.

9. B Cevabınız yanlış ise Üç Boyutlu Yazıcılarda Tasarımı Yazdırma konusunu gözden 
geçiriniz.

10. C Cevabınız yanlış ise Üç Boyutlu Yazıcılarda Tasarımı Yazdırma konusunu gözden 
geçiriniz.

İkinci Tasarım adında yeni bir tasarım oluşturmak için aşağıdaki yönergeleri uygulayınız.
• Yeni bir tasarım oluşturunuz.
• Çizim programının tasarım için verdiği ismi değiştirmek için tasarım ismini tıklayınız.
• Tasarımın adını İkinci Tasarım olarak değiştiriniz.

Ana sayfaya dönerek önceden oluşturduğunuz başka bir tasarımı açmak için aşağıdaki yönergeleri 
izleyiniz.

• Uygulamanız açıkken son tasarımlar düğmesine tıklayınız.

Ölçme ve Değerlendirme Cevap Anahtarı

2. ÖĞRENME BİRİMİ / BİLGİSAYARLI ÇİZİM

Sıra Sizde Cevap Anahtarları

Sıra Sizde 1

Sıra Sizde 2



175CEVAP ANAHTARI

• İstediğiniz uygulamayı seçiniz ve Bunu düzenle düğmesine tıklayınız.

Silindir üzerinde temel işlemleri yapmak için aşağıdaki yönergeleri takip ediniz.
• Yeni bir tasarım oluşturunuz.
• Tasarımın adını Sıra Sizde 3 olarak değiştiriniz.
• Çalışma düzlemine bir silindir ekleyiniz.
• Silindirin yüksekliğini 15 mm olarak ölçeklendiriniz.
• Silindirin çapını 35 mm olarak ölçeklendiriniz.

• Silindiri çalışma alanının sol üst köşesine taşıyınız.
• Silindiri 15 mm yukarı kaldırınız.
• Silindiri 30 derece döndürünüz.

Sıra Sizde 3
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Çikolata tasarımını farklı şekillerle yapmak için aşağıdaki yönergeleri uygulayınız.
• Yeni bir tasarım oluşturunuz.
• Tasarımın adını Sıra Sizde 4 olarak değiştiriniz.
• Çalışma düzlemine bir kutu ekleyiniz.
• Kutunun yüksekliğini 5 mm olarak ölçeklendiriniz.
• Kutunun enini ve boyunu 100x100 mm olarak ölçeklendiriniz.

• Çalışma düzlemine bir piramit  ekleyiniz.
• Piramidi 5 mm yükseltiniz.
• Piramidin yüksekliğini 10 mm olarak ölçeklendiriniz.
• Piramidi Duplicate  and repeat (Ctrl+D) düğmesi ile 5 adet yan yana şekilde çoğaltınız.
• Piramit şekillerini Gruplandır (Ctrl+G) düğmesi ile gruplandırınız.
• Piramit grubu ile kutu şeklini sol alt köşede hizalayınız.

Sıra Sizde 4
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• Piramit grubunu Duplicate  and repeat (Ctrl+D) düğmesi ile çoğaltınız.
• Yeni piramit grupları ile çikolata zemininin yüzeyini kaplayınız.

• Bütün şekilleri Gruplandır (Ctrl+G) düğmesi ile gruplandırınız.
• Çalışma düzlemine bir kutu ekleyiniz.
• Kutunun enini ve boyunu 100x100 mm olarak ölçeklendiriniz.
• Kutuyu 10 mm yükseltiniz.
• Kutunun özelliğini Delik olarak değiştiriniz.
• Kutuyu ve şekil grubunu sol alt köşeden hizalayınız.

• Tüm şekilleri gruplandırınız.
• Şeklin rengini özelliklerden kahverengi olarak değiştiriniz.
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Kalemlik tasarımında yıldız şekillerini artırmak için aşağıdaki yönergeleri uygulayınız.
• Kalemlik Yapımı uygulamasını açınız.
• Yıldızları seçiniz ve gruplandırınız. 
• Yıldız grubunu çoğaltınız.
• Yeni yıldız grubunu 10 mm yükseltiniz.
• Yıldız grubunu 22,5 derece döndürünüz.

• Yıldız grubunu tekrar çoğaltınız.
• Yeni yıldız grubunu 10 mm yükseltiniz.
• Yıldız grubunu 22,5 derece döndürünüz.
• Yıldız grubunu tekrar çoğaltınız.
• Yeni yıldız grubunu 10 mm daha yükseltiniz. 
• Yıldız grubunu 22,5 derece döndürünüz.
• Yazı üzerine gelen yıldızı, yıldız grubunu çözerek taşıyınız.

• Tüm şekilleri gruplandırınız.

Sıra Sizde 5
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Kalemlik tasarımında yıldız şekillerini artırmak için aşağıdaki yönergeleri uygulayınız.
• Kalemlik Yapımı uygulamasını açınız.
• Yıldızları seçiniz ve gruplandırınız. 
• Yıldız grubunu çoğaltınız.
• Yeni yıldız grubunu 10 mm yükseltiniz.
• Yıldız grubunu 22,5 derece döndürünüz.

• Yıldız grubunu tekrar çoğaltınız.
• Yeni yıldız grubunu 10 mm yükseltiniz.
• Yıldız grubunu 22,5 derece döndürünüz.
• Yıldız grubunu tekrar çoğaltınız.
• Yeni yıldız grubunu 10 mm daha yükseltiniz. 
• Yıldız grubunu 22,5 derece döndürünüz.
• Yazı üzerine gelen yıldızı, yıldız grubunu çözerek taşıyınız.

• Tüm şekilleri gruplandırınız.

Piyon tasarımını kale taşına dönüştürmek için aşağıdaki yönergeleri takip ediniz.
• Piyon Yapımı tasarımını açınız.
• Piyon tasarımını seçiniz ve Kopyala (Ctrl+C) düğmesine tıklayınız.
• Son tasarımlar düğmesine tıklayınız ve yeni bir tasarım oluşturunuz.
• Tasarımın adını Kale Yapımı olarak değiştiriniz.
• Yapıştır (Ctrl+V) düğmesi ile piyon tasarımını yeni tasarıma aktarınız.
• Şekli seçiniz ve grubu çözünüz.
• En üsteki küre şeklini siliniz.

• Bir Çalışma Düzlemini koninin üstüne sürükleyiniz.
• Çalışma düzlemine bir silindir ekleyiniz.
• Silindirin yüksekliğini 10 mm olarak ölçeklendiriniz.
• Silindirin çapını 12 mm olarak ölçeklendiriniz.
• Çalışma düzlemine bir kutu ekleyiniz.
• Kutunun enini ve boyunu 20x3 mm olarak ölçeklendiriniz.
• Kutuyu 8 mm yükseltiniz.
• Silindir ve kutuyu merkezden hizalayınız.

Sıra Sizde 6
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• Kutuyu çoğaltınız.
• Kutuyu 90 derece döndürünüz.
• Silindir ve kutuları gruplandırınız.
• Kale başlığını gövde üzerine taşıyınız.
• Bir Çalışma Düzlemini şeklin dışında bir alana sürükleyerek çalışma düzlemini orijinal konumuna 

getiriniz. 
• Tüm şekilleri seçerek merkezden hizalayınız.
• Tüm şekilleri gruplandırınız.
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1. E Cevabınız yanlış ise Taslak Çizim Komutları konusunu gözden geçiriniz.

2. D Cevabınız yanlış ise Taslak Çizim Komutları konusunu gözden geçiriniz.

3. D Cevabınız yanlış ise Kısıtlamalar konusunu gözden geçiriniz.

4. A Cevabınız yanlış ise Çokgenler konusunu gözden geçiriniz.

5. A Cevabınız yanlış ise Fillet konusunu gözden geçiriniz.

6. B Cevabınız yanlış ise Extend konusunu gözden geçiriniz.

7. C Cevabınız yanlış ise Project konusunu gözden geçiriniz.

8. A Cevabınız yanlış ise Çoğaltma konusunu gözden geçiriniz.

9. B Cevabınız yanlış ise Kısıtlamalar konusunu gözden geçiriniz.

10. C Cevabınız yanlış ise Kısıtlamalar konusunu gözden geçiriniz.

11. B Cevabınız yanlış ise Döndürerek Nesne Oluşturma konusunu gözden geçiriniz.

12. E Cevabınız yanlış ise Döndürerek Nesne Oluşturma konusunu gözden geçiriniz.

13. C Cevabınız yanlış ise Profil Nesnelerini Çoğaltma konusunu gözden geçiriniz.

14. A Cevabınız yanlış ise Nesneden Başka Bir Nesne Çıkarma konusunu gözden geçiriniz.

15. C Cevabınız yanlış ise Profil Nesnelerini Çoğaltma konusunu gözden geçiriniz.

16. E Cevabınız yanlış ise Destek Elemanı Oluşturma konusunu gözden geçiriniz.

17. B Cevabınız yanlış ise Döndürerek Nesne Oluşturma konusunu gözden geçiriniz.

18. D Cevabınız yanlış ise Nesneden Başka Bir Nesne Çıkarma konusunu gözden geçiriniz.

19. D Cevabınız yanlış ise Düzenleme Komutlarıyla Nesneler Oluşturma konusunu gözden 
geçiriniz.

20. A Cevabınız yanlış ise Düzenleme Komutlarıyla Nesneler Oluşturma konusunu gözden 
geçiriniz.

21. B Cevabınız yanlış ise Montajda Yeni Parça Oluşturma konusunu gözden geçiriniz.

22. D Cevabınız yanlış ise Edit Companent konusunu gözden geçiriniz.

23. A Cevabınız yanlış ise Joints konusunu gözden geçiriniz.

24. E Cevabınız yanlış ise Joints konusunu gözden geçiriniz.

25. C Cevabınız yanlış ise As Built Joint konusunu gözden geçiriniz.

26. E Cevabınız yanlış ise Joints konusunu gözden geçiriniz.

27. A Cevabınız yanlış ise Joints konusunu gözden geçiriniz.

28. D Cevabınız yanlış ise Joints konusunu gözden geçiriniz.

29. C Cevabınız yanlış ise Edit Companent konusunu gözden geçiriniz.

30. E Cevabınız yanlış ise Montaja Akıllı Bağlantı Elemanları Ekleme konusunu gözden 
geçiriniz.

Ölçme ve Değerlendirme Cevap Anahtarı

3. ÖĞRENME BİRİMİ / DİJİTAL ÜRETİM
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31.
kenar ya da 
köşelerine pah 
kırmak için

Cevabınız yanlış ise Nesneden Başka Bir Nesne Çıkarma konusunu gözden geçiriniz.

32. istenilen açıda 
eğim vermek

Cevabınız yanlış ise Düzenleme Komutlarıyla Nesneler Oluşturma konusunu gözden 
geçiriniz.

33. Align Cevabınız yanlış ise Düzenleme Komutlarıyla Nesneler Oluşturma konusunu gözden 
geçiriniz.

34. Shell Cevabınız yanlış ise Düzenleme Komutlarıyla Nesneler Oluşturma konusunu gözden 
geçiriniz.

35. bölerek 
parçalara 
ayırmak

Cevabınız yanlış ise Düzenleme Komutlarıyla Nesneler Oluşturma konusunu gözden 
geçiriniz.

• XY düzlemde bir taslak oluşturunuz.
• -X, –Y eksenleri ve orijinden geçen Construction Line (Yardımcı Geometri Çizgisi) çiziniz.
• Orijin noktasını merkez kabul eden ve çapı 131,2 mm olan bir çember çiziniz.
• Orijin noktası ile yatay doğrultuda (Horizontal / Vertical kısıtlamasını kullanınız.) ve 10 mm solunda 

(Sketch Dimension komutunu kullanınız.), çapı 168,2 mm olan bir çember çiziniz.
• Çember çizimlerinin sağ tarafında ve çemberlerin arasında kalan bölgeye orijin noktası ile yatay 

doğrultuda, çemberler ile teğet,  8,5 mm çapında bir çember çiziniz (2-Points Circle komutunu kullanmak 
daha işlevsel olacaktır.). 

• Orijin noktasının 185 mm solunda ve orijin ile yatay doğrultuda, çapları sırasıyla 12 mm ve 32 mm olan 
eş merkezli iki çember çiziniz.

• 3-Point Arc komutunu kullanarak 32 mm çaplı çember ile 168,2 mm çaplı çember arasında, çemberlere 
teğet, 108 mm yarıçaplı yay çiziniz.

• 3-Point Arc komutunu kullanarak 32 mm çaplı çember ile 131,2 mm çaplı çember arasında, çemberlere 
teğet, 145 mm yarıçaplı yay çiziniz.

• Trim komutu ile gerekli budamaları yapınız.
• Çalışmanızı bulut ortamında kaydediniz ya da File > Export komutu ile istediğiniz dizine çıkartınız.  

Sıra Sizde 1

Sıra Sizde Cevap Anahtarları
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• XY düzlemde bir taslak oluşturunuz.
• -X, –Y eksenlerinden ve orijinden geçen Construction Line çiziniz.
• Sol alt köşesi orijin noktasında olan 40 mm uzunluğunda, 95 mm genişliğinde bir dikdörtgen çiziniz. 
• Çizilen dikdörtgenin içine 10 mm uzunluğunda, 75 mm genişliğinde bir dikdörtgen daha çiziniz.
• Çizilen ikinci dikdörtgenin 75 mm’lik uzun kenarının ilk çizilen dikdörtgenin 95 mm olan uzun kenarına 

uzaklığını Skecth Dimension komutu ile 10 mm olarak ayarlayınız.

• Çizilen ikinci dikdörtgenin 10 mm’lik olan kısa kenarlarının ilk çizilen 
dikdörtgenin 40 mm olan kısa kenarlarına uzaklığını Skecth Dimension 
komutu ile 10 mm olarak ayarlayınız.

• Büyük dikdörtgenin uzun kenarının orta noktasından geçecek biçimde 
uzunca bir çizgi çiziniz ve çizgiyi X kısayol tuşuna basarak yardımcı 
geometri hâline dönüştürünüz.

• Büyük dikdörtgenin uzun kenarının orta noktasından 20 mm yukarıda, 
çapı 20 mm olan bir çember çiziniz.

• Büyük dikdörtgenin uzun kenarının orta noktasından 100 mm 
yukarıda, çapı 40 mm ve 80 mm olan eş merkezli iki çember çiziniz.

• 3-Points Arc komutu ile 20 mm ve 40 mm çaplı çemberler arasında, 
çemberlere teğet ve yarıçap ölçüsü 75 mm olan bir yay çiziniz.

Sıra Sizde 2
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• 3-Points Arc komutu ile 80 mm çaplı, 
dikdörtgenin sağ üst köşesi arasında, 
çembere teğet ve yarıçap ölçüsü 115 mm 
olan bir yay çiziniz.

• Mirror komutunu çalıştırınız. Aynalanacak 
ögeler olarak yay nesnelerini, aynalama 
çizgisi olarak büyük dikdörtgenin uzun 
kenarının orta noktasından geçen kesik 
çizgiyi seçiniz. 

• Trim komutu ile gerekli budamaları 
yapınız. Büyük dikdörtgenin uzun 
kenarının alt köşelerine Fillet komutu ile 
10 mm yarıçapında kavis veriniz.

• Çalışmanızı bulut ortamında kaydediniz ya 
da File > Export komutu ile istediğiniz dizine çıkartınız.  

• XY düzlemde bir taslak oluşturunuz.
• -X, –Y eksenlerinden ve orijinden geçen Construction Line çiziniz.
• Orijin noktasına çapları sırasıyla 30 mm ve 70 mm olan eş merkezli iki çember çiziniz. Orijin noktası ile 

yatay doğrultuda, orijin noktasının 92 mm solunda, 50 mm çaplı bir çember çiziniz.

Sıra Sizde 3
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• 3-Points Arc komutu ile A ve B noktalarından geçen ve çemberlere teğet olan bir yay çiziniz. Sketch 
Dimension komutu ile yayın yarıçap ölçüsünü 92 mm olarak belirleyiniz. 

• 3-Points Arc komutu ile C ve D noktalarından geçen ve çemberlere teğet olan bir yay çiziniz. Sketch 
Dimension komutu ile yayın yarıçap ölçüsünü 185 mm olarak belirleyiniz. 

• Trim komutu ile 50 mm çapındaki dairenin içeride kalan kısmını budayınız. 

• Offset komutu ile içeri doğru 11 mm öteleyerek çoğaltma işlemini gerçekleştiriniz. 

• Trim  komutu ile gerekli budamaları yapınız. Fillet komutu ile E ve F noktalarına 6 mm yarıçapında kavis 
işlemi uygulayınız.

• Çalışmanızı bulut ortamında kaydediniz ya da File > Export komutu ile istediğiniz dizine çıkartınız. 
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• XY düzlemde bir taslak oluşturunuz.
• -X, –Y eksenlerinden ve orijinden geçen Construction Line  çiziniz.
• Orijin noktasına çapları sırasıyla 20 mm ve 48 mm olan iki çember çiziniz.
• Orijin noktasından 30 mm yukarıda ve 21 mm solda bulunan noktada (A noktası) 20 mm çaplı çember 

çiziniz. 
• Circle komutunu çalıştırınız. Çember çizmeden önce yakalama doğruları ile 20 mm çaplı çemberin alt 

noktasında (B noktası) 48 mm çaplı bir çember çiziniz.
• Line  komutunu çalıştırınız. Çizgiyi çizmeden önce yakalama doğruları ile çemberin üzerindeki noktadan 

(C noktası) yukarı yönlü dik bir çizgi çiziniz.
• -Y eksenindeki yardımcı geometri çizgisi üzerinde 90 mm çaplı bir çember çiziniz. Bu çember ile B noktası 

merkezli, 48 mm çaplı çemberi Tangent kısıtlaması ile teğet hâle getiriniz.

• D noktasından yukarı yönlü dik bir çizgi çiziniz. Çizilen çizginin bitiş noktasının orijin noktasına olan 
uzaklığını Sketch Dimension komutu ile 83 mm olarak ayarlayınız.

• E noktasından –Y eksenine dik bir çizgi çiziniz. Yine E noktasından yukarı yönlü dik bir çizgi çiziniz. Çizginin 
ölçüsünü 67 mm olarak ayarlayınız.

Sıra Sizde 4
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• F noktasından –Y eksenine, ekseni dik kesecek biçimde bir 
çizgi çiziniz. Yine F noktasından uzunluğu 2 mm, açı değeri 1350 

olan bir çizgi çiziniz. Çizilen çizginin ucundan –Y eksenine dik 
bir çizgi çiziniz.

• Resimde mavi renkle seçili olan alan içine çapı 8 mm 
uzunluğunda bir çember çiziniz. Çizilen çemberi, C noktasından 
yukarı yönlü çizilen doğru ve merkezi –Y ekseninde olan 90 
mm çapındaki çember ile teğet hâle getiriniz.

• G ve H noktalarından geçen ve çemberlere teğet olan bir çizgi 
çiziniz. Gerekli budamaları Trim komutu ile yapınız.

• Mirror komutunu çalıştırınız. Aynalanacak nesneleri seçiniz. 
Aynalama doğrusu olarak -Y eksenini seçiniz.

• Çalışmanızı bulut ortamında kaydediniz ya da File > Export 
komutu ile istediğiniz dizine çıkartınız.  

v

• XY düzlemde bir taslak oluşturunuz.
• -X, –Y eksenlerinden ve orijinden geçen Construction Line çiziniz.
• Orijin noktasını merkez kabul eden, çapları sırasıyla 40 mm, 50 mm ve 70 mm olan üç çember çiziniz.
• Orijin noktasından başlayarak -Y ekseninde, yukarı yönlü, 25 mm uzunluğunda bir çizgi çiziniz.
• Circular Pattern komutunu çalıştırınız. Çoğaltılacak nesne olarak 25 mm uzunluğundaki çizgiyi, merkez 

nokta olarak da orijin noktasını seçiniz. Çoğaltma adedini 12 olarak belirleyiniz. Trim komutu ile gerekli 
budamaları yapınız.

Sıra Sizde 5
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• Orijin noktasının 46 mm solunda ve 26,80 mm 
yukarısında bulunan noktada 10 mm ve 30 mm 
çaplı iki çember çiziniz. 

• -Y ekseni üstünde, orijin noktasının 85 mm 
yukarısında, 22 mm ve 42 mm çaplı iki çember 
çiziniz.

• Merkezi orijin noktasında olan 70 mm çaplı 
çemberden, çapları 42 mm ve 30 mm olan 
çemberlere teğetler çiziniz. 

                                       

• 3-Points Arc komutu ile 30 mm ve 42 mm çaplı çemberlerin üzerindeki noktalardan yay çiziniz. Yayın 
çemberlere teğet olmasını sağlayınız. Sketch Dimension komutu ile yayın yarıçap ölçüsünü 39,70 mm 
olarak belirleyiniz.

• Çalışmanızı bulut ortamında kaydediniz ya da File > Export komutu ile istediğiniz dizine çıkartınız.  

• XZ düzlemine bir Sketch açınız. Line ve Spline komutları ile görseldeki gibi çizim yapınız.
• Offset komutu ile 5 mm içeri ofsetleyiniz.

Sıra Sizde 6
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• Trim komutu ile oluşan fazlalıkları kesiniz ve Line komutu ile açık uçları tamamlayarak çizimi bitiriniz. 
Finish Sketch komutunu tıklayınız. 

• Revolve komutuyla kapalı profil olarak çizimi ve dönüş için gerekli referans eksenini seçiniz.
• Fincanın ağız kısmındaki iki çemberi seçiniz ve 2 mm yarıçap değerinde Fillet  komutu ile yuvarlatınız. 

Aynı işlemi fincanın alt kısmına da uygulayınız.

• XZ düzleminde yeni bir Sketch oluşturunuz.  Line ve Spline komutlarını kullanarak tabağı çiziniz. Finish 
Sketch komutunu tıklayınız.

• Revolve komutu ile fincan tabağı elde ediniz. Fincan tabağının kenarlarını Fillet  komutuyla 1 mm 
yarıçapında, alt düzlemine 2 mm yarıçapında yuvarlatınız. 

• XZ düzleminde Spline komutuyla görseldeki gibi eğriler ile fincanın kulpunu oluşturunuz.
• Construct > Plane Tangent to Face At Point komutu ile bir noktadan bir yüze teğet olan düzlem 

oluşturunuz. 
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• Yeni oluşan düzlemin orijin noktasında 10 mm çapında bir çember çiziniz. Finish Sketch tıklayınız. 

• Sweep komutunu seçiniz. Profil olarak 10 mm çaplı çember, Path olarak çizilen eğri, Operation olarak 
Join seçiniz.

• Fincanın kulpa bağlandığı yeri Fillet komutu ile 2 mm yarıçapında yumuşatınız.
• Tasarımı kaydediniz.

• XY düzlemine Box komutu ile 15,8 mm genişliğinde, 31,8 mm uzunluğunda, 9,6 mm yüksekliğinde bir 
kutu oluşturunuz. 

• Oluşturduğunuz kutunun üst yüzeyine kenardan 3,9 mm uzaklıkta, 5 mm çapında, 3,9 mm yüksekliğinde 
bir silindir oluşturunuz.

• Rectangular Pattern komutunu çalıştırınız. 
• Pattern Type olarak Bodies seçiniz.
• Objects olarak silindirik parçayı seçiniz.
• Directions olarak çoğaltma yönünü seçiniz. 

Sıra Sizde 7
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• Distance Type olarak Extent seçiniz.
• Quantity ve Distance ayarları ile 24 mm boyunca yatayda nesnenin 4 adet olmasını sağlayınız. 
• Quantity ve Distance ayarları ile 8 mm boyunca dikeyde nesnenin 2 adet olmasını sağlayınız.

• Direction Type ile çoğaltma işleminin yönünü belirleyiniz. 
• OK tuşuna basarak işlemi tamamlayınız.
• Oluşturduğunuz nesneyi kaydediniz.

• XY düzlemine 5 mm çapında, 5 mm yüksekliğinde bir silindir oluşturunuz. 
• Oluşturduğunuz silindirin alt yüzeyinde orijin noktaları aynı, 3 mm çapında 70 mm uzunluğunda bir 

silindir daha oluşturunuz.
• Fillet komutu ile silindirik yüzeylerin kenarlarını ve birleşim noktalarını 0,5 mm yuvarlayınız.
• Threat komutunu seçiniz.  Faces olarak diş açılacak silindir yüzeyini seçiniz. 
• Modeled seçeneğini tıklayınız. 
• Full Length seçeneğini kaldırınız ve başlangıç noktası için Offset olarak 0 mm, diş uzunluğunu belirlemek 

için Length değeri olarak 35 mm giriniz.
• Cıvata başının üst yüzeyinde bir Sketch oluşturunuz ve yarıçapı 2 mm olan bir altıgen çiziniz. Extrude 

komutu ile içe doğru 3,5 mm kesme işlemi yaparak cıvatanın başını altıgen alyan anahtara uygun şekilde 
oluşturunuz.

• XY düzlemde bir taslak oluşturunuz.
• -X, –Y eksenlerinden ve orijinden geçen Construction Line çiziniz.
• Center Rectangle komutu ile merkezi orijin noktasında olan 20 mm ve 90 mm ebatlarında bir dikdörtgen 

çiziniz. Kesik çizgi üzerinde çapı 4 mm ve orijine uzaklığı 25 mm olan iki çember çiziniz. 

Sıra Sizde 9
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• Extrude komutu ile çembere 3 mm yükseklik değeri veriniz.
• Ayrıtları 3 mm ve 20 mm olan menteşe yüzeyinde bir taslak oluşturunuz. Nesnenin hemen bitişiğinde 

sola doğru 3 mm yüksekliğinde ve 1,5 mm genişliğinde bir dikdörtgen çiziniz. Dikdörtgene teğet, 3 
mm çapında bir çember ve bu çemberle aynı merkezli 2 mm çapında bir çember  daha çiziniz. Gerekli 
kısıtlamaları vererek  nesneye Fully Constrained (Tam Çakışık) özelliğini kazandırınız.

• Seçili düzlemleri Extrude komutuyla menteşenin diğer ucuna 90 mm uzatınız. 

• Üst yüzeyde bir taslak çizim oluşturunuz. Kesme işlemi için gerekli dikdörtgenleri, her iki köşeye aynı 
mesafe ve uzunlukta olacak biçimde çiziniz. Extrude komutu ile dikdörtgensel bölgeleri seçip aşağı 
yönde uzatarak kesme işlemini gerçekleştiriniz. Kesme işleminden sonra size bakan yüzeyleri Offset 
Face komutu ile içeri doğru 1,3 mm öteleyiniz.
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• Timeline çizgisini geriye çekiniz. 

• Move komutunu çalıştırınız. Taşınacak nesneyi Body olarak ayarlayıp seçiniz. Seçilen nesnenin bir 
kopyasını oluşturmak için Create Copy seçeneğini aktif hâle getiriniz. Y Distance değerini  -23 mm olarak 
belirleyiniz.

• Timeline çizgisini ileri doğru uzatarak kopyalama işlemini sağlayınız.
• Menteşenin gösterilen yüzeyi üzerinde Sketch oluşturunuz. Project komutunu çalıştırınız. Project 

paletinde yer alan Geometry nesnesini menteşe milinin geçeceği çember olarak seçiniz. 
• Circle komutu ile bir çember çiziniz. 

• İki çember (kırmızı ve sarı renkle gösterilen) arası mesafeyi Sketch Dimension komutu ile 0,1 mm 
olarak belirleyiniz. Extrude komutu ile içteki çembere 90 mm değerinde uzunluk vererek mil nesnesini 
oluşturunuz. 
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• Açıkta kalan kısımları kapatmak için Sketch ortamına gidiniz. Sketch ortamına girebilmek için Rectangle 
komutunu çalıştırınız. Dikdörtgen çizmeden önce Project komutunu çalıştırınız. Selection Filter olarak 
Body, Geometry olarak da ortadan geçen mil nesnesini seçerek OK tuşuna basınız. Kapatılacak alanı 
Rectangle komutu ile çiziniz.

• Sketch Dimension komutu ile çizilen dikdörtgen ve yüzeyler arasındaki mesafeyi 1 mm olarak belirleyiniz. 
Yüzeyleri seçerek Extrude komutunu çalıştırınız. Opeartion olarak Join seçiniz ve mesafeyi 3 mm giriniz. 

• Assemble > New Companent komutunu çalıştırınız. From Bodies seçeneğini aktifleştiriniz. Dizayn 
sayfasındaki gövdeleri seçerek OK tuşuna basınız.

• Browser altında Companent1:1 ve Companent2:1 isminde iki bileşenin yer aldığı görülür. Companent1 
bileşenini yere sabitlemek için Ground komutunu çalıştırınız.

• Joint komutunu çalıştırınız. Motion Type olarak Revolute hareket türünü seçiniz.
• Component1 ve Component2 alanlarını kullanarak montaj nesnelerini seçiniz. Seçim esnasında 

parçaların monte edileceği Joint Origin noktalarını sırasıyla gösteriniz.  
• Bileşen, mil etrafında döndürüleceği için Joint Origin noktaları milin orta noktası olarak seçilir. OK 

tuşuna basarak işlem bitirilir.
• Animate komutu çalıştırıldığında dönen nesnenin, sabit nesnenin içinden geçtiğini gözlemleyiniz. Bu 

durumu engellemek için Browser altında Joints dalında bulundan Rev1  üzerine farenin sağ tuşu ile 
tıklayınız. Gelen menüden Edit Joint Limits komutunu çalıştırınız.

• Hareketin almasını istediğiniz en az ve en fazla açı değerlerini giriniz.


